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Introduction

ew people read introductions to reference books, so I'll make this brief.

I just want to tell you which versions of QuickBooks this book works for,

what’s in the reference, what it assumes about your existing skills, and what
conventions I use.

About This Book

TIP

The desktop version of QuickBooks comes in several flavors, including QuickBooks
Pro, QuickBooks Premier, and QuickBooks Enterprise Solutions. This reference
talks about QuickBooks 24 Enterprise Solutions, which is a superset of QuickBooks
2024 Premier and QuickBooks 2024 Pro. If you’re using QuickBooks Self-Employed
or QuickBooks Online, you shouldn’t use this book. Instead, you should check out
QuickBooks Online For Dummies, 2024 Edition, by David Ringstrom.

On the other hand, even though this book is written for QuickBooks Enterprise
Solutions, if you’re using QuickBooks Premier or QuickBooks Pro, don’t worry.
You’re just fine with this book. And don’t freak out if you’re using some version
of QuickBooks that’s very similar to QuickBooks 2024, such as QuickBooks 2023
or QuickBooks 2022. Although this reference is about QuickBooks 2024, it also
works just fine for the 2022, 2023, and probably 2025 versions of QuickBooks
because QuickBooks is a very mature product at this point. The changes from one
year to the next are modest. This means that if you’re using QuickBooks 2023,
stuff may look a little different if you closely compare the images in this book
with what you see on your screen, but the information in this reference will still
apply to your situation.

Note, too, that specialty versions of QuickBooks, such as QuickBooks Accountant’s
Edition and QuickBooks Contractor, also work almost identically to QuickBooks
Premier.

If you use QuickBooks Pro and see some whistle or bell that you really want to use

but that isn’t available in your version of QuickBooks, you’ll know that you should
upgrade to the Premier or Enterprise Solutions version of QuickBooks.
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The bottom line? Yes, QuickBooks comes in several flavors. Yes, Intuit publishes
new editions of its QuickBooks products every year. But you can use this book for
rRememeer ANy recent version of QuickBooks Pro, Premier, or Enterprise Solutions.

To make the best use of your time and energy, you should know about the conven-
tions I use in this book:

3 When | want you to type something such as Jennifer, it's in bold letters.

3 By the way, except for passwords, you don't have to worry about the case of
the stuff you type in QuickBooks. If | tell you to type Jennifer, you can type
JENNIFER. Or you can follow poet e. e. cummings's lead and type jennifer.

3 Whenever | tell you to choose a command from a menu, | say something like
Choose Lists = Items, which simply means to first choose the Lists menu and
then choose Items. The = separates one part of the command from the
next part.

¥ You can choose menus and commands and select dialog box elements with
the mouse. Just click the thing that you want to select.

3 While I'm on the subject of conventions, let me also mention something about
QuickBooks conventions, because it turns out that there's really no good place
to point this out: QuickBooks doesn’t use document windows the same way
that other Windows programs do. Instead, it locks the active window into
place and then displays a list of windows in its Navigator pane, which is like
another little window. To move to a listed window, you click it.

You can tell QuickBooks to use windows like every other program does, however,
by choosing View = Multiple Windows. You can even remove the Navigator pane

by choosing View = Open Window List.
TIP

Foolish Assumptions

I’'m making only three assumptions about your QuickBooks and accounting skills:

¥ You have a PC with Windows 8, Windows 10, or Windows 11. (I took screen-
shots of the QuickBooks windows and dialog boxes in Windows 10, in case
you're interested.)

3 You know a little bit about how to work with your computer.

2 QuickBooks 2024 All-in-One For Dummies
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3 You have, or will buy, a copy of QuickBooks Pro, QuickBooks Premier, or
QuickBooks Enterprise Solutions for each computer on which you want to run
the program.

In other words, I don’t assume that you’re a computer genius or an MBA, or
that you’re super-experienced in the arcane rules of accounting. I assume that
QuickBooks and accounting are new subjects to you. But I also assume that you
want to understand the subjects because you need to do so for your job or your
business.

Note that I wrote this book in 2023 for the 2024 version of QuickBooks. QuickBooks
automatically adds a time stamp of the date on which I enter transactions into
the system. Consequently, in some screenshots, you can see that I entered the
transactions into QuickBooks in 2023, even though the transaction dates for my
examples are in 2024. I hope you don’t find this situation too confusing; there’s
just no way I can work around it.

Icons Used in This Book

A

WARNING

REMEMBER

©)

TIP

LD,
TECHNICAL
STUFF

Like many computer books, this book uses icons, or little pictures, to flag things
that don’t quite fit into the flow of things.

The Warning icon tells you to watch out! It marks important information that may
save you headaches when using QuickBooks 2024.

Remember icons mark the information that’s especially important to know. To
siphon off the most important information in each chapter, skim these icons.

The Tip icon marks tips (duh!) and shortcuts that you can use to make QuickBooks
easier.

The Technical Stuff icon marks information of a highly technical nature that you
normally can skip.
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Beyond the Book

QuickBooks 2024 All-in-One For Dummies includes some extra content that you
bought with your book but didn’t get inside the book. This extra, premium stuff
is available online:

¥ The Cheat Sheet for this book is at www . dummies . com.

In the Search field, type QuickBooks 2024 All-in-One For Dummies Cheat
Sheet to find the Cheat Sheet for this book.

¥ Updates to this book, if there are any, are also at www.dummies. com. Search
for the book's title to find the associated updates.

Where to Go from Here

This reference combines eight short books, including a book about account-
ing, one about setting up the QuickBooks system, one for bookkeepers using
QuickBooks, one for accountants and managers using QuickBooks, a book about
small-business financial management, a book about business planning, a book
about taking care of a QuickBooks accounting system, and a book of appendixes
of useful information.

If you have a specific question about what’s covered or where some topic is
covered, refer to the table of contents in the front of this reference. Also remem-
ber that the book provides an index to help you find just the pages that have the
information you need.

While I’'m on the subject of what’s in this book and how to find information, let
me make four tangential points:

¥ You'll never read this book from cover to cover unless you're someone who
has an obsessive-compulsive personality (like me) and many hours to devote
to reading. But that's okay. This reference isn't meant to be read from cover to
cover like some Val McDermid page-turner. Instead, chapters within the eight
books are organized into largely self-contained descriptions of how you do the
things that you need to do. You just read the paragraph, page, or chapter that
provides the information you want.

¥ | haven't discussed in any detail how to use the QuickBooks Premier and
QuickBooks Enterprise Solutions features for business planning. The wizard-
based approach that QuickBooks Premier and QuickBooks Enterprise
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Solutions provide for business planning is not, in my humble opinion, the right
way. Instead, | discuss in detail alternative, superior approaches to business
planning and budgeting (using spreadsheets) in Book 6. (Just so you know:
The approach | describe and recommend here is the same one that any
business school teaches its students.)

At a few points in the book, you'll find me saying things like, “Well, | really don't
think you should use this part of the product.” I just want to explain here, up
front, where I'm coming from. First, know that | think QuickBooks is an out-
standing product, but not every feature or command is good. I've mentioned
that the new business planning tools aren’t ones that | can recommend. And
payroll, very frankly, is another pain-in-the-butt feature that most businesses
should avoid. (I do briefly discuss payroll in Book 3, Chapter 5.) So, if | think that
a particular feature is one that you shouldn't use, | don't take up page space
(or much page space) describing the feature. I'd rather use that space to
describe other stuff that | believe is valuable to you and other readers.

I should also mention one final thing: Accounting software programs require
you to do a certain amount of preparation before you can use them to get real
work done. If you haven't started to use QuickBooks yet, | recommend that you
skim Book 1 and then read Book 2 to find out what you need to do first.
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IN THIS CHAPTER

» Figuring out the purpose of
accounting

» Taking a look at common financial
statements

» Understanding the philosophy of
accounting

» Discovering income tax accounting
and reporting

Chapter 1
Principles of Accounting

ny discussion of how to use QuickBooks to manage your business better

begins with a discussion of the basics of accounting. For this reason, in

this chapter and the next two, I attempt to provide the same informa-
tion that you’d receive in an introductory college accounting course. I tailor the
entire discussion, of course, to QuickBooks and the small-business environment.
What you’ll read about here and in the next two chapters of this book pretty much
describes how accounting works in a small-business setting when you’re using
QuickBooks.

If you’ve had some experience with accounting, if you know how to read an
income statement and balance sheet, or if you know how to construct a journal
entry, you don’t need to read this chapter or the next ones. But if you’re new to
accounting and business bookkeeping, take the time to read this chapter carefully.
I start by giving you a high-level overview of the purpose of accounting. Then
I review the common financial statements that any accounting system worth its
salt produces. I also discuss some of the important principles of accounting and
the philosophy of accounting. Finally, I talk a little bit about income tax law and
tax accounting.
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Looking at the Purpose of Accounting

10

In the movie Creator, Peter O’Toole plays an eccentric professor. At one point,
O’Toole’s character attempts to talk a young student into working as an unpaid
research assistant. When the student protests, noting that he needs 15 credit
hours, O’Toole creates a special 15-credit independent-study course named
“Introduction to the Big Picture.” In the next section, I describe the “big picture”
of accounting. At its core, accounting makes perfect, logical sense.

The big picture

The most important thing to understand about accounting is that it provides
financial information to stakeholders. Stakeholders are the people who do business
with or interact with a firm; they include managers, employees, investors, banks,
vendors, government authorities, and agencies that may tax a firm. Stakeholders
and their information requirements deserve a bit more discussion. Why? Because
the information needs of these stakeholders determine what an accounting sys-
tem must do.

Managers, investors, and entrepreneurs

The first category of stakeholders includes the firm’s managers, investors, and
entrepreneurs. This group needs financial information to determine whether a
business is making money. This group also wants any information that gives
insight into whether a business is growing or contracting and how healthy or sick
it is. To fulfill its obligations and duties, this group often needs detailed informa-
tion. A manager or entrepreneur may want to know which customers are partic-
ularly profitable — or unprofitable. An active investor may want to know which
product lines are growing or contracting.

A related set of information requirements concerns asset and liability record
keeping. An asset is something that the firm owns, such as cash, inventory, or
equipment. A liability is some debt or obligation that the firm owes, such as bank
loans and accounts payable.

Obviously, someone at a firm — perhaps a manager, bookkeeper, or accountant —
needs to have very detailed records of the amount of cash that the firm has in its
bank accounts, the inventory that the firm has in its warehouse or on its shelves,
and the equipment that the firm owns and uses in its operations.

If you look over the preceding two or three paragraphs, nothing I've said is par-
ticularly surprising. It makes sense, right? Someone who works in a business,

BOOK 1 An Accounting Primer



manages a business, or actively invests in a business needs good general informa-
tion about the financial affairs of the firm and, in many cases, very detailed infor-
mation about important assets (such as cash) and liabilities (such as bank loans).

External creditors

A second category of stakeholders includes outside firms that lend money to a
business and credit-reporting agencies that supply information to these lenders.
Banks want to know about the financial affairs and financial condition of a firm
before lending money, for example. The accounting system needs to produce the
financial information that a bank requires to consider a loan request.

What information do lenders want? Lenders want to know that a business is
profitable and enjoys a positive cash flow. Profits and positive cash flows allow a
business to repay debt easily. A bank or other lender also wants to see assets that
could be liquidated, in a worst-case scenario, to pay a loan — and other debts that
may represent a claim on the firm’s assets.

Vendors also typically require financial information from a firm. A vendor often
lends money to a firm by extending trade credit. What’s noteworthy about this fact
is that vendors sometimes require special accounting. One category of vendors
that a company such as John Wiley & Sons, Inc., deals with is its authors. To pay
an author the royalty that they’re entitled to, Wiley puts in a fair amount of work
to calculate royalty-per-unit amounts and then reports and remits these amounts
to each author.

Other firms sometimes have similar financial reporting requirements for vendors.
Franchisees (such as the person who owns and operates the local McDonald’s) pay
a franchise fee based on revenue. Retailers may perform special accounting and
reporting to enjoy rebates and incentives from the manufacturers of the products
that they sell.

Government agencies

Predictable stakeholders that require financial information from a business also
include the federal and state government agencies that have jurisdiction over the
firm. Every business in the United States needs to report on its revenue, expenses,
and profits so that it can correctly calculate income tax due to the federal govern-
ment (and often, the state government, too) and then pay that tax.

Firms with employees must also report to the federal and state governments on
wages paid to those employees and pay payroll taxes based on metrics, such as
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number of employees, wages paid to employees, and unemployment benefits
claimed by past employees.

Providing this sort of financial information to government agencies represents a
key duty of a firm’s accounting system.

Business form generation

In addition to the financial reporting described in the preceding paragraphs,
accounting systems typically perform a key task for businesses: producing busi-
ness forms. An accounting system almost always produces the checks needed to
pay vendors, for example. In addition, an accounting system prepares the invoices
and payroll checks. More sophisticated accounting systems, such as those used
by large firms, prepare many other business forms, including purchase orders,
monthly customer statements, credit memos to customers, and sales receipts.

Every accounting function that I’ve described so far is performed ably by each
version of QuickBooks: QuickBooks Simple Start, QuickBooks Pro, QuickBooks
Premier, and QuickBooks Enterprise.

Reviewing the Common Financial
Statements

12

With the background information just provided, I'm ready to talk about some of
the common financial statements or accounting reports that an accounting sys-
tem like QuickBooks produces. If you understand which reports you want your
accounting system to produce, you should find it much easier to collect the raw
data necessary to prepare these reports.

In the following sections, I describe the three principal financial statements:
the income statement, the balance sheet, and the statement of cash flows. I also
briefly describe a fourth, catch-all category: accounting reports.

Don’t worry — I go through this material slowly. You need to understand what
financial statements your accounting systems are supposed to provide and what
data these financial statements supply.

BOOK 1 An Accounting Primer



TABLE 1-1

Income statement

Perhaps the most important financial statement that an accounting system
produces is the income statement, also known as a profit and loss statement.
An income statement summarizes a firm’s revenue and expenses for a particular
period. Revenue represents amounts that a business earns by providing goods and
services to its customers. Expenses represent amounts that a firm spends provid-
ing those goods and services. If a business can provide goods or services to cus-
tomers for revenue that exceeds its expenses, the firm earns a profit. If expenses
exceed revenue, obviously, the firm suffers a loss.

To show you how all this works — and it’s really pretty simple — take a look at
Tables 1-1 and 1-2. Table 1-1 summarizes the sales that an imaginary business
enjoys. Table 1-2 summarizes the expenses that the same business incurs for the
same period. These two tables provide all the information necessary to construct
an income statement.

A Sales Journal
Joe $1,000
Bob 500
Frank 1,000
Abdul 2,000
Yoshio 2,750
Marie 2,250
Jeremy 1,000
Chang 2,500
Total Sales $13,000

Using the information from Tables 1-1 and 1-2, you can construct the simple
income statement shown in Table 1-3. Understanding the details of an income
statement is key to understanding how accounting works and what accounting
tries to do. Therefore, I want to go into some detail in discussing this income
statement.

The first thing to note about the income statement shown in Table 1-3 is the sales
revenue figure of $13,000. This figure shows the sales generated for a particu-
lar period. The $13,000 figure shown in Table 1-3 comes directly from the sales
journal shown in Table 1-1.
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TABLE 1-2

TABLE 1-3

An Expenses Journal

Purchases of hot dogs and buns $3,000
Rent 1,000
Wages 4,000
Supplies 1,000
Total Expenses $9,000

Simple Income Statement

Sales revenue $13,000

Less: Cost of goods sold 3,000

Gross Margin $10,000

Operating Expenses

Rent $1,000
Wages 4,000
Supplies 1,000
Total Operating Expenses 6,000
Operating Profit $4,000

One important thing to recognize about accounting for sales revenue is that rev-
enue gets counted when goods or services are provided, not when a customer pays
for the goods or services. If you look at the list of sales shown in Table 1-1, for
example, Joe (the first customer listed) may have paid $1,000 in cash, but Bob,
Frank, and Abdul (the second, third, and fourth customers) may have paid for
their purchases with a credit card. Yoshio, Marie, Jeremy, and Chang (the fifth
through eighth customers listed) may not have even paid for their purchases at
the time the goods or services were provided. These customers may simply have
promised to pay for the purchases at some later date. The timing of payment for
goods or services doesn’t matter, however. Accountants have figured out that you
count revenue when goods or services are provided. Information about when cus-
tomers pay for those goods or services, if you want that information, can come
from lists of customer payments.

Cost of goods sold and gross margins are two other values that you commonly see
in income statements. Before I discuss cost of goods sold and gross margins,
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however, let me add a little more detail to this example. Suppose that the finan-
cial information in Tables 1-1, 1-2, and 1-3 shows the financial results from your
business: the hot dog stand that you operate for one day at the major sporting
event in the city where you live. Table 1-1 describes sales to hungry customers.
Table 1-2 summarizes the one-day expenses of operating your super-duper hot
dog stand.

In this case, the actual items that you sell — hot dogs and buns — are shown
separately in the income statement as cost of goods sold. By separately showing
the cost of the goods sold, the income statement can show what is called a gross
margin. The gross margin is the amount of revenue left over after paying for the
cost of goods. In Table 1-3, the cost of goods sold equals $3,000 for purchases
of dogs and buns. The difference between the $13,000 of sales revenue and the
$3,000 of cost of goods sold equals $10,000, which is the gross margin.

Knowing how to calculate gross margin allows you to estimate firm break-even
points and to perform profit, volume, and cost analyses. All these techniques are
extremely useful for thinking about the financial affairs of your business. In fact,
Book 6, Chapter 1 describes how you can perform these analyses.

The operating expenses portion of the simple income statement shown in Table 1-3
repeats the other information listed in the expenses journal. The $1,000 of rent,
the $4,000 of wages, and the $1,000 of supplies get totaled. Then these operating
expenses are subtracted from the gross.

Do you see, then, what an income statement does? An income statement reports
on the revenue that a firm has generated. It shows the cost of goods sold and cal-
culates the gross margin. It identifies and shows operating expenses, and finally
shows the profits of the business.

One other important point: Income statements summarize revenue, expenses,
and profits for a particular period. Some managers and entrepreneurs, for exam-
ple, may want to prepare income statements on a daily basis. Public companies
are required to prepare income statements on a quarterly and annual basis. And
taxing authorities, such as the Internal Revenue Service (IRS), require tax return
preparation both quarterly and annually.

Technically speaking, the quarterly statements required by the IRS don’t need
to report revenue. The IRS requires quarterly statements only of wages paid to
employees. Only the annual income statements required by the IRS report both
revenue and expenses. These income statements are produced to prepare an
annual income tax return.
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Balance sheet

The second-most-important financial statement that an accounting system pro-
duces is a balance sheet. A balance sheet reports on a business’s assets, liabilities,
and owner contributions of capital at a particular point in time:

¥ The assets shown in a balance sheet are items that are owned by the
business, which have value and for which money was paid.

¥ The liabilities shown in a balance sheet are amounts that a business owes to
other people, businesses, and government agencies.

3 The owner contributions of capital are the amounts that owners, partners, or
shareholders have paid into the business in the form of investment or have
reinvested in the business by leaving profits inside the company.

As long as you understand what assets and liabilities are, a balance sheet is easy to
understand and interpret. Table 1-4, for example, shows a simple balance sheet.
Pretend that this balance sheet shows the condition of the hot dog stand at the
beginning of the day, before any hot dogs have been sold. The first portion of the
balance sheet shows and totals the two assets of the business: the $1,000 cash in
the cash register in a box under the counter and the $3,000 worth of hot dogs and
buns that you’ve purchased to sell during the day.

TABLE 1-4 A Simple Balance Sheet
Cash $1,000
Inventory 3,000
Total assets $4,000
Accounts payable $2,000
Loan payable 1,000

Owner's Equity

S. Nelson, capital $1,000

Total Liabilities and Owner’s Equity $4,000
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REMEMBER

Balance sheets can use several other categories to report assets: accounts receiv-
able (amounts that customers owe), investments, fixtures, equipment, and
long-term investments. In the case of a small owner-operated business, not all
these asset categories show up. But if you look at the balance sheet of a very large
business — say, one of the 100 largest businesses in the United States — you see
these other categories.

The liabilities section of the balance sheet shows the amounts that the firm owes
to other people and businesses. The balance sheet in Table 1-4 shows $2,000 of
accounts payable and a $1,000 loan payable. Presumably, the $2,000 of accounts
payable is the money that you owe to the vendors who supplied your hot dogs and
buns. The $1,000 loan payable represents some loan you’ve taken out — perhaps
from some well-meaning and naive relative.

The owner’s equity section shows the amount that the owner, the partners,
or shareholders have contributed to the business in the form of original funds
invested or profits reinvested. One important point about the balance sheet shown
in Table 1-4: This balance sheet shows how owner’s equity looks when the busi-
ness is a sole proprietorship. In the case of a sole proprietor, only one line is
reported in the owner’s equity section of the balance sheet. This line combines
all contributions made by the proprietor — both amounts originally invested and
amounts reinvested.

I talk a bit more about owner’s equity accounting later in this chapter because the
owner’s equity sections look different for partnerships and corporations. Before I
get into that discussion, however, let me make two important observations about
the balance sheet shown in Table 1-4:

3 Abalance sheet needs to balance. This means that the total assets must
equal the total liabilities and owner's equity. In the balance sheet shown in
Table 1-4, for example, total assets show as $4,000. Total liabilities and
owner'’s equity also show as $4,000. This equality is no coincidence. If an
accounting system works right, and the accountants and bookkeepers
entering information into this system do their jobs right, the balance
sheet balances.

3 Abalance sheet provides a snapshot of a business’s financial condition
at a particular point in time. | mention in the introductory remarks related
to Table 1-4 that the balance sheet in this table shows the financial condition
of the business immediately before the day's business activities begin.

You can prepare a balance sheet for any point in time. It’s key that you understand
that a balance sheet is prepared for a particular point in time.
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TABLE 1-5

TABLE 1-6

By convention, businesses prepare balance sheets to show the financial condi-
tion at the end of the period of time for which an income statement is prepared.
A business typically prepares an income statement on an annual basis. In this
orthodox situation, a firm also prepares a balance sheet at the very end of the year.

At this point, I return to something that I allude to earlier in the chapter: the fact
that the owner’s equity section of a balance sheet looks different for different
types of businesses.

Table 1-5 shows how the owner’s equity section of a balance sheet looks for a
partnership. In Table 1-5, I show how the owner’s equity section of the busi-
ness appears if, instead of having a sole proprietor named S. Nelson running the
hot dog stand, the business is actually owned and operated by three partners
named Tom, Maria, and Amani. In this case, the partners’ equity section shows
the amounts originally invested and any amounts reinvested by the partners. As
is the case with sole proprietorships, each partner’s contributions and reinvested
profits appear on a single line.

Owner's Equity for a Partnership

Partners’ Equity

Tom, capital $500
Maria, capital 250
Amani, capital 250
Total Partner Capital $1,000

Take a look at Table 1-6, which shows how the owner’s equity section looks for a
corporation.

Owner’s Equity for a Corporation

Shareholders’ Equity

Capital stock, 100 shares at $1 par $100
Contributed capital in excess of par 400
Retained earnings 500
Total Shareholders’ Equity $1,000
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This next part is a little bit weird. For a corporation, the amounts that appear in
the owner’s equity or shareholders’ equity section actually fall into two major
categories: retained earnings and contributed capital. Retained earnings represent
profits that the shareholders have left in the business. Contributed capital is the
money originally contributed by the shareholders to the corporation.

The retained-earnings thing makes sense, right? That’s just the money — the
profits — that investors have reinvested in the business.

The contributed-capital thing is more complicated. Here’s how it works. If you
buy a share of stock in some new corporation — for, say, $5 — typically, some
portion of that price per share is for par value. Now, don’t ask me to justify par
value. It stems from business practices that were common a century or more
ago. Just trust that typically, if you pay some amount — again, say $5 — for a
share, some portion of the amount that you pay — maybe 10 cents a share or $1a
share — is for par value.

In the owner’s equity section of a corporation’s balance sheet, capital that’s
contributed by original investors is broken down into the amounts paid for
this mysterious par value and the amounts paid in excess of this par value.
In Table 1-6, you can see that $100 of shareholders’ equity or owner’s equity
represents amounts paid for par value. Another $400 of the amounts contributed
by the original investors represents amounts paid in excess of par value. The
total shareholders’ equity, or total corporate owner’s equity, equals the sum of
the capital stock par value, the contributed capital and excess of par value, and
any retained earnings. So, in Table 1-6, total shareholders’ equity equals $1,000.

Statement of cash flows

Now I come to the one tricky financial statement: the statement of cash flows.

Before I begin, I have one comment to make about the statement of cash flows.
As an accountant, I’ve worked with many bright managers and businesspeople. No
matter how much hand-holding and explanation I (or other accountants) provide,
some of these smart people never quite get some of the numbers on the statement
of cash flows. In fact, many of the students who major in accounting never (in my
opinion, at least) quite understand how a statement of cash flows really works.

For this reason, don’t spend too much time spinning your wheels on this state-
ment or trying to understand what it does. QuickBooks does supply a statement of
cash flows, but you don’t need to use it. In fact, QuickBooks produces cash-basis
income statements, which give you almost the same information — and in a for-
mat that’s easier to understand.
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TABLE 1-7

20

©

REMEMBER

I think the best way to explain what a statement of cash flows does is to ask you
to look again at the balance sheet shown in Table 1-4 earlier in this chapter. This
table is the balance sheet for the imaginary hot dog stand at the beginning of
the day.

Now take a look at Table 1-7, which shows the balance sheet at the end of the day,
after operations for the hot dog stand have ended. Notice that at the start of the
day (see Table 1-4), cash equals $1,000, and at the end of the day (see Table 1-7),
cash equals $5,000. The statement of cash flows explains why cash changes from
the one number to the other number over a period of time. In other words, a state-
ment of cash flows explains how cash goes from $1,000 at the start of the day to
$5,000 at the end of the day.

Another Simple Balance Sheet

Cash $5,000
Inventory 0
Total assets $5,000
Accounts payable $0
Loan payable 0

Owner's Equity

S. Nelson, capital $5,000

Total Liabilities and Owner’s Equity $5,000

Table 1-8, not coincidentally, shows a statement of cash flows that explains how
cash flowed for your imaginary business. If you’re reading this book, presumably
you need to understand this statement. I start at the bottom of the statement and
work up.

By convention, accountants show negative numbers inside parentheses. These
parentheses flag negative values more clearly than a simple minus sign can.

The last three lines of the statement of cash flows are all easy to understand.
The cash balance at the end of the period, $5,000, shows what cash the business
holds at the end of the day. The cash balance at the start of the period, $1,000,
shows the cash that the business holds at the beginning of the day. Both the cash
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TABLE 1-8

balance at the start of the period and the cash balance at the end of the period tie
to the cash-balance values reported in the two balance sheets. (Look at Table 1-4
and Table 1-7 to corroborate this assertion.) Clearly, if you start the period with
$1,000 and end the period with $5,000, cash has increased by $4,000. That’s an
arithmetical certainty. No question there, right?

A Simple Statement of Cash Flows

Operating Activities

Net income $4,000
Decrease in accounts payable (2,000)
Adjustment: Decrease in inventory 3,000

Net cash provided by operating activities $5,000
Decrease in notes payable (1,000)
Net cash provided (used) by financing activities (1,000)
Increase in cash $4,000
Cash balance at start of period 1,000

Cash balance at end of period $5,000

The financing activities of the statement of cash flows show how firm borrowing
and firm debt repayment affect the firm cash flow. If the business uses its profits
to repay the $1,000 loan payable — which is what happened — this $1,000 cash
outflow shows up in the financing activities portion of the statement of cash flows
as a negative $1,000.

The top portion of the statement of cash flows is often the trickiest to understand.
Note, however, that I've talked about everything else in this statement. So, with
a strong push, you can fight your way through to understanding what’s going on
here. The operating activities portion of the statement of cash flows essentially
shows the cash that comes from the profit. If you look at Table 1-8, for example,
you see that the first line in the operating activities portion of the statement of
cash flows is net income of $4,000. This is the net income amount reported on
the income statement for the period. The net income or operating profit reported
in the business’s income statement, however, isn’t necessarily the same thing as
cash income or cash profit. A variety of factors must be adjusted to convert this
net income amount to what’s essentially a cash amount of operating profit.
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In the case of the hot dog stand business, if you use some of the profits to pay
off all the accounts payable, this payoff uses up some of your cash profit. This is
exactly what Table 1-8 shows. You can see that the decrease in the accounts pay-
able from $2,000 to $0 over the day required, quite logically, $2,000 of the net
income. Another way to think about this is that essentially, you used up $2,000 of
your cash profits to pay off accounts payable. Remember that the accounts payable
is the amount that you owed your vendors for hot dogs and buns.

Another adjustment is required for the decrease in inventory. The decrease in
inventory from the start of the period to the end of the period produces cash.
Basically, you’re liquidating inventory. Another way to think about this is that
although this inventory — the hot dogs and buns, in this example — shows up as
an expense for the day’s income statement, it isn’t purchased during the day. It
doesn’t consume cash during the day; it was purchased at some point in the past.

When you combine the net income, the accounts payable adjustment, and the
inventory adjustment, you get the net cash provided by the operating activities.
In Table 1-8, these three amounts combine for $5,000 of cash provided by the
operations.

After you understand the details of the financing and operating activities areas
of the statement of cash flows, the statement makes sense. Net cash provided by
the operating activities equals $5,000. Financing activities reduce cash by $1,000.
This means that cash actually increased over the period by $4,000, which explains
why cash starts the period at $1,000 and ends the period at $5,000.

Other accounting statements

You can probably come up with examples of several other popular or use-
ful accounting reports. Not surprisingly, a good accounting system such as
QuickBooks produces most of these reports. One very common report or financial
statement, for example, is a list of the amounts that your customers owe you. It’s
a good idea to prepare and review such reports on a regular basis to make sure that
you don’t have customers turning into collection problems.

Table 1-9 shows how the simplest sort of accounts receivable report may look.
Each customer is named along with the amount owed.

Table 1-10 shows another common accounting report: an inventory report that
the hot dog stand may have at the start of the day. An inventory report like the
one shown in Table 1-10 probably would name the various items held for resale,
the quantity held, and the amount or value of the inventory item. A report such as
this one is useful for making sure that you have the appropriate quantities of inven-
tory in stock. (Think of how useful such a report would be if you really were planning
to sell thousands of hot dogs at major sporting events in your hometown.)

BOOK 1 An Accounting Primer



TABLE 1-9

TABLE 1-10

An Accounts Receivable Report at End of Day

W. Churchill $45.12
G. Patton 34.32
B. Montgomery 12.34
H. Petain 65.87
C. de Gaulle 43.21
Total Receivables $200.86

An Inventory Report at Start of Day

Item Quantity Amount
Kielbasa 2,000 $900.00
Bratwurst 2,000 1,000.00
Plain buns 2,000 500.00
Sesame buns 2,000 600.00
Total Inventory $3,000.00

Putting it all together

By now, you should understand what an accounting system does. When you boil
everything down to its essence, it’s straightforward, isn’t it? Really, an account-
ing system just provides you with the financial information that you need to run
your business.

Let me add a tangential but important point: QuickBooks supplies all this account-
ing information. For the most part, preparing these sorts of financial statements
in QuickBooks is pretty darn easy. But first, you’ll find it helpful to know a bit
more about accounting and bookkeeping. I go over that information in the coming
chapters. Also, note that the big-picture stuff covered in this chapter is the most
important knowledge that you need. If you understand the ideas described in this
chapter, the battle is more than half won.
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BOOK 1

CURIOUS ABOUT DIFFERENT
BUSINESS FORMS?

Are you curious about the differences among a sole proprietorship, a partnership, and
a corporation? A sole proprietorship is formed automatically in most states and in most
industries when an individual decides to go into business. In many jurisdictions, the sole
proprietor needs to acquire or apply for a business license from the state or local city
government. Other than clearing that modest hurdle, sole proprietorship requires no
special prerequisites.

A partnership is formed automatically when two or more people enter into a joint busi-
ness or investment activity for the purpose of making a profit. As is the case with a sole
proprietorship, partnerships typically need to acquire a business license from the state
and perhaps the federal government. Partnership formation doesn’t necessarily require
any additional paperwork or legal maneuvering. If you do enter into a partnership,
however, most attorneys (probably all attorneys) will tell you that you do so at a certain
amount of risk if you don't have an attorney draw up a partnership agreement that out-
lines the duties, rights, and responsibilities of the partners. Also be aware that you can
form a partnership simply by collaborating in business with someone. The law books
are full of stories of people who inadvertently created partnerships merely by collabo-
rating on some project, sharing office space, or working together on some activity.

By comparison, most states allow several other business forms, including corporations,
limited liability companies, and limited liability partnerships. These other business forms
sometimes require considerably more work to set up, sometimes the assistance of a
good attorney or accountant, and sometimes payment of several hundred — possibly
several thousand — dollars in legal and licensing fees. The unique feature of most of
these other business forms is that the corporation, limited liability company, or limited
liability partnership becomes a separate legal entity. In many cases, this separate legal
entity protects investors from creditors that have a claim on the assets of the business.
By comparison, in a sole proprietorship or a partnership, the sole proprietor and the
partners are liable for the debts and obligations of the proprietorship or the partnership.

If you have questions about the correct business form in which to operate, talk with

a good local attorney or accountant. They can assist you in choosing the appropriate
business form and in considering both the legal and tax aspects of choosing a particular
form. As a general rule, more-sophisticated business forms such as corporations, lim-
ited liability companies, and limited liability partnerships deliver significant legal and tax
benefits to investors and managers. Unfortunately, these more-sophisticated business
forms also require considerably more legal and accounting fiddle-faddling.



Examining the Philosophy of Accounting

Maybe the phrase philosophy of accounting is too strong, but accounting does rest
on a rather small set of fundamental assumptions and principles. People often
refer to these fundamentals as generally accepted accounting principles.

I want to quickly summarize what these principles are. I find — and I bet you’ll
find the same thing — that understanding the principles provides context and
makes accounting practices more understandable. With this in mind, let me go
through the half dozen or so key accounting principles and assumptions.

These basic accounting principles underlie business accounting. These principles
and assumptions are implicit in all the discussions throughout this book. It’s no
exaggeration to say that they permeate almost everything related to business
accounting.

Revenue principle

The revenue principle, also known as the realization principle, states that revenue is
earned when the sale is made. Typically, the sale is made when goods or services
are provided. A key component of the revenue principle, when it comes to the sale
of goods, is that revenue is earned when legal ownership of the goods passes from
seller to buyer.

Note that revenue isn’t earned when you collect cash for something. It turns out,
perhaps counterintuitively, that counting revenue when cash is collected doesn’t
give the business owner a good idea of what sales really are. Some customers
may pay deposits early, before actually receiving the goods or services. Often,
customers want to use trade credit, paying a firm at some point in the future for
goods or services. Because cash flows can fluctuate wildly — even something like
a delay in the mail can affect cash flow — you don’t want to use cash collection
from customers as a measure of sales. Besides, you can easily track cash collec-
tions from customers. So why not have the extra information about when sales
actually occur?

Expense principle

The expense principle states that an expense occurs when the business uses goods
or receives services. In other words, the expense principle is the flip side of
the revenue principle. As is the case with the revenue principle, if you receive
some goods, simply receiving the goods means that you’ve incurred the expense
of the goods. Similarly, if you’ve received some service — services from your
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lawyer, for example — you’ve incurred the expense. It doesn’t matter that your
lawyer takes a few days or a few weeks to send you the bill. You incur an expense
when goods or services are received.

Matching principle

The matching principle is related to the revenue and expense principles. The match-
ing principle states that when you recognize revenue, you should match related
expenses with the revenue. The best example of the matching principle concerns
the case of businesses that resell inventory. In the example of the hot dog stand,
you should count the expense of a hot dog and the expense of a bun on the day
when you sell that hot dog and that bun. Don’t count the expense when you buy
the buns and the dogs; count the expense when you sell them. In other words,
match the expense of the item with the revenue of the item.

Accrual-based accounting, which is a term you’ve probably heard, is what you get
when you apply the revenue principle, the expense principle, and the matching
principle. In a nutshell, accrual-based accounting means that you record revenue
when a sale is made and record expenses when goods are used or services are
received.

Cost principle

The cost principle states that amounts in your accounting system should be quanti-
fied, or measured, by using historical cost. If you have a business, and the busi-
ness owns a building, that building — according to the cost principle — shows
up on your balance sheet at its historical cost. You don’t adjust the values in an
accounting system for changes in a fair market value. You use the original histori-
cal costs.

I should admit that the cost principle is occasionally violated in a couple of ways.
The cost principle is adjusted through the application of depreciation, which
I discuss in Book 1, Chapter 3. Also, fair market values are sometimes used to value
assets, but only when assets are worth less than they cost.

Objectivity principle

The objectivity principle states that accounting measurements and accounting
reports should use objective, factual, and verifiable data. In other words, accoun-
tants, accounting systems, and accounting reports should rely on subjectivity as
little as possible.
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An accountant always wants to use objective data (even if it’s bad) rather than
subjective data (even if the subjective data is arguably better). The idea is that
objectivity provides protection from the corrupting influence that subjectivity can
introduce into a firm’s accounting records.

Continuity assumption

The continuity assumption — accountants call it an assumption rather than a principle
for reasons unknown to me — states that accounting systems assume that a
business will continue to operate. The importance of the continuity assumption
becomes clear if you consider the ramifications of assuming that a business won’t
continue. If a business won’t continue, it becomes very unclear how one should
value assets if the assets have no resale value. This sounds like gobbledygook, but
think about the implicit continuity assumption built in to the balance sheet for the
hot dog stand at the beginning of the day. (This is the balance sheet that shows up
in Table 1-4 earlier in this chapter.)

Implicit in that balance sheet is the assumption that hot dogs and hot dog buns
have some value because they can be sold. If a business won’t continue opera-
tions, no assurance exists that any of the inventory can be sold. If the inventory
can’t be sold, what does that say about the owner’s equity value shown in the
balance sheet?

You can see, I hope, the sorts of accounting problems that you get into without the
assumption that the business will continue to operate.

Unit-of-measure assumption

The unit-of-measure assumption assumes that a business’s domestic currency is
the appropriate unit of measure for the business to use in its accounting. In other
words, the unit-of-measure assumption states that it’s okay for US businesses to
use US dollars in their accounting, and it’s okay for UK businesses to use pounds
sterling as the unit of measure in their accounting system. The unit-of-measure
assumption also states, implicitly, that even though inflation and occasionally
deflation change the purchasing power of the unit of measure used in the account-
ing system, that’s still okay. Sure, inflation and deflation foul up some of the num-
bers in a firm’s financial statements. But the unit-of-measure assumption says
that’s usually okay — especially in light of the fact that no better alternatives exist.
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Separate-entity assumption

The separate-entity assumption states that a business entity, like a sole propri-
etorship, is a separate entity — a separate thing from its business owner. Also,
the separate-entity assumption says that a partnership is a separate thing from
the partners who own part of the business. This assumption, therefore, enables
one to prepare financial statements just for the sole proprietorship or just for the
partnership. As a result, the separate-entity assumption also relies on a business
to be separate, distinct, and definable compared with its business owners.

Adding a Few Words about Tax Accounting

28

I’'m not going to talk much about tax accounting or tax preparation in this book,
but one key reason why you do accounting and use a program such as QuickBooks
is to make your tax accounting easier. That’s obvious. So, a fair question is this:
How does what I've said so far relate to income tax return preparation?

This question is a tough one to answer. Tax laws typically don’t map to generally
accepted accounting principles. Generally accepted accounting principles aren’t
the same things as income tax laws. If you use good basic accounting practices
as you operate QuickBooks, however, you get financial information that you can
use to easily prepare your tax returns, especially if you get some help from your
certified public accountant (CPA).

If you want, you can also use income tax rules to fine-tune your accounting and
bookkeeping. This practice, which is technically known as an other comprehensive
basis of accounting (OCBOA), is generally considered to be an appropriate way to
perform accounting for small and medium-size enterprises.

BOOK 1 An Accounting Primer



IN THIS CHAPTER

» Checking out the fiddle-faddle
method of accounting

» Grasping how double-entry
bookkeeping works

» Looking at an (almost) real-life
example

» Figuring out how QuickBooks helps

Chapter 2

Double-Entry
Bookkeeping

he preceding chapter describes why businesses create financial statements

and how these financial statements can be used. If you’ve read Book 1,

Chapter 1, or if you’ve spent much time managing a business, you prob-
ably know what you need to know about financial statements. In truth, financial
statements are pretty straightforward. An income statement, for example, shows
a firm’s revenue, expenses, and profits. A balance sheet itemizes a firm’s assets,
liabilities, and owner’s equity. So far, so good.

Unfortunately, preparing traditional financial statements is more complicated
and tedious. The work of preparing financial statements — called accounting or
bookkeeping — requires either a whole bunch of fiddle-faddling with numbers or
learning how to use double-entry bookkeeping.

In this chapter, I start by describing the fiddle-faddle method. This isn’t because
I think you should use that method. In fact, I assume that you eventually want to
use QuickBooks for your accounting and, by extension, for double-entry book-
keeping. But if you understand the fiddle-faddle method, you’ll clearly see why
double-entry bookkeeping is so much better.
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After I describe the fiddle-faddle method, I walk you through the steps to using
and understanding double-entry bookkeeping. After you see all the anguish and
grief that the fiddle-faddle method causes, you should have no trouble appreciat-
ing why double-entry bookkeeping works so much better. And I hope you’ll also
commit to the 30 or 40 minutes necessary to learn the basics of double-entry
bookkeeping.

Using the Fiddle-Faddle Method
of Accounting

TABLE 21

Most small businesses — or at least those small businesses whose owners aren’t
already trained in accounting — have used the fiddle-faddle method. Take a
peek at the financial statements shown in Tables 2-1 and 2-2. If you’ve read or
reviewed Book 1, Chapter 1, you may recognize that these financial statements
stem from the imaginary hot dog stand. Table 2-1 shows the income statement
for the one day a year that the imaginary business operates. Table 2-2 shows the
balance sheet at the start of the first day of operation.

A Simple Income Statement for the Hot Dog Stand

Sales Revenue $13,000

Less: Cost of goods sold 3,000

Gross margin $10,000

Operating Expenses

Rent $1,000
Wages 4,000
Supplies 1,000
Total Operating Expenses 6,000
Operating Profit $4,000

With the fiddle-faddle method of accounting, you individually calculate each
number shown in the financial statement. The sales revenue figure shown in
Table 2-1, for example, equals $13,000. The fiddle-faddle method of accounting
requires you to somehow come up with this sales revenue number manually. You
may be able to come up with this number by remembering each of the sales that
you made during the day. Or, if you prepare invoices or sales receipts, you may be
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TABLE 2-2

able to come up with this number by adding all the individual sales. If you have a
cash register, you may be able to come up with this number by looking at the cash
register tape.

A Simple Balance Sheet for the Hot Dog Stand

Cash $1,000
Inventory 3,000
Total assets $4,000
Accounts payable $2,000
Loan payable 1,000

Owner's Equity

S. Nelson, capital $1,000

Total Liabilities and Owner’s Equity $4,000

Other revenue and expense numbers get calculated in the same crude manner.
The $1,000 of rent expense, for example, gets calculated by remembering what
amount you paid for rent or by looking in your checkbook register and finding the
check that you wrote for rent.

The balance sheet values get produced in roughly the same way. You can deduce
the cash balance of $1,000, for example, by looking at the checkbook or, in a
worst-case scenario, the bank statement. You can deduce the inventory balance
of $3,000 by adding the individual inventory item values. You can calculate the
liability and owner’s equity amounts in similar fashion.

Some of the values shown in an income statement or on a balance sheet get
plugged — meaning that they’re calculated by using other numbers from the
financial statement. You don’t look up the profit amount in any particular place;
instead, you calculate profit by subtracting expenses from revenue. You can also
calculate balance sheet values such as total assets, owner’s equity, and total
liabilities, of course.

Okay, I admit it: The fiddle-faddle method of accounting works reasonably well
for a very small business as long as you have a good checkbook. So for a very
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small business, you may be able to get away with this crude, piecemeal approach
to accounting.

Unfortunately, the fiddle-faddle method suffers the three horrible weaknesses for
a firm that doesn’t have super-simple finances:

3 It's not systematic enough to be automated. Now, admittedly, you may not
care that the fiddle-faddle approach isn't systematic enough for automation.
But this point is an important one: A systematic approach like double-entry
bookkeeping can be automated, as you can do with QuickBooks. This
automation means that the task of preparing financial statements requires —
oh, I don't know — maybe five mouse clicks. Because the fiddle-faddle
approach can't be automated, every time you want to produce financial
statements, you or some poor co-worker must do an enormous amount of
work to collect the numbers and all the raw data necessary to produce
information like that shown in Table 2-1 and Table 2-2. In reality, of course,
with more complicated financial statements, someone does much, much
more work.

¥ It's very easy to lose details. This sounds abstract, but let me give you a
good, concrete example. If you look at Table 2-1, you see that the hot dog
stand incurs only three operating expenses: rent, wages, and supplies. If you
know the operating expense categories that the business incurs, it's fairly easy
to look through the check register and find the check or checks that pay rent,
for example. You can use a similar approach with the wages and supplies
expenses. But what if you also have an advertising expense category, a
business license expense, or some other easy-to-forget category? If you forget
a category, you miss expenses. If you forget that you spent money advertising
and, thereby, forget to tally your advertising expenses, that whole category of
operating expense gets omitted from your income statement.

¥ It doesn't allow rigorous error checking. This business about error checking
may seem to be nitpicky, but error checking is important with accounting and
bookkeeping systems. With all the numbers and transactions floating around,
errors easily creep into the system. | discuss error checking more later in this
chapter, but let me give you an example of the sort of error checking an
accounting system can (and should) perform. Take a look at the example of
the sales transaction. If you sell an item for $1,000, you can check that amount
by comparing it with your record of what the customer paid. This makes
sense, right? If you sell me an item for $1,000, you should be able to compare
that $1,000 sale with the amount of cash that | pay you. A $1,000 sale to me
should correspond to a $1,000 cash payment from me. The fiddle-faddle
method can't make these comparisons, but double-entry bookkeeping can.
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You see where I am now, right? I've admitted that you can construct financial
statements by using the fiddle-faddle method. But I hope I've also convinced you
that the fiddle-faddle method suffers some really debilitating weaknesses. I’'m
talking about something as important as how you can best manage the financial
affairs of your business. These weaknesses indicate that you need a better tool.
Specifically, you need double-entry bookkeeping, which I discuss next.

Finding Out How Double-Entry
Bookkeeping Works

After you conclude that the fiddle-faddle method is for the birds, you’re ready to
absorb the necessary accounting theory and learn the bookkeeping tricks required
to employ double-entry bookkeeping. Essentially, you need two things to work
with double-entry bookkeeping: an understanding of the accounting model and a
grasp of the mechanics of debits and credits. Neither of these things is difficult. If
you flip ahead a few pages, you can see that I'm going to spend only a few pages
talking about this material. How difficult can anything be that can be described in
just a few pages? Not very, right?

The accounting model

Here’s the first thing to understand and internalize to use double-entry book-
keeping: Modern accounting uses an accounting model that says assets equal
liabilities plus owner’s equity. The following formula expresses this in a more
conventional, algebraic form:

assets = liabilities + owner's equity

If you think about this for a moment and flip back to Table 2-2, you see that this
formula summarizes the organization of a business’s balance sheet. Conceptually,
the formula says that a business owns stuff and that the money or the funds for
that stuff comes from either creditors (such as the bank or some vendor) or the
owners (either in the form of original contributed capital or perhaps in reinvested
profits). If you understand the balance sheet shown in Table 2-2 and discussed
here, you understand the first core principle of double-entry bookkeeping. This
isn’t that tough so far, is it?

Here’s the second thing to understand about the basic accounting model: Revenue

increases owner’s equity, and expenses decrease owner’s equity. Think about that
for a minute. That makes intuitive sense. If you receive $1,000 in cash from a
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customer, you have $1,000 more in the business. If you write a $1,000 check to pay
a bill, you have $1,000 less in the business.

Another way to say the same thing is that profits clearly add to owner’s equity.
Profits get reinvested in the business and boost owner’s equity. Profits are cal-
culated as the difference between revenue and expenses. If revenue exceeds
expenses, profits exist.

Let me review where I am so far in this discussion about the basic accounting
model. The basic model says that assets equal liabilities plus owner’s equity. In
other words, the total assets of a firm equal the total of its liabilities and owner’s
equity. Furthermore, revenue increases owner’s equity, and expenses decrease
owner’s equity.

At this point, you don’t have to intuitively understand the logic of the accounting
model and the way that revenue and expenses plug into the owner’s equity of the
model. If you do get it, that’s great but not necessary. But you do need to memo-
rize or remember (for at least the next few paragraphs) the manner in which the
basic model works.

This point may seem to be redundant, but note that a balance sheet is constructed
by using information about a firm’s assets, liabilities, and owner’s equity. Simi-
larly, note that a firm’s income statement is constructed by using information
about its revenue and its expenses. All this discussion — all this tediousness —
is really about how you collect the information necessary to produce an income
statement and a balance sheet.

Now I come to perhaps the most important point to understand to get double-
entry bookkeeping. Every transaction and every economic event that occurs in
the life of a firm produces two effects: an increase in some account shown in the
balance sheet or income statement and a decrease in some account shown in
the balance sheet or income statement. When something happens, economically
speaking, that something affects at least two types of information shown in the
financial statement. In the next few paragraphs, I give you some examples so that
you can really understand this concept.

Suppose that in your business, you sell $1,000 worth of an item for $1,000 in
cash. In the case of this transaction or economic event, two things occur from the
perspective of your financial statements:

¥ Your cash increases by $1,000.

¥ Your sales revenue increases by $1,000.
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Another way to say this same thing is that your $1,000 cash sale affects both your
balance sheet (because cash increases) and your income statement (because sales
revenue is earned).

See the duality? And just a paragraph ago, you were thinking that this topic might
be too complicated for you, weren’t you?

Here’s another common example. Suppose that you buy $1,000 worth of inventory
for cash. In this case, you decrease your cash balance by $1,000, but you increase
your inventory balance by $1,000. Note that in this case, both effects of the trans-
action appear in sort of the same area of your financial statement: the list of
assets. Nevertheless, this transaction also affects two accounts.

When I use the word account, I simply mean some value that appears in your
income statement or on your balance sheet. If you look at Tables 2-1 and 2-2, for
example, any value that appears in those financial statements that isn’t simply
a calculation represents an account. In essence, an account tracks some group of
assets, liabilities, owner’s equity, contributions, revenue, or expenses. I talk more
about accounts in the next section, where I get to the actual mechanics of double-
entry bookkeeping.

Here’s another example that shows this duality of effects in an economic event.
Suppose that you spend $1,000 in cash on advertising. In this case, this economic
event reduces cash by $1,000 and increases the advertising expense amount by
$1,000. This economic event affects both the assets portion of the balance sheet
and the operating expenses portion of the income statement.

And now — believe it or not — you’re ready to see how the mechanics of double-
entry bookkeeping work.

Talking mechanics

Roughly 500 years ago, an Italian monk named Luca Pacioli devised a systematic
approach to keeping track of the increases and decreases in account balances. He
said that increases in asset and expense accounts should be called debits, whereas
decreases in asset and expense accounts should be called credits. He also said that
increases in liabilities, owner’s equity, and revenue accounts should be called
credits, whereas decreases in liabilities, owner’s equity, and revenue accounts
should be called debits.

Table 2-3 summarizes the information that I just shared. Unfortunately — and

you can’t get around this fact — you need to memorize this table or dog-ear the
page so that you can refer to it easily.
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TABLE 2-3

TABLE 24

You Must Remember This

Account Debit Credit
Assets Increase Decrease
Expenses Increase Decrease
Liabilities Decrease Increase
Owner's equity Decrease Increase
Revenue Decrease Increase

In Pacioli’s debits-and-credits system, any transaction can be described as a set of
balancing debits and credits. This system not only works as financial shorthand,
but also provides error checking. To get a better idea of how it works, look at some
simple examples.

Take the case of a $1,000 cash sale. By using Pacioli’s system or by using double-
entry bookkeeping, you can record this transaction as shown here:

Cash ‘ $1,000 ‘ Debit

Sales revenue ‘ $1,000 ‘ Credit

See how that works? The $1,000 cash sale appears as both a debit to cash (which
means an increase in cash) and a $1,000 credit to sales (which means a $1,000
increase in sales revenue). Debits equal credits, and that’s no accident. The
accounting model and Pacioli’s assignment of debits and credits mean that any
correctly recorded transaction balances. For a correctly recorded transaction, the
transaction’s debits equal the transaction’s credits.

Although you can show transactions as I've just shown the $1,000 cash sale,
you and I may just as well use the more orthodox nomenclature. By conven-
tion, accountants and bookkeepers show transactions, or what accountants and
bookkeepers call journal entries, like the one shown in Table 2-4.

Journal Entry 1: Recording the Cash Sale

Account Debit Credit
Cash $1,000
Sales revenue $1,000

See how that works? Each account that’s affected by a transaction appears on a
separate line. Debits appear in the left column. Credits appear in the right column.
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You actually already understand how this account business works if you have a
checkbook. You use it to keep track of both the balance in your checking account
and the transactions that change the checking account balance. The rules of
double-entry bookkeeping essentially say that you’re going to use a similar
record-keeping system not only for your cash account, but also for every other
account you need to prepare your financial statements.

Here are a couple of other examples of how this transaction recording works.
In the first part of this discussion of how double-entry bookkeeping works,
I describe two other transactions: purchasing $1,000 of inventory for cash, and
spending $1,000 in cash on advertising. Table 2-5 shows how the purchase of
$1,000 of inventory for cash appears. Table 2-6 shows how spending $1,000 of
cash on advertising appears.

THAT DARN BANK

When | learned about double-entry bookkeeping, | stumbled over the terms debit and
credit. The way I'd heard the terms used before didn't agree with the way that double-
entry bookkeeping seemed to describe them. This conflict caused a certain amount
of confusion for me. Because | don't want you to suffer the same fate, let me quickly
describe my initial confusion.

If you look at Table 2-3, you see that an increase in an asset account is a debit, and
a decrease in an asset account is a credit. This means that in the case of your cash
account, increases to cash are debits and decreases to cash are credits.

At some time, however, you've undoubtedly talked to the bank and heard someone
refer to crediting your bank account — which meant increasing the account balance. And
perhaps that someone talked about debiting your account — which meant decreasing
the account balance. So what's up with that? Am | wrong, and is the bank right?

Actually, both the bank and | are right. Here's why. The bank is talking about debiting
and crediting — not a cash account and not an asset account, but a liability account. To
the bank, the money that you've placed in the account isn't cash (an asset) but a liability
(money that the bank owes you). If you look at Table 2-3, you see that increases in a
liability are credit amounts and decreases in a liability are debit amounts. Therefore,
from the bank’s perspective, when the bank increases the balance in your account, that
increase is a credit.

Your assets may represent another firm'’s liabilities. Your liabilities will represent
another firm's assets. Therefore, whenever you hear some other business talking about
crediting or debiting your account, what you do is exactly the opposite. If the business
credits, you debit. If the business debits, you credit.
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TABLE 2-6

Journal Entry 2: Recording the Inventory Purchase

Account Debit Credit
Inventory $1,000
Cash $1,000

Journal Entry 3: Recording the Advertising Expense

Account Debit Credit
Advertising $1,000
Cash $1,000

By tallying the debits and credits to an account, you can calculate the account
balance. Suppose that before Journal Entries 1, 2, and 3, the cash balance equals
$2,000. Journal Entry 1 increases cash by $1,000 (the debit). Journal Entries
2 and 3 decrease cash by $1,000 each (the $2,000 credits). If you combine all
these entries, you get the new account balance. The following formula shows the
calculation:

Beginning Cash Balance $2,000
Plus cash debit from Journal Entry 1 $1,000
Minus cash credit from Journal Entry 2 -$1,000
Minus cash credit from Journal Entry 3 -$1,000
Ending Cash Balance $1,000

Do you see how that works? You start with $2,000 as the cash account balance.
The first cash debit of $1,000 increases the cash balance to $3,000, and then the
cash credit of $1,000 in Journal Entry 2 decreases the cash balance to $2,000.
Finally, the cash credit of $1,000 in Journal Entry 3 decreases the cash balance
to $1,000.

You can calculate the account balance for any account by taking the starting
account balance and then adding the debits and credits that have occurred since
then. By hand, this arithmetic is a little unwieldy. Your computer (with the help of
QuickBooks) does this math easily.
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Looking at Almost a Real-Life Example

TABLE 2-7

REMEMBER

TABLE 2-8

TIP

To cement the concepts that I talk about in the preceding paragraphs of this chapter,
I want to quickly step through the journal entries, or bookkeeping transactions, that
you’d record in the case of the hot dog stand discussed in Book 1, Chapter 1. To start,
you need to know that the balance sheet shown in Table 2-2 is the balance sheet
at the start of the day, which means that the account balances in all the accounts
appear as shown in Table 2-7. This list of account balances is called a trial balance. It
shows the debit or credit balance for each account.

A Trial Balance at the Start of the Day

Account Debit Credit
Cash $1,000

Inventory 3,000

Accounts payable $2,000
Loan payable 1,000
S. Nelson, capital . 1,000
Totals $4,000 $4,000

I’m assuming that no year-to-date revenue or expenses exist yet for the hot dog
stand. In other words, the operation is at a starting period.

You may want to take a quick peek at Table 2-1, shown earlier. It summarizes the
business activities of the hot dog stand. The journal entries that follow show how
the information necessary for this statement would be recorded.

Recording rent expense

Suppose that the first transaction to record is a $1,000 check written to pay rent.
In this case, the journal entry appears as shown in Table 2-8. In this example,
$1,000 is debited to rent expense, and $1,000 is credited to cash.

Journal Entry 4: Recording the Rent Expense

Account Debit Credit
Rent $1,000
Cash $1,000
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TIP

Recording wages expense

If you need to record $4,000 of wages expense, you use the journal entry shown
in Table 2-9. This journal entry debits wages expense for $4,000 and credits cash
for $4,000. In other words, you use $4,000 of cash to pay wages for the business.

Journal Entry 5: Recording the Wages Expense

Account Debit Credit
Wages expense $4,000
Cash $4,000

Recording supplies expense

To record $1,000 of supplies expense paid for by writing a check, you record the
journal entry shown in Table 2-10. This transaction debits supplies expense for
$1,000 and credits cash for $1,000.

Journal Entry 6: Recording the Supplies Expense

Account Debit Credit
Supplies $1,000
Cash $1,000

Note that for each of the preceding transactions, debits equal credits. As long as
debits equal credits, you know that the transaction is in balance. This balance is
one of the ways that double-entry bookkeeping prevents errors.

Recording sales revenue

Suppose that you sell $13,000 worth of hot dogs. To record this transaction in a
journal entry, you debit cash for $13,000 and credit sales revenue for $13,000,
as shown in Table 2-11. I should tell you, however, that in the case of the hot
dog stand selling hot dogs for a dollar or two apiece, you wouldn’t necessarily
use a single journal entry to record sales revenue amounts. Though you could
use a single journal entry that tallied the entire day’s sales, if you’re selling hot
dogs at a dollar a dog, you could also record 13,000 $1 transactions. Each of these
$1 transactions debits cash for $1 and credits sales revenue for $1.
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TABLE 2-12

TIP

Journal Entry 7: Recording the Sales Revenue

Account Debit Credit
Cash $13,000
Sales revenue $13,000

Recording cost of goods sold

You must record the expense of the hot dogs and buns that you sell. You must
also record the fact that if you use up your inventory of hot dogs and buns, your
inventory balance has decreased. Table 2-12 shows how you record these items.
Cost of goods sold gets debited for $3,000, and inventory gets credited for $3,000.

Journal Entry 8: Recording the Cost of Goods Sold

Account Debit Credit
Cost of goods sold $3,000
Inventory $3,000

If you’re confused about this cost-of-goods-sold transaction — it represents the
first transaction that doesn’t use cash — read Book 1, Chapter 1, where I describe
the two accounting principles. In short, these two principles are as follows.

¥ Expense principle: Expense is counted when the item gets sold. This means
that the inventory isn't counted as cost of goods sold or as an expense when
it's purchased. Rather, the expense of each hot dog and bun you sell gets
counted when the item is actually sold to somebody.

3 Matching principle: Expense or cost of a sale is matched with the revenue
of the sale. This means that you recognize the cost of goods sold at the same
time that you recognize the sale. Typically, in fact, you can combine Journal
Entries 7 and 8.

Another way to think about the information recorded in Journal Entry 8 is this:
Rather than spend cash to provide customers hot dogs and buns, you spend
inventory.

Recording the payoff of accounts payable

Suppose that one thing you do at the end of the day is write a check to pay
off the accounts payable. The accounts payable are the amounts that you owe
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TABLE 2-13

TABLE 2-14

vendors — probably the suppliers from which you purchased the hot dogs and
buns. To record the payoff of accounts payable, you debit accounts payable for
$2,000 and credit cash for $2,000, as shown in Table 2-13.

Journal Entry 9: Recording the Payoff of Accounts Payable

Account Debit Credit
Accounts payable $2,000
Cash $2,000

Recording the payoff of a loan

Suppose also that you use cash profits from the day to pay off the $1,000 loan
that the balance sheet shows (refer to Table 2-2 earlier in this chapter). To record
this transaction, you debit loan payable for $1,000 and credit cash for $1,000, as
shown in Table 2-14.

Journal Entry 10: Recording the Payoff of the Loan

Account Debit Credit
Loan payable $1,000
Cash $1,000

Calculating account balance

You may already be able to guess that if you know an account’s starting balance
and have a way to add up the debits and the credits to the account, you can easily
calculate the ending account balance.

Take the case of the cash account balance of the hot dog stand. If you look at the
balance sheet shown in Table 2-2, you see that the beginning balance for cash
is $1,000. You can easily construct a little schedule of how the account balance
changes — this schedule is called a T-account — that calculates the ending
balance. (In case you’re wondering, a T-account is a visual aid to help in account-
ing. You start by drawing a big capital T, with debits on the left side and credits on
the right side.) In fact, Table 2-15 does just this. If you look closely at Table 2-15,
you see that the cash beginning balance is $1,000. Then, on the following lines of
the T-account, you see the effects of Journal Entries 4, 5, 6, 7, 9, and 10. Some of
these journal entries credit cash. Some of them debit cash. You can calculate the
ending cash balance by combining the debit and credit amounts.
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TABLE 2-16

A T-Account of the Cash Account

Beginning balance $1,000

Journal Entry 4 $1,000
Journal Entry 5 4,000
Journal Entry 6 1,000
Journal Entry 7 13,000

Journal Entry 9 2,000

Journal Entry 10 $1,000

Ending balance $5,000

The information shown in Table 2-15 should make sense to you. But in case you’re
still trying to memorize what debits and credits mean, I’'m going to give you a
bit more detail. To calculate the ending balance shown in Table 2-15, you add up
the debits, add up the credits, and combine the two sums. The net amount in the
cash account equals the $5,000 debit. If you recall from the preceding paragraphs,
a debit balance in an asset account, such as cash, represents a positive amount.
A $5,000 debit balance in the cash account, therefore, indicates that you have
$5,000 of cash in the account.

Cash is usually the trickiest account to analyze with a T-account because so many
journal entries affect cash. In many cases, however, a T-account analysis of an
account balance is much more straightforward. If you look at Table 2-16, you see a
T-account analysis of the inventory account. This T-account analysis shows that
the beginning inventory account balance equals $3,000. But when Journal Entry
8 credits inventory for $3,000 — this is the journal entry that records the cost of
goods sold — the inventory balance is wiped out.

A T-Account of the Inventory Account

Debit Credit

Beginning balance $3,000

Journal Entry 8 $3,000

Ending balance $0
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TABLE 2-18

Paying off the accounts payable and loan payable accounts is similarly straightfor-
ward. Table 2-17 shows the T-account analysis of the accounts payable account.
Table 2-18 shows the T-account analysis of the loan payable account. In both
cases, the T-account analysis shows that the liability accounts start with a credit
beginning balance. (Remember that a liability account would have a credit balance
if the firm really owed money.) Then, when the payments are recorded to pay off
the accounts payable and loan payable in Journal Entries 9 and 10, the liability
account is debited. The result, in the case of both accounts, is that the liability
account balance is reduced to zero.

A T-Account of Accounts Payable

Beginning balance $2,000
Journal Entry 9 $2,000
Ending balance $0

A T-Account of the Loan Payable Account

Beginning balance $1,000
Journal Entry 10 $1,000
Ending balance $0

I’m not going to show T-account analyses of the other accounts that the preced-
ing journal entries use. In every other case, the only debit or credit to the account
comes from the journal entry, which means that the journal entry amount is the
account balance. Only one journal entry affects the sales revenue account: Jour-
nal Entry 7, which credits sales revenue for $13,000. Because the sales revenue
account has no beginning balance, that $13,000 credit equals the sales revenue
account balance. The expense accounts work the same way.

Using T-account analysis results

If you construct (or your accounting program constructs) T-accounts for each
balance sheet and income statement account, you can easily calculate account
balances at a particular point in time by using the T-account analysis results.
Table 2-19 shows a trial balance at the end of the day for the hot dog stand. You
can calculate each of these account balances by using T-account analysis.

44, BOOK 1 An Accounting Primer



TABLE 2-19

REMEMBER

A Trial Balance at End of Day

Account Debit Credit
Cash $5,000

Inventory 0

Accounts payable $0
Loan payable 0

S. Nelson, capital $1,000
Sales revenue 13,000
Cost of goods sold 3,000

Rent 1,000

Wages expense 4,000

Supplies 1,000 .
Totals $14,000 $14,000

The first line shown in the trial balance in Table 2-19 is the cash account, with
a debit balance of $5,000. This debit account balance comes from the T-account
analysis shown in Table 2-15. The account balances for inventory, accounts pay-
able, and loan payable also come from the T-account analyses shown previously
in this chapter (Tables 2-16, 2-17, and 2-18).

As I note in the preceding section, you don’t need to perform T-account analyses
for the other accounts shown in the trial balance provided in Table 2-19. These
other accounts show a single debit or credit.

I need to make one final and perhaps already-obvious point: The information
provided in Table 2-19 is the information necessary to construct an income state-
ment for the day and a balance sheet as of the end of the day. If you take sales
revenue, cost of goods sold, rent, wages expense, and supplies expense from the
trial balance, you have all the information that you need to construct an income
statement for the day. In fact, the information shown in Table 2-19 is the infor-
mation used to construct the income statement shown in Table 2-1.

Similarly, the asset, liability, and owner’s equity balance information shown in

the trial balance provided in Table 2-19 supplies the information necessary to
construct a balance sheet as of the end of the day.
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The end-of-day balance sheet won’t balance unless you also include the profits of
the day. These profits, called retained earnings, are lumped into the owner’s capital
account and equal $4,000. You can see what this end-of-day balance sheet looks
like by reading Book 1, Chapter 1. In that chapter, Table 1-9 shows the end-of-day
balance sheet for the hot-dog-stand business.

Adding a Few Words about How
QuickBooks Works

46

Before I end this chapter, I want to make a few comments about how QuickBooks
helps you. First — and this point may be the most important one — QuickBooks
makes most of these journal entries for you. In Journal Entry 6, for example,
I show you how to record a $1,000 check written to pay for supplies, but you’d
never have to make this journal entry in QuickBooks. When you use QuickBooks
to record a $1,000 check that pays Acme Supplies for some paper products that
you purchased, QuickBooks automatically debits supplies expense (as long as you
indicate that the check is for supplies) and then credits cash.

Similarly, in the case of Journal Entries 7 and 8, when you produce an invoice that
records a sale, QuickBooks makes these journal entries for you. If you sold $13,000
worth of hot dogs and buns, and those hot dogs and buns actually cost you $3,000,
QuickBooks debits cash for $13,000, credits sales revenue for $13,000, debits cost
of goods sold for $3,000, and credits inventory for $3,000. In other words, for
most of your routine transactions, QuickBooks handles the journal entries for you
behind the scenes.

This doesn’t mean, however, that you can always avoid working with journal
entries. Any transaction that can’t be handled through a standard QuickBooks
form — such as the Invoice form or the Write Checks form — must be recorded
by using a journal entry. If you purchase some fixed asset by writing a check,
for example, the purchase of the fixed asset gets recorded automatically by
QuickBooks. But the depreciation that will be used to expense the asset over its
estimated economic life — something I talk a bit about in the next chapter —
must be recorded with journal entries that you construct yourself and enter a
different way.

One other really important point: I note in the preceding paragraphs that the trial
balance information shown in Table 2-19 provides the raw data that you need to
prepare your financial statement. I don’t want to leave you with a misunderstand-
ing, however: You don’t have to use this sort of raw data to prepare your financial
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statements. Predictably, QuickBooks easily, quickly, and effortlessly builds your
financial statements by using this trial balance information.

Just to put these comments together, then, QuickBooks automatically creates
most journal entries for you, builds a trial balance by using journal entry infor-
mation, and — when asked — produces financial statements. Most of the work
of double-entry bookkeeping, then, goes on behind the scenes. You don’t worry
about many journal entries on a day-to-day basis. And if you don’t want to ever
see a trial balance, you don’t have to. In fact, if you use QuickBooks only to pro-
duce invoices and to write checks that pay the bills, almost all the information
that you need to prepare your financial statements gets collected automatically.
So that’s really neat.

Not all the information that’s necessary for producing good, accurate financial
statements gets collected automatically. You’ll encounter a handful of important
cases that should be handled on a special basis through journal entries that you or
your CPA must construct and enter.
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» Sorting out accounts receivable and
accounts payable

» Keeping track of inventory

» Figuring out fixed assets

» Finding out about asset write-downs
» Recognizing liabilities

» Handling revenue and expense
account closings

Chapter 3

Special Accounting
Problems

ven if you understand the principles of accounting (which I describe in Book 1,
Chapter 1) and the basics of double-entry bookkeeping (which I describe
in Book 1, Chapter 2), you still may not have all the information that you
need to keep good records. Tracking the amounts that customers owe you and
the amounts that you owe vendors can be a bit tricky, for example. Inventory can
also present challenging record-keeping problems — a fact that’s not surprising
to you as a retailer. And things like fixed assets . . . oh, don’t even get me started.

For these reasons, this chapter describes the most common complexities that
business owners confront. You don’t need to be an accountant or an experienced
bookkeeper to understand the material in this chapter. You do need to proceed
carefully, take your time, and think a bit about how the material I describe here
applies to your specific business situation.
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Working with Accounts Receivable

TABLE 3-1

If you read Book 1, Chapter 1, you already know that accounting principles state
that sales revenue needs to be recognized when a sale is made and that the sale is
made when a business provides goods or services to a customer.

In other words — and this point is really important — sales revenue doesn’t get
recorded when you receive payment from a customer. Sales revenue gets recorded
when a customer has a legal obligation to pay you because you have (or your busi-
ness has) provided the customer the goods or services.

Recording a sale

This requirement to record sales revenue at the time that goods or services are
provided means that accounting for sales revenue is slightly more complicated
than you may have first guessed. The first transaction — the transaction that
records a sale — is shown in Table 3-1.

Journal Entry 1: Recording a Credit Sale

Account Debit Credit
Accounts receivable $1,000
Sales revenue $1,000

Journal Entry 1 shows how a $1,000 sale may be recorded. The journal entry shows
a $1,000 debit to accounts receivable (sometimes abbreviated A/R) and a $1,000
credit to sales revenue. To record a $1,000 sale — a credit sale — the journal entry
needs to show both the $1,000 increase in accounts receivable and the $1,000
increase in sales revenue.

Recording a payment

When the business receives payment from the customer for the $1,000 receivable,
the business records a journal entry like that shown in Table 3-2.

Journal Entry 2 shows a $1,000 debit to cash, which is the $1,000 increase in the
cash account that occurs because the customer has just paid you $1,000. Jour-
nal Entry 2 also shows a $1,000 credit to accounts receivable. This credit to the
accounts receivable asset account reduces the accounts receivable balance.
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Journal Entry 2: Recording the Customer Payment

Account Debit Credit
Cash $1,000
Accounts receivable $1,000

At the point when you record Journal Entries 1and 2, the net effect is a $1,000 debit
to cash (showing that cash has increased by $1,000) and a $1,000 credit to sales
revenue (showing that sales revenue has increased by $1,000). The $1,000 debit to
accounts receivable and the $1,000 credit to accounts receivable net to zero.

If you think about this accounts receivable business a bit, you should realize that it
makes sense. Although the accounts receivable account includes a $1,000 receiv-
able balance, this just means that the customer owes you $1,000. But when the
customer finally pays off the $1,000 bill, you need to zero out that receivable.

QuickBooks, by the way, automatically records Journal Entries 1 and 2 for you.
Journal Entry 1 gets recorded whenever you issue or create a customer invoice.
Therefore, you don’t need to worry about the debits and credits shown in
Journal Entry 1 except on one special occasion: When you set up QuickBooks and
QuickBooks items, you do specify which account should be credited to track sales
revenue. So, although you may not need to worry much about the mechanics of
Journal Entry 1, you should understand how this journal entry works so that you
can set up QuickBooks correctly. (Book 2, Chapter 1 describes the mechanics of
setting up QuickBooks.)

Items are things that get included in the invoices.

Journal Entry 2 also gets recorded automatically by QuickBooks. QuickBooks
records Journal Entry 2 for you whenever you record a cash payment from a
customer. You don’t need to worry, then, about the debits and credits necessary
for recording customer payments. I find that it’s helpful, however, to understand
how this journal entry works and how QuickBooks records this customer payment
transaction.

Estimating bad-debt expense

One other important journal entry to understand is shown in Table 3-3.

Journal Entry 3 records an estimate of the uncollectible portion of accounts receiv-
able. (Businesses that don’t want to keep accrual-based accounting statements
may not need to worry about Journal Entry 3.) Unfortunately, some of the money
you bill customers may be uncollectible. Yet Journal Entry 1 records every dollar
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that you bill your customers as revenue. Therefore, you need a way to offset, or
reduce, some of the sales revenue by the amount that ultimately turns out to be
uncollectible.

Journal Entry 3: Recording an Allowance for
Uncollectible Accounts

Account Debit Credit
Bad-debt expense $100
Allowance for uncollectible A/R $100

Journal Entry 3 shows a common way of doing this. This entry debits bad-debt
expense — which is an expense account that you may use to record uncollectible
customer receivables. Journal Entry 3 also credits another account shown as allow-
ance for uncollectible A/R. This allowance account is called a contra-asset account,
which means that it basically reduces the balance reported on the balance sheet of
an asset account. In the case of the allowance for uncollectible A/R accounts, for
example, this $100 credit reduces the accounts receivable balance shown in the
balance sheet by $100.

Where the bad-debt expense shown in Journal Entry 3 appears varies from business
to business. Some businesses report the bad-debt expense with the other sales
revenue, thereby allowing the income statement to show net sales revenue; other
businesses report it with the other operating expenses. You should report bad-
debt expense wherever it makes most sense in terms of managing your business.

QuickBooks doesn’t automatically record the transaction in Journal Entry 3. You
record estimates of bad-debt expense yourself by using the QuickBooks Make
General Journal Entries command. You can find out more about these types of
entries in Book 4, Chapter 1.

Removing uncollectible accounts receivable

If you do set up an allowance for uncollectible accounts, you also need to remove
the uncollectible accounts periodically from both the accounts receivable balance
and the allowance for uncollectible accounts. You don’t want to do this while any
chance to collect on the accounts exists. But at some point, obviously, you may
as well clean out the bad receivables from your records. It makes no sense, for
example, to have uncollectible receivables from 17 years ago still appearing in
your balance sheet. Table 3-4 illustrates how to clean out bad receivables.
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Journal Entry 4: Writing Off an Uncollectible Receivable

Account Debit Credit
Allowance for uncollectible $100
Accounts receivable $100

This journal entry debits the allowance from the uncollectible A/R account for
$100. The journal entry also credits the accounts receivable account for $100.
In combination, these two entries zero out the allowance for the uncollectible
A/R account and remove the uncollectible amount from the accounts receivable
account.

Writing off an actual, specific uncollectible receivable for invoice should be done
on a case-by-case basis, which is what Journal Entry 4 shows.

None of these entries is particularly tricky as long as you understand the logic —
something that I hope I’ve illuminated for you in this discussion. If you do have
trouble with these journal entries or with recording the economic events that they
attempt to summarize, you may want to consult your CPA. Most likely, you’d
record these same transactions (with different customers and amounts, of course)
many, many times over the year. If you can get a bit of help or a template that
shows you how to record these transactions, you should be able to record them
yourself without any outside help.

To write off an uncollectible account receivable, you record a credit memo and
then apply the credit memo to the uncollectible account. The item shown in your
credit memo should cause the allowance for uncollectible accounts to be debited.

Recording Accounts Payable Transactions

Within QuickBooks, you have the option of working with or without an accounts
payable account. If you want to, you can record expenses when you write checks.
This means that to have a complete list of all your expenses, you must have
recorded checks that pay all your expenses. This approach works fine — and, in
fact, is the approach that I've always used in my businesses.

QuickBooks also supports a more precise approach of recording expenses. By
answering a few questions during the QuickBooks setup process, you can set up
an accounts payable account, which is an account that tracks the amounts that
you owe your vendors and other suppliers.
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Recording a bill

When you use an accounts payable account, you enter the bills that you get from
vendors when you receive them.

Table 3-5 shows the way this transaction is recorded. Journal Entry 5 automati-
cally debits office-supplies expense for $1,000 and credits accounts payable for
$1,000. QuickBooks would record this journal entry if you purchased $1,000 of
office supplies and then entered that bill into the QuickBooks system.

Journal Entry 5: Recording a Credit Purchase

Account Debit Credit
Office supplies $1,000
Accounts payable $1,000

Paying a bill

When you later pay that bill, QuickBooks records Journal Entry 6, shown in
Table 3-6. In Journal Entry 6, QuickBooks debits accounts payable for $1,000 and
credits cash for $1,000. The net effect on accounts payable combining both the
purchase and the payment is zero. That makes sense, right? The approach shown
in Journal Entries 5 and 6 counts the amount that you owe some vendor or sup-
plier as a liability — accounts payable — only while you owe the money.

Journal Entry 6: Recording the Payment to Vendor

Account Debit Credit
Accounts payable $1,000
Cash $1,000

When you record Journal Entry 6 in QuickBooks, you must supply the name of the
account that gets debited. QuickBooks obviously knows which account to credit:
the accounts payable account. But QuickBooks also has to know the expense or
asset account to debit.

QuickBooks does need to know which cash account to credit when you pay an
accounts payable amount. You identify this account when you write the check to
pay the bill.
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Taking some other accounts
payable pointers

Let me make a couple of additional points about Journal Entries 5 and 6:

3 The accounts payable method is more accurate. The accounts payable
method, which Journal Entries 5 and 6 show, is the best way to record your
bills. The accounts payable method means that you record expenses when
the expenses actually occur. As you may have already figured out, the
accounts payable method is the mirror image of the accounts receivable
approach described in the early paragraphs of this chapter. The accounts
payable method, as you may intuit, delivers two big benefits: It keeps track of
the amounts that you owe vendors and suppliers, and it recognizes expenses
as they occur rather than when you pay them (which may be some time later).

3 Not every debit is for an expense. Journal Entry 5 shows the debit going to
an office-supplies expense account. Many of the accounts payable that you
record are amounts owed for expenses. Not every accounts payable transac-
tion stems from incurring some expense, however. You may also need to
record the purchase of an asset, such as a piece of equipment. In this case,
the debit goes not to an expense account, but to an asset account. Except for
this minor change, however, the transaction works the same way. | describe
how fixed-asset accounting works later in this chapter, in the section,
“Accounting for Fixed Assets.”

Can you guess how an expense or fixed-asset purchase gets recorded if you don’t
use an accounts payable account? In the case in which you paid $1,000 for office
supplies, QuickBooks debits office-supplies expense for $1,000 and credits cash
for $1,000 when you write a $1,000 check. As part of writing the check, you iden-
tify which expense account to debit.

If you’re purchasing a $1,000 piece of equipment, the journal entry looks and
works roughly the same way. When you record the purchase, QuickBooks debits
the asset account for $1,000 and credits cash for $1,000. Again, this transaction
gets recorded when you write the check to pay for the asset.

Looking at Inventory Accounting

Fortunately, most of the inventory accounting that goes on in a business gets
handled automatically by QuickBooks. When you purchase an inventory item by
writing a check or recording an accounts payable bill, for example, QuickBooks
automatically adjusts your inventory accounts for both the dollar value of the
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inventory and the quantity of the items. When you sell an inventory item to a cus-
tomer, QuickBooks again automatically adjusts the dollar value of your inventory
and adjusts the quantity counts of the items you sell.

Basically, all this means is that QuickBooks maintains a perpetual inventory
system — an inventory system that lets you know at any time what quantity of
items you have in inventory and what value your inventory amounts to. (In the
past, smaller firms often used a periodic inventory system, which meant that busi-
ness owners never really knew with any precision the dollar value of their inven-
tory or the quantity counts for the inventory items that they held.)

Although everything in the preceding paragraph represents good news, several
inventory-related headaches do require a bit of accounting magic. Specifically, if
your firm carries inventory, you need to know how to deal with obsolete inven-
tory, disposal of obsolete inventory, and inventory shrinkage. I discuss all three
accounting gambits in the following sections.

Dealing with obsolete inventory

Obsolete inventory refers to items that you’ve purchased for sale but turn out not to
be saleable. Perhaps customers no longer want it. Perhaps you have too much of
the inventory item and will never be able to sell everything that you hold.

In either case, you record the fact that your inventory value is actually less than
what you purchased it for. And you want to record the fact that really, the money
you spent on the obsolete itemn is an expense. Suppose that you purchased some
$100 item and now realize that it’s obsolete. How do you record this obsolescence?
Table 3-7 shows the conventional approach.

Journal Entry 7: Recording an Allowance for
Obsolete Inventory

Account Debit Credit
Inventory obsolescence $100
Allowance for obsolete inventory $100

As Journal Entry 7 shows, to record the obsolescence of a $100 inventory item, you
first debit an expense account called something like “Inventory obsolescence” for
$100. Then you credit a contra-asset account named something like “Allowance
for obsolete inventory” for $100. As I mention in the discussion of accounts
receivable, a contra-asset account gets reported on the balance sheet immediately
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below the asset account to which it relates. The contra-asset account, with its
negative credit balance, reduces the net reported value of the asset account. If the
inventory account balance is $3,100, and you have an allowance for an obsolete
inventory contra-asset account of $100, the net inventory balance shows up as
$3,000. In other words, the contra-asset account gets subtracted from the related
asset account.

QuickBooks requires you to record Journal Entry 7 yourself by using the Make
General Journal Entries command. You can find out more about these types of
entries in Book 4, Chapter 1.

Disposing of obsolete inventory

When you ultimately do dispose of obsolete inventory, you record a journal entry
like the one shown in Table 3-8. This journal entry debits the contra-asset account
for $100 and credits inventory for $100. In other words, this journal entry removes
the value of the obsolete inventory from both the allowance for obsolete inven-
tory account and the inventory account itself. You record this journal entry when
you actually, physically dispose of the inventory — when you pay the junk hauler
to haul away the inventory, for example, or when you toss the inventory into the
large trash bin behind your office or factory.

Journal Entry 8: Recording Disposal of Inventory

Account Debit Credit
Allowance for obsolete inventory $100
Inventory $100

In general, one thing you should do every year for tax accounting reasons is deal
with your obsolete inventory. The tax rules generally state that you can’t write
off obsolete inventory unless you actually dispose of it for income purposes.
Typically, however, you can write down inventory to its liquidation value. Such a
write-down works the same way as a write-down for obsolete inventory. A write-
down can be a little tricky if you’ve never done it before, however, so you may
want to confer with your tax adviser.

One more really important point about recording disposal of obsolete inven-
tory: Within QuickBooks, you record inventory disposal by adjusting the physical
item count of the inventory items. I describe how adjusting the physical inven-
tory accounts works in Book 3, Chapter 3. So even though I won’t go down that
path here, you should know that you don’t actually enter a journal entry like the
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one shown in Journal Entry 8. You adjust the inventory accounts for the obsolete
inventory. This adjustment automatically reduces the inventory account balance.
When QuickBooks asks you which account to debit, you specify the allowance for
obsolete inventory account.

Dealing with inventory shrinkage

The other chronic inventory headache that many business owners and business
managers have to deal with is inventory shrinkage. It’s very likely, sometimes
for the most innocent reasons, that your inventory records overstate the quantity
counts of items. When this happens, you must adjust your records. Essentially,
you want to reduce both the dollar value of your inventory and the quantity counts
of your inventory items.

WHY NOT JUST CREDIT THE ASSET
ACCOUNT?

If you're really getting into this double-entry bookkeeping, you may wonder why you
don't just credit the inventory account in the case of something like obsolete inventory.
Wouldn't that save you time and trouble? Well, yes and no.

Simply crediting the inventory account does make sense. Such an approach saves you
the task of having to set up a goofy contra-asset account. Accountants, however, have
concluded over the centuries that it makes sense to keep a record of your obsolete
inventory as long as you own it. There are a bunch of reasons for this approach, but one
reason is that you want to know what inventory you need to get rid of or dispose of.

It's not necessary to set up some sort of separate system for keeping track of obsolete
inventory. By using the contra-asset account, you can continue to store information
about your inventory in the accounting system without making the balance sheet infor-
mation and income statement information incorrect.

This logic applies to other contra-asset accounts, too. Earlier in this chapter, | describe
how to set up a contra-asset account for uncollectible accounts receivable. The busi-
ness about wanting to have some record of your uncollectible accounts receivable —
perhaps so that you know you don’t want to deal with those customers again — means
that you may as well keep this information in the accounting system. A contra-asset
account allows you to do so and at the same time not have uncollectible receivables
present to overstate your accounts receivable balance.
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Table 3-9 shows the journal entry that QuickBooks makes for you to record this
event. This journal entry debits an appropriate expense account — in Journal
Entry 9, I call the expense account “Shrinkage expense” — for $100. A journal
entry also needs to credit the inventory account for $100.

Journal Entry 9: Recording Inventory Shrinkage

Account Debit Credit
Shrinkage expense $100
Inventory $100

Within QuickBooks, as I’ve mentioned, you don’t actually record a formal journal
entry like the one shown here. You use something called a physical count worksheet
to adjust the quantities of your inventory item counts to whatever they actually
are. When you make this adjustment, QuickBooks automatically credits the inven-
tory account balance and adjusts the quantity counts. QuickBooks also requires
you to supply the expense account that it should debit for the shrinkage.

In the old days (by the old days, I mean a few decades ago), businesses compared
their accounting records with the physical counts of inventory items only once a
year. In fact, the annual inventory physical count was a painful ritual that many
distributors and retailers went through. These days, I think, most businesses have
found that it works much better to stage physical inventory counts throughout the
year. This approach, called cycle counting, means that you’re probably comparing
your accounting records with physical counts for your most valuable items sev-
eral times a year. For your moderately valuable items, you’re probably compar-
ing your inventory accounting records with physical counts once or twice a year.
With your least valuable inventory items, you probably compare inventory records
with physical counts only irregularly, and you may accept a degree of imprecision.
Rather than count screws in some bin, for example, you may weigh the bin and
then make an estimate of the screw count. In any case, you want some system that
allows you to compare your accounting records with your physical counts. Inven-
tory shrinkage and inventory obsolescence represent real costs of doing business
that won’t get recorded in your accounting records in any other way.

Accounting for Fixed Assets

Fixed assets are those items that you can’t immediately count as expenses when
purchased. Fixed assets include such things as vehicles, furniture, equipment, and
so forth. These assets are tricky for two reasons: Typically, you must depreciate
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them (more on that in a bit), and you need to record their disposal at some point
in the future for either a gain or a loss.

Purchasing a fixed asset

Accounting for the purchase of a fixed asset is pretty straightforward. Table 3-10
shows how a fixed-asset purchase typically looks.

Journal Entry 10: Recording Fixed-Asset Purchase

Account Debit Credit
Delivery truck $12,000
Cash $12,000

If you purchase a $12,000 delivery truck with cash, for example, the journal entry
that you use to record this purchase debits “Delivery truck” for $12,000 and cred-
its “Cash” for $12,000.

Within QuickBooks, this journal entry gets made when you write the check to pay
for the purchase. The one thing that you absolutely must do is set up a fixed-asset
account for the specific asset. In other words, you don’t want to debit a general
catch-all fixed-asset account. If you buy a delivery truck, you set up a fixed-asset
account for that specific delivery truck. If you buy a computer system, you set up a
fixed-asset account for that particular computer system. In fact, the general rule
is that any fixed asset that you buy individually or dispose of later individually
needs its own asset account. The reason is that if you don’t have individual fixed-
asset accounts, the job of calculating gains and losses on the disposal of the fixed
asset turns into a Herculean task later.

Dealing with depreciation

Depreciation is an accounting gimmick to recognize the expense of using a fixed
asset over a period of time. Although you may not be all that familiar with the
mechanics of depreciation, you probably do understand the logic. For the sake of
illustration, suppose that you bought a $12,000 delivery truck. Also suppose that
because you know how to do your own repair work and take excellent care of your
vehicles, you’ll be able to use this truck for ten years. Further suppose that at the
end of the ten years, the truck will have a $2,000 salvage value (your best guess).
Depreciation says that if you buy something for $12,000 and later sell it for $2,000,
that decrease in value can be apportioned to expense. In this case, the $10,000
decrease in value is counted as expense over ten years. That expense is depreciation.
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Accountants and tax accounting laws use a variety of methods to apportion the
cost of using an asset over the years in which it’s used. A common method is
called straight-line depreciation; it divides the decrease in value by the number of
years that an asset is used. An asset that decreases $10,000 over ten years, for
example, produces $1,000 a year of depreciation expense.

To record depreciation, you use a journal entry like the one shown in Table 3-11.

Journal Entry 11: Recording Fixed-Asset Depreciation

Account Debit Credit
Depreciation expense $1,000
Acc. dep. — delivery truck $1,000

CHOOSING A DEPRECIATION METHOD

Straight-line depreciation, which I illustrate here, makes for a good example in a book.
It's easy to understand and to illustrate. Most accountants and business owners use
more-complicated depreciation methods, however, for a variety of reasons. One of the
most important reasons is that tax accounting laws generally allow for depreciation
methods that accelerate tax deductions.

You can figure out the annual depreciation according to one of these tax-based depre-
ciation methods with your tax adviser’s help. Different rules apply to different types

of assets. The rules that you use for a particular asset depend on when you originally
purchased the asset. | recommend that you use the same asset depreciation method in
QuickBooks that you use for your tax accounting. Depreciation is complicated enough
as it is. You don't want to be using one method of depreciation within QuickBooks for
your own internal financial management and another method for your tax returns.

While I'm on the subject of depreciation, | should also mention that many small firms
have the option of using something called a Section 179 election. (Section 179 is a chunk
of law in the Internal Revenue Code.) A Section 179 election allows many businesses to
immediately depreciate 100 percent of the cost of many of their fixed assets at the time
of purchase. Despite the fact that a Section 179 election means that you can immediately
write off the purchase of, for example, a $12,000 delivery truck at the time of purchase,
you still want to treat fixed assets expensed via a Section 179 election the way | describe
here. The difference is that you'llimmediately show the asset as fully depreciated —
which means depreciated down to its salvage value or down to zero.
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Journal Entry 11 debits an expense account called “Depreciation expense” for
$1,000. Journal Entry 11 also credits a contra-asset account called “Acc. dep. —
delivery truck” for $1,000. (By convention, because the phrase accumulated depre-
ciation is so long, accountants and bookkeepers usually abbreviate it as acc. dep.)
Note also that you need specific individual accumulated depreciation contra-asset
accounts for each specific individual fixed-asset account. You don’t want to lump
all your accumulated depreciation together into a single catch-all account. Down
that way lie madness and ruin.

Disposing of a fixed asset

The final wrinkle of fixed-asset accounting concerns disposal of a fixed asset for
a gain or for a loss. When you ultimately sell a fixed asset or trade it in or discard
it because it’s now junk, you record any gain or loss on the disposal of the asset.
You also remove the fixed asset from your accounting records.

To show you how this works, consider again the example of the $12,000 delivery
truck. Suppose that you’ve owned and operated this truck for two years. Over that
time, you’ve depreciated $2,000 of the truck’s original purchase price. Further
suppose that you’re going to sell the truck for $11,000 in cash. Table 3-12 shows
the journal entry that you’d make to record this disposal.

Journal Entry 12: Recording Fixed-Asset Sale for Gain

Account Debit Credit
Delivery truck $12,000
Cash $11,000

Acc. dep. — delivery truck $2,000

Gain on sale $1,000

The first component of Journal Entry 12 shows the $12,000 credit of the delivery
truck asset. This makes sense, right? You remove the delivery truck from your
fixed-asset amounts by crediting the account for the same amount that you orig-
inally debited the account when you purchased the asset.

The next component of the journal entry shows the $11,000 debit to cash. This
component, again, is pretty straightforward. It shows the cash that you receive by
selling the asset.
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The third component of the journal entry backs out the accumulated deprecia-
tion. If you depreciated the truck $1,000 a year for two years, the accumulated
depreciation contra-asset account for the truck should equal $2,000. To remove
this accumulated depreciation from your balance sheet, you debit the accumulated
depreciation account for $2,000.

The final piece of the disposal journal entry is a plug — a calculated amount. You
know the amount and whether that amount is a debit or credit by looking at the
other accounts affected. In the case of Journal Entry 12, you know that a $1,000
credit is necessary to balance the journal entry. Debits must equal credits.

A credit is a gain. A credit is essentially revenue, as you may remember from the
discussion of double-entry bookkeeping in Book 1, Chapter 2.

If the plug was a debit amount, the disposal produces a loss. This makes sense; a
loss is like an expense, and expenses are debits.

If you’re confused about the gain component of Journal Entry 12, let me make
this observation. Over the two years of use, the business depreciated the truck by
$2,000. In other words, the business, through the depreciation expense, said that
the truck lost $2,000 of value. If, however, the $12,000 delivery truck is sold two
years later for $11,000, the loss in value doesn’t equal $2,000; it equals $1,000.
The $1,000 gain essentially recaptures the unnecessary extra depreciation that
was charged incorrectly.

You can enter Journal Entries 11 and 12 as journal entries in QuickBooks by using
the Make General Journal Entries command.

Recognizing Liabilities

Liabilities are amounts that a business owes to other parties. If a business owes a
bank money because of a loan, that’s a liability. If a business owes an employee
wages or benefits, that’s a liability. If a business owes the federal, state, or local
government taxes, those are liabilities.

Borrowing money

Liabilities, fortunately, aren’t too tricky to record after you’ve seen how the jour-
nal entries look. Table 3-13, for example, shows how you record money borrowed
on a loan. In the case of a $10,000 loan, you would debit cash for $10,000 and
credit a loan payable liability account for $10,000.
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Journal Entry 13: Borrowing Money via a Loan

Account Debit Credit
Cash $10,000
Loan payable $10,000

Sometimes, you may purchase an asset with a loan. Suppose that you purchased
$10,000 worth of furniture by using a note payable or a loan. Even though there’s
no immediate cash effect, you still record the transaction. Table 3-14 shows how
you record this transaction. A furniture account gets debited for $10,000, and a
loan payable account gets credited for $10,000.

Journal Entry 14: Buying an Asset with a Loan

Account Debit Credit
Furniture $10,000
Loan payable $10,000

You can record Journal Entry 13 directly in your checkbook when you record the
$10,000 cash deposit. You can also record Journal Entry 13, as well as Journal
Entry 14, by using the Make General Journal Entries command that QuickBooks
provides. By the way, you can record Journal Entry 14 only by using the Make
General Journal Entries command.

Making a loan payment

To record the payment on a loan, you or QuickBooks makes a journal entry like
the one shown in Table 3-15. Suppose that in connection with the loan shown in
Journal Entry 13, you need to pay $2,200. Further suppose that this amount is for
$1,200 of loan interest and $1,000 of principal. In this case, you debit loan pay-
able for $1,000, debit loan interest expense for $1,200, and credit cash for $2,200.

Journal Entry 15: Paying a Loan Payment

Account Debit Credit
Loan payable $1,000

Loan interest expense 1,200

Cash $2,200
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Sometimes, the tricky thing about loan payments is breaking the payment amount
into its principal and interest components. Ideally, the lender will provide you an
amortization schedule that breaks payments into principal and interest.

If a lender doesn’t provide such an amortization schedule, you can calculate the
interest expense yourself by using either a spreadsheet or a calculator. In Microsoft
Excel, right-click any worksheet tab, choose Insert from the shortcut menu, and
double-click the Amortization Table on the Spreadsheet Solutions tab of the result
dialog box. Then, after you’ve calculated the interest expense, you can deduce the
principal component by subtracting the interest from the payment amount.

Accruing liabilities

I want to show you one other liability-related journal entry. Very commonly, a
business owes money for some goods or services or taxes that must be recorded
in the accounting system. If, at the end of an accounting period — say, at the end
of the year — you owe $1,200 of interest on some loan, you really need to record
that interest expense in your accounting system. You want to record the fact that
although the loan balance may show as $10,000 in your accounting records, you
probably really owe $11,200, because you owe both the $10,000 of principal and
$1,200 of accrued interest.

To accrue a liability, you use a journal entry like the one shown in Table 3-16. This
journal entry shows the accrual of $1,200 of interest expense on a loan payable.

Journal Entry 16: Accruing a Liability

Account Debit Credit
Loan interest expense $1,200
Loan interest payable $1,200

The journal entry shows a $1,200 debit to loan interest expense and a $1,200 credit
to loan interest payable. This journal entry records amounts that you owe as of the
end of the accounting period that don’t get recorded in some other way.

You need to be careful about using journal entries like the one shown in Table 3-16.

Typically, you want to use such journal entries when it’s very important to count
all your expenses and to measure all your liabilities accurately.
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One common situation in which you want to be especially careful about mak-
ing such accruals occurs if you sell your firm. Any prospective purchaser wants
to have not only a very good estimate of your true expenses for the accounting
period, but also a very accurate estimate of liabilities at the time the business is
being evaluated.

Liability accruals like the one shown in Journal Entry 16 present a problem to
the accountant or bookkeeper, however. To return to the example of the accrued
interest shown in Journal Entry 16, suppose that at a later time, the business
makes a $3,000 payment, which includes the interest accrued in Journal Entry 16.
When the accountant or bookkeeper later records this loan payment, they must
remember or recognize the earlier journal entry. You don’t want the accountant
or bookkeeper to double-count interest expense by recording the same interest
again. This makes sense, right?

Because accountants and bookkeepers can’t reliably remember these sorts of
accrual entries — they may need to recall them months later — they typically
back out the effect of the accrual from the first day of the new accounting period.

If Journal Entry 16 were recorded at the end of year 1 to accurately estimate inter-
est expense and liability balances, an accountant or bookkeeper could, on the first
day of year 2, enter a reversing journal entry. This reversing journal entry would
credit loan interest expense for $1,200 and debit loan interest payable for $1,200.
In other words, this reversing journal entry reverses the earlier accrual. Because
the accrual entry is still in year 1, however, year 1’s estimates of interest expense
and liability account balances are still correct.

Table 3-17 shows how a reversing entry looks. Again, notice that it’s simply the
mirror image of Journal Entry 16. The debits and credits are flip-flopped.

Journal Entry 17: Reversing an Accrual

Account Debit Credit
Loan interest expense $1,200
Loan interest payable $1,200

When the actual loan interest payment is made, the journal entry appears as
though no accrual or reversal ever existed, as Table 3-18 shows. Suppose that at
some time in year 2, the business pays $1,800 in interest by making a cash pay-
ment. Journal Entry 18 shows how this transaction gets recorded.
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Journal Entry 18: The “Real” Loan Interest Payment

Account Debit Credit
Loan interest expense $1,800
Cash $1,800

Let me quickly summarize what happens with Journal Entries 16, 17, and 18:

3 Journal Entry 16 enables you to show that at the end of year 1, the business

owes $1,200 of interest on a loan — even though that interest hasn't yet been
paid. Journal Entry 16 also shows that even though the money wasn't paid,
loan interest expense of $1,200 was incurred.

3 Journal Entries 17 and 18 need to be combined to be understood. Journal

Entry 17, for example, reduces the loan interest payable to zero. Remember
that the loan interest payable would be a balance sheet liability account. The
combination of the $1,200 debit and credit zero this account out. The $1,200
credit to loan interest expense in Journal Entry 17 must be combined with the
$1,800 debit to loan interest expense in Journal Entry 18. This seems funny,
because after all, aren’t you really paying $1,800 of interest? That's true. But
looking back at Journal Entry 16, you can see that you've already recorded
$1,200 of loan interest expense. That interest expense has been recorded for
year 1 in this example. If you have $1,800 of loan interest in total, what's left
over for year 2 is the remaining $600. The combination of the $1,200 credit to
loan interest expense and the $1,800 debit to loan interest expense produces
this $600 of loan interest expense. The only other component of these two
journal entries is the $1,800 credit to cash. This credit to cash represents just
the actual cash payment that's made to pay the loan interest amount.

You need to be careful when working with accrual entries, reversing entries, and
then the real entries that follow and correct everything in the end. These tools can
be enormously helpful when it’s important to measure expenses and liabilities
accurately. You must remember to complete the entire sequence of transactions,
however; you can’t stop halfway.

One last important point: In Journal Entries 16, 17, and 18, I talk about how to
accrue loan interest expense. You can use this accrual technique to recognize any
liability — a fact that I want to emphasize. You can use the technique demon-
strated in these journal entries to deal with liabilities for things such as wages
owed to employees, taxes owed to the government, and so forth.
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Some firms, particularly those with sophisticated accounting systems, can
even use this technique to record hard-to-quantify liabilities, such as warranty
liabilities. (A warranty is a promise that you make to a customer. You might prom-
ise that your product won’t break, for example.) These promises create liabili-
ties and expenses. An accurate accounting system requires that you record these
expenses as they occur and recognize these liabilities as they come into existence.

Closing Out Revenue and Expense
Accounts

68

You're about to enter the twilight zone of accounting. In this section, I talk about
what happens to revenue and expense accounts at the end of the year in tradi-
tional manual accounting systems. Then I explain why QuickBooks doesn’t quite
work that way and what you need to do about it.

If you want to skip anything in this chapter, this section may be that material. On
the other hand, if you (like me) have a compulsive personality and deem it essen-
tial to read everything in this chapter (even stuff that’s not particularly exciting),
read on.

Book 1, Chapter 1 and Book 1, Chapter 2 describe an imaginary hot dog stand, a
one-day business that (in my imagination) you operate. (If you’ve been reading
this chapter and have no questions, you don’t even need to worry about the two
preceding chapters.) Table 3-19 shows the trial balance for this business at the
end of the day of operation.

The traditional close

As I hope you already know, revenue and expense accounts count revenue and
expenses for a particular period of time. Revenue and expense accounts may count
for the month, the quarter, or the year, for example.

One thing that accounting systems traditionally do is zero out the revenue and
expense accounts at the end of the year. This makes sense if you think about it
a bit. You want your counters reset at the beginning of the year so that counting
the new year’s revenue and the new year’s expenses is easy. In the case of a trial
balance like the one shown in Table 3-19, for example, you’d typically make the
journal entry shown in Table 3-20.
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TABLE 3-20

A Trial Balance at the End of the Period

Account Debit Credit
Cash $5,000

Inventory 0

Accounts payable $0
Loan payable 0

S. Nelson, capital 1,000
Sales revenue 13,000
Cost of goods sold 3,000

Rent 1,000

Wages expense 4,000

Supplies 1,000 _
Totals $14,000 $14,000

Journal Entry 19: Closing the Period

Account Debit Credit
Sales revenue $13,000

Cost of goods sold $3,000
Rent 1,000
Wages expense 4,000
Supplies 1,000
Owner's equity 4,000

If you look at Journal Entry 19 (Table 3-20), for example, you see that the first
line in the journal entry is a $13,000 debit for sales revenue. If you look back at
the trial balance shown in Table 3-19, you see that sales revenue has a $13,000
credit balance. The combination of the account balance shown in Table 3-19 and
the closing entry shown in Journal Entry 19 (Table 3-20) effectively zeros out the
sales revenue account.
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The same sort of accounting magic occurs for each of the other expense accounts
shown in the trial balance. The cost-of-goods-sold balance is equal to a $3,000
debit in Table 3-19 and is zeroed out in Journal Entry 19 with a $3,000 credit. And
so it goes.

The QuickBooks close

The sort of accounting taught at local community colleges makes just the sort of
closing entry shown in Journal Entry 19, but you don’t need or even want to make
such a closing entry within QuickBooks.

The closing entry shown in Journal Entry 19 gets made in a manual system so that
the revenue and expense accounts can be reset to zero. By comparison, QuickBooks,
relying on the power of the computer, doesn’t need to have these accounts reset
to zero to calculate the revenue and expenses for the new accounting period cor-
rectly. QuickBooks, as you discover throughout this book, can calculate revenue or
sales for any period and for any interval of time, using its report generation tool to
summarize the revenue and expenses that occur within a particular time interval.

This seemingly missed step doesn’t cause any idiosyncratic behavior on the part
of QuickBooks. QuickBooks lumps the revenue and expenses from all the previous
years into a retained earnings amount reported on the balance sheet. Net income
for the current year is also reported in the equity portion of the balance sheet. In
addition, if you have a corporation, QuickBooks typically includes a dividends paid
account in the equity portion of the balance sheet. I'm getting ahead of myself,
however.

The main thing that I want you to know is that this seemingly critical textbook
journal entry for closing out revenue and expense accounts isn’t made within
QuickBooks. This is okay, because QuickBooks doesn’t need to make the tradi-
tional closing entry.

You may want to ask your accountant about this entry. Typically, however, any
dividends paid by a corporation are zeroed out or combined with retained earn-
ings at the end of the year. If you want to combine dividends paid for the current
year with accumulative retained earnings, you do this with a journal entry. The
journal entry credits the dividends paid account and debits retained earnings for
the amount of dividends paid for the year. I hesitate to encourage you to make this
journal entry willy-nilly, however. I think it’s okay to skip making the entry. And
before you make it, consult your tax adviser.
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Adding One More Thing...

In this chapter, I try to address some of the common, complicated journal entries
and accounting transactions that business owners encounter. I know that I can’t
answer every question here, but I do want to provide as thorough a set of instruc-
tions as possible. All this is leading up to a special request: If you’ve read this
chapter and didn’t find a discussion of the sort of journal entry or accounting
transaction that you need to record, send me an email or write me a letter that
tells me what help you hoped to find here but didn’t. (You can get my contact
information at https://stephenlnelson.com.)

I can’t promise you that I’ll be able to supply an answer. But if you describe a
journal entry that I should have included, I'll try to respond to your email with
instructions on how to make the journal entry. I'll also include a description of the
journal entry in the next edition of this book.
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» Preparing for setup
» Setting up QuickBooks

» Figuring out your starting trial balance

Chapter 1
Setting Up QuickBooks

o use QuickBooks, you need to do two things: Install the QuickBooks software

and run the QuickBooks Setup process. This chapter gives you a bird’s-eye

view of both these tasks. I also want to spend just a few paragraphs talking
about some of the planning that you should do before you set up QuickBooks and
some of the missing steps in the QuickBooks Setup process — things it should do
but doesn’t. (Don’t worry. I tell you how to complete the missing steps, partly at
the end of this chapter and in the next chapter.)

Planning Your New QuickBooks System

I start with a couple of big-picture discussions: what accounting does and what
accounting systems do. If you understand this big-picture stuff from the very
start, you’ll find that the QuickBooks Setup process makes a whole lot more sense.

What accounting does

Think about what accounting does. People may argue about the little details, but
most would agree that accounting does the following four important things:

¥ Measures profits and losses

¥ Reports on the financial condition of a firm (its assets, liabilities, and net worth)
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¥ Provides detailed records of the assets, liabilities, and owner’s equity accounts

¥ Supplies financial information to stakeholders, especially to management

What accounting systems do

Now take a brief look at what accounting systems, or at least small-business
accounting systems, typically do:

¥ Produce financial statements, including income statements, balance sheets,
and other accounting reports

¥ Generate business forms, including checks, paychecks, invoices, customer
statements, and so forth

¥ Keep detailed records of key accounts, including cash, accounts receivable
(amounts that customers owe a firm), accounts payable (amounts that a firm
owes its vendors), inventory items, fixed assets, and so on

¥ Perform specialized information management functions

In the publishing industry, for example, book publishers often pay authors
royalties. So royalty accounting is a task that book publishers' accounting
systems typically must do.

What QuickBooks does

After you understand what accounting does and what accounting systems typi-
cally do, you can see with some perspective what QuickBooks does:

¥ Produces financial statements

¥ Generates many common business forms, including checks, paychecks,
customer invoices, customer statements, credit memos, and purchase orders

¥ Keeps detailed records of a few key accounts in simple settings, for example,
cash, accounts receivable, accounts payable, and inventory

Allow me to make an important observation here: QuickBooks does three of the
four things that you expect an accounting system to do. Compare the list that I
just provided with the preceding list (“What accounting systems do”). I’ll save
you the time of finding the fourth thing: QuickBooks doesn’t supply the special-
ized accounting stuff. It doesn’t do royalty accounting, for example, as discussed
in the earlier example.
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And now for the bad news

So, QuickBooks does three of the four things that accounting systems do, but it
doesn’t do everything. QuickBooks is often an incomplete accounting solution.
Be careful, therefore, about setting your expectations. Typically, you also need to
figure out work-arounds for some of your special accounting requirements.

QuickBooks gives users and businesses a lot of flexibility. To return to an ear-
lier example, a book publisher can do much of what it needs to do for royalty
accounting in QuickBooks. This royalty-accounting work simply requires a certain
amount of fiddling as the business is setting up QuickBooks.

But QuickBooks (or at least the most popular versions) does suffer from a couple
of significant weaknesses:

3 QuickBooks Pro doesn’t supply a good way to handle the manufacturing
of inventory. QuickBooks Premier and QuickBooks Enterprise Solutions do
support simple manufacturing accounting, however, and QuickBooks
Enterprise Solutions provides some additional inventory management
capability (multiple inventory sites, lot and serial number tracking, and FIFO
[firstin, first out] costing) as part of its Advance Inventory feature. These
versions of QuickBooks help you account for the process of turning raw
materials into finished goods and also deal with some real-life inventory
complexities.

3 Only QuickBooks Enterprise Solutions handles the situation of storing
inventory in multiple locations. In other words, QuickBooks Pro and
QuickBooks Premier simply show, for example, that you have 3,000 widgets.
They don't let you keep track of the fact that you have 1,000 widgets at the
warehouse, 500 widgets at store A, and 1,500 widgets at store B.

In spite of the fact that QuickBooks may be an incomplete solution and may not
handle inventory the way you want or need it to, QuickBooks is still a very good
solution. No, wait — that’s not really strong enough. What QuickBooks does, it
does very well.

As with a lot of things in life, finding the right accounting solution is all about bal-
ance. Some of the factors that you may consider when choosing your accounting
software would be ease of use, portability, price, data security, customer service,
and integration with other business tools. The desktop version of QuickBooks has
been a good balance of the things I need, which is why I use it for my business.
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TIP

The desktop version of QuickBooks provides considerably more horsepower
than the online version of QuickBooks (or other cloud-based systems). That
said, the online version makes it far easier to work with an outside accountant or
bookkeeper. Accordingly, for those clients who really need outside professional
help but don’t need advanced desktop features (such as job costing), the online
version of QuickBooks is a very reasonable choice, too.

Installing QuickBooks

You install QuickBooks the same way that you install most applications or pro-
grams, by downloading the software. I’d begin at https://quickbooks.intuit.
com/desktop, where you can compare some product options, chat with a sales
agent, or (if you’re ready) purchase the version of your choosing. After purchase,
you should be able to download the product; definitely reach out to Intuit if you
can’t. If you purchase a copy of QuickBooks from a bricks-and-mortar store,
you will receive instructions to download and an online activation code.

After downloading the program you don’t need to do anything special to install
QuickBooks. Simply follow the onscreen instructions.

The QuickBooks installation process may ask you to answer questions about how
you want QuickBooks to be installed. Almost always, you want to accept the default
suggestions. In other words, QuickBooks may ask you whether it can create a new
folder in which to install the program files. In this case, choose yes.

Dealing with the Presetup Jitters

78

After you install QuickBooks, you run an onscreen wizard to set up QuickBooks for
your firm’s accounting. Cleverly, this onscreen wizard is called QuickBooks Setup.
In the following sections, I explain what you need to do before you use QuickBooks
Setup so that you work in an efficient manner. I also give you an overview of what
you’ll do as you go through QuickBooks Setup.
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Preparing for setup

In running QuickBooks Setup, you provide quite a bit of information to QuickBooks.
As a practical matter, setup and post-setup cleanup (which I describe in this
chapter and the next one) require that you have the following:

¥ Accurate financial statements as of the conversion-to-QuickBooks date

¥ Detailed records of your accounts payable, accounts receivable, inventory,
and fixed assets

3 A complete or nearly complete list of employees, customers, vendors, and
inventory items (if you buy and sell inventory)

You want to get all this stuff together before you start QuickBooks Setup, because
(depending on how you go about setting up QuickBooks) you may be asked about
this stuff as part of the process. Don’t try to scurry around looking for a particu-
lar piece of data while you’re running the Setup Wizard; collect this data up front.
Then stack all the necessary paperwork on your desk next to your computer.

Let me also note that you’re going to make several accounting decisions as you go
through QuickBooks Setup. You may be asked to decide whether you want to use
an accounts payable system, for example. You may choose to use the Setup Wiz-
ard to tell QuickBooks whether you want to send customers monthly statements.
You may also be asked whether you want to prepare estimates for customers or
whether you want to use classes to further track your income and spending.

In general, when you’re asked any of the accounting questions, you can sim-
ply accept the default answer. You’re required by law to be consistent in your
accounting for tax purposes, however. If you want to change your accounting —
technically called a change of accounting method by the Internal Revenue Service —
you must request permission from the IRS to make that change. How to do this
and the ramifications of doing it are beyond the scope of this book, but be fore-
warned: The IRS insists that you be consistent in your accounting. If you’ve been
treating particular items of income or expense in a certain way, the IRS says,
“Hey, taxpayer, you must continue to treat them that way unless you get permis-
sion from us to change.”

I should make a clarification: You can use one accounting method for your tax
return and then, within QuickBooks, use a different accounting method. You may
be locked into using accrual-basis accounting on your tax return, for example,
but that doesn’t mean you can’t use cash-basis accounting in QuickBooks and in
managing your business. Accordingly, what I say in the preceding paragraphs is a
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little bit inaccurate. Technically. But you probably don’t want to use one account-
ing approach on your tax return and a different approach in QuickBooks. Too
complicated.

One final note: You should have your tax return from last year handy because it
supplies information that you need for running QuickBooks Setup. Last year’s tax
return, for example, supplies your taxpayer ID number, your legal business name,
and your method of accounting.

Seeing what happens during setup

As you walk through the setup process, you work with QuickBooks to set prefer-
ences (which determine how QuickBooks works and which features are initially
available) and to set up a chart of accounts and your bank accounts.

The chart of accounts, just so you know, identifies those income, expense, asset,
liability, and owner’s equity accounts that appear in your financial statements.

When you complete QuickBooks Setup, you’re almost ready to begin using Quick-
Books. In fact, in a pinch, you could (after QuickBooks Setup) limp along with
QuickBooks.

An important point of clarification. You may think that you should be ready to
rock and roll after installing QuickBooks and running through the setup process.
But you have two other tasks to complete: identifying your starting trial balance
(which I describe at the end of this chapter) and loading your key master files
(which I describe mostly in the next chapter). The trial balance identifies your
year-to-date income and expense numbers, as well as your asset, liability, and
owner’s equity numbers as of the conversion date. The master files store infor-
mation about customers, vendors, employees, and inventory items that you use
repeatedly. The customer master file, for example, stores a customer’s name and
address, phone number, and the contact person’s name (if different).

Running the QuickBooks Setup Wizard

80

After you install the QuickBooks program, the installation program may start
QuickBooks automatically and then start QuickBooks Setup. You can also start
QuickBooks Setup by starting the QuickBooks program the same way that you
start any program and then choosing File => New Company.
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FIGURE 1-1:

The QuickBooks
Desktop Setup
window.

Getting the big welcome

The QuickBooks Desktop Setup screen of QuickBooks Setup (see Figure 1-1)
appears when you choose File > New Company. The screen gets you started cre-
ating a new company file within QuickBooks. The screen has two radio buttons to
choose between. The For Myself (I’'m the Admin) button enables you to set up the
new file as the admin, in which case you use your email address to create the file.
The For Someone Else button enables you to set up the file on behalf of the admin,
in which case you use that person’s email address to set up the file.

Intuit Qui e countant 24 .0

(D Better control of your data

-

v Superior fraud protection

& One account for all Intuit products

Who are you creating the company file for?

© For myself (I'm the admin)
My email will be used to create an Intuit account, which will be used to access all Intuit products.

- For someone else

T'm creating the company file on behalf of the admin

Contral the setup and fine-tune the Create a new company file based Convert data from Quicken or other
company file on an existing one. accounting software.

Detailed Start Create Other Options ¥

10:25 AM

77772023

The Detailed Start button (refer to Figure 1-1) allows you to choose the advanced
setup option, which walks you through a bunch of screens full of information
that let you rather tightly specify how the company file that QuickBooks sets up
should look.

Supplying company information

The first few screens of the EasyStep Interview collect several important pieces of
general information about your business, including your company name and the
firm’s legal name, your company address, the industry in which you operate, your
federal tax ID number, the first month of the fiscal year (typically, January), the
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FIGURE 1-2:

The first screen
of the EasyStep
Interview collects
general company
information.

A

WARNING

Q

TIP

type of income tax form that your firm uses to report to the IRS, and the industry
or type of company that you’re operating (retail, service, and so forth). The first
screen of the EasyStep Interview is shown in Figure 1-2.

Intuit QuickBooks Enterprise Solutions: ountant 24 0

EasyStep Intenview

¥ Getanswers

Enter your company information
EasyStep’Interview
QuickBooks uses this information on your tax forms and forms you use to communicate with your

customers and vendors
Interview Progress " Companyname pine | o Porcelain LLG

Legal name Pine Lake Porcelain LLC

use 2 DBA name, this wil probably

123456789

Your Federal Emplayer Identification Number {EIN] or Socisl Security Number, Used ol
forms,

Streetaddress 43 yain Street

City Pine Lake State wa - 7P gg765
Country us.

Phane 4258817350 Far ]
Use the format you would like displayed on your forms, e.g. (555) 555-1212

E-mall address

‘Web site

Need help setting up? vt * required field ‘What if | have more than one business?

Find ALocal QuickBooks
Expert
(fees may apply) Leave...

QuickBooks isn’t very smart about the tax accounting rules for limited liability
companies (LLCs). An LLC can be treated as a sole proprietorship if it has one
owner and as a partnership if it has more than one owner. But LLCs may also elect
to be treated as S corporations or C corporations. If you’ve made such an election
for your LLC, be sure to indicate that the LLC is an S corporation or C corporation.

To move to the next screen in the EasyStep Interview, click the Next button. To
move to the previous screen, click the Back button. If you get discouraged and
want to give up, click the Leave button. But try not to get discouraged.

After collecting this general company information, QuickBooks creates the
company data file that stores your firm’s financial information. QuickBooks sug-
gests a default name or a QuickBooks data file based on the company name (see
Figure 1-3). All you need to do is accept the suggested name and the suggested
folder location (unless you want to save the data file in the Documents folder,
which isn’t a bad idea).
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FIGURE 1-3:

The Filename for
New Company
dialog box.

Intuit QuickBooks Enterpr

Solutions: Accountant 240

-3

x

Eile Help

EasyStep’Interview

|
Interview Progress

Need help setting up? n
ntur

Find ALocal QuickBooks
Expert
(fees may apply) ‘

Save

*

EasySte

p Interview

Create your company file

Your QuickBooks information is stored in a file called the company file.

Filenam

e for New Campany

ein: | || Pine Lake Porcelan LLC

Name

Quick access

|
Desktop

Libraries

=
@

<

M < B A=

Date medified

Mo items match your search.

Fie name | Pine Lake Porcelain LLC

Save asiype

| GuickBooks Fies (-QBW." GBA)

Customizing QuickBooks

After QuickBooks collects the general company information mentioned in the pre-
ceding paragraphs, the EasyStep Interview asks you some very specific questions
about how you run your business so that it can set the QuickBooks preferences.
Preferences in effect turn various accounting features of QuickBooks on or off,
thereby controlling how the program works and looks. Here are the sorts of ques-

tions that the EasyStep Interview asks to set the QuickBooks preferences:

»
»
»
»
»
»

Does your firm maintain inventory?

Do you want to track the inventory that you buy and sell?

Do you collect sales tax from your customers?

x

Do you want to use sales orders to track customer orders and back orders?

Do you want to use QuickBooks to help with your employee payroll?

Do you need to track multiple currencies within QuickBooks because you deal
with customers and vendors in other countries, and do these people regularly
have the audacity to pay or invoice you in a currency different from the one

your country uses?
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3 Would you like to track the time that you or your employees spend on jobs or
projects for customers?

¥ How do you want to handle bills and payments (enter the checks directly, or
enter the bills first and the payments later)?

Setting your start date

Perhaps the key decision that you make in setting up any accounting system is
the day on which you begin using your new system. This day is called the conver-
sion date. Typically, you want to begin using an accounting system on the first day
of the year or the first day of a new month. Accordingly, one other big question
you’re asked is about the conversion date. You’re prompted to identify the start
date by using the dialog box shown in Figure 1-4.

-« Pine Lake Porcelain LLC - Intuit Quic nterpris jons: Accountant 24.0
File

-easy step

My Shortc

-
e T

EasyStep Interview x

@ Getanswers

% peod Select a date to start tracking your finances
0 EasyStep Interview
. The date you select will be your start date in QuickBooks

Hom
L
Pl oS © Beginning of this fiscal year: 01/01/2023

In order to complete this years tax returns, you'll need to enter transactions

from the beginning of this fiscal year to taday.

0 Cast

@ Use today's date or the first day of the quarter or month.
You'll need to enter transactions from this date forward

By i1 12024 @
Cale What date should | choose?

€ sna

® Inco

[ My Shar
B view Ba
M Run Fay

H openw

Need help setting up?

FIGURE 1-4: Find ALocal QuickBooks et
The EasyStep DRI
Interview dialog
box that lets
you select the
start date.

The easiest time to start using a new accounting system is the beginning of the
year. The reason? You get to enter a simpler trial balance. At the start of the year,

for example, you enter only asset, liability, and owner’s equity account balances.
TIP
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At any other time, you also enter year-to-date income and year-to-date expense
account balances. Typically, you have this year-to-date income and expense
information available only at the start of the month. For this reason, the only
other feasible start date that you can pick is the start of a month.

In this case, you get year-to-date income amounts through the end of the
previous month from your previous accounting system. If you’ve been using
Sage 50 Accounting, for example, get year-to-date income and expense amounts
from Sage.

After you’ve provided the start date, supplied the basic company information,
identified most of your accounting preferences, and identified the date on which
you want to start using QuickBooks, you’re almost done.

If you click the Leave button, QuickBooks leaves you in the QuickBooks program,
ready to get to work. The EasyStep Interview process isn’t lost forever, however.
To get back into the interview, just open the file you were in the process of setting
up. When you do, the EasyStep Interview restarts.

Reviewing the suggested chart of accounts

At the very end of the EasyStep Interview, based on the information that you sup-
ply about your type of industry and the tax return form that you file with the IRS,
QuickBooks suggests a starting set of accounts, which accountants call a chart
of accounts. These accounts are the categories that you use to track your income,
expenses, assets, liabilities, and owner’s equity. Figure 1-5 shows the screen that
the EasyStep Interview displays for showing you these accounts.

The accounts that QuickBooks marks with a check, as the screen explains, are the
recommended accounts. If you don’t do anything else, these checked accounts are
the ones you’ll use (at least to start) within QuickBooks. You can remove a sug-
gested account by clicking the check mark. QuickBooks removes the check mark,
which means that the account won’t be part of the final chart of accounts. You can
also click an account to add a check mark and have the account included in the
starting chart of accounts.

You can click the Restore Recommendations button at the bottom of the list to
return to the initial recommended chart of accounts (if you made changes that you
later decide you don’t want).

When the suggested chart of accounts looks okay to you, click Next. It’s

fine to accept what QuickBooks suggests because you can change the chart of
accounts later.
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FIGURE 1-5:

The EasyStep
Interview screen
shows you its
recommended
income and
expense
accounts.

® Pine Lake Parcelain LLC - Intuit QuickBooks Enterprise Solutions: Accountant 24.0

Eile Help

-easy step
My Shortc # Getanswers

Review income and expense accounts
EasyStep’Interview
Income and expense accounts calegorize money your business eams from, or spends on, normal

T He business operations.
|
B i s for your industry are typically all you need
& for income tax purposes. Explain

B cast ACCOUNT NAME TvPE
Mercnandise Sales Income
e Inco Sales Discounts Income

Senice Sales Income

& Bl

Merchant Account Fees Cost of Goods Sold

Cale Product Samples Expense Cost of Goods Sold

€ sna

- Advertising and Pramotion Expense

Purchase Discounts Cost of Goods Sold

Purchases - Resale ltems Cost of Goods Sold

B My Shor Automobile Expense Expense

B View Ba
M Run Fay Restore Recommendations

B openw You can modify your chart of accounts anytime after completing this interview.

Need help setting up? —
nfurt

Find ALocal QuickBooks
Expert
(fees may apply)

Adding your information
to the company file

After you and QuickBooks set up the company file, QuickBooks prompts you to
enter your own information in the company file (see Figure 1-6).

Customers, vendors, and employees

To describe customers, vendors, and employees, click the first Add button. Quick-
Books asks whether it’s possible to get this data from someplace else, such as an
email program or email service (Outlook, Gmail, and so forth), or whether you
want to enter the information into a worksheet manually. You’re probably going
to enter the information manually, so click the appropriate button and then click
Continue. When QuickBooks displays a worksheet window (see Figure 1-7), enter
each customer, vendor, or employee in its own row and be sure to include both
the name and address information. Click Continue (not shown in Figure 1-7) when
you finish. Then QuickBooks asks (using a screen I don’t show here) whether you
want to enter opening balances — amounts you owe or are owed — for customers
and vendors. Indicate that you do by clicking the Enter Opening Balances link and
then enter the opening balances in the screen that QuickBooks provides.
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FIGURE 1-6:

The QuickBooks
Setup screen that
prompts you to
enter your own
information in
the company file.

FIGURE 1-7:

The QuickBooks
Setup screen
that collects
information
about the
people you do
business with.

Add the people you do business with i

‘Why do this? Import or enter your contacts so you can bill your customers, pay
your vendors, and track your employees. ses how it works

@ snapshots Add the products and services you sell

a You've added 2 non-inventory parts
@ My Shortcuts

B View Balances

M Run Favorite Reports.
B Open Windows

Add your bank accounts i

‘Why do this? So you can track deposits, payments and how much money you
have. Don't worry we won't connect to your bank. &see how &t works

No data to enter right now? No problem. You can always add it later.

tomers  Vendors

) Add the people you do business with oo 5

[® My Company
& T Enter your contacts below and mark each one as a customer, vendor, or employee. You can save time by pasting fron

h Flow Hub worry about getting everything perfectly, we'll let you know if you need to fix anything. How does this work?

In Income Tracker skip Customer Vendor Employee Name Company Name  First Name  Last Name  Email Phone

Selectall  Selectall  Selectall  Selectall
B Bill Tracker

Calendar

@ snapshots
[ My Shortcuts
B View Balances

[ Run Favorite Reports

[olcCHONOHOHOHONONC]
0000000000
0000000000
0000000000

B Open Windows

0 contacts selected
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Services and inventory items you sell

To describe the stuff you sell, click the second Add button in the second box shown
in Figure 1-6. QuickBooks asks about the stuff you sell — whether you sell ser-
vices, whether you sell inventory items, and whether you want to track any such
inventory items you sell, for example. Answer these questions by clicking the but-
ton that conforms to your situation and then click Continue. When QuickBooks
displays a worksheet window (not shown), describe each item you sell on a sep-
arate worksheet row. Also be sure to describe any inventory items you’re holding
at the time you convert to QuickBooks. Click Continue when you finish. If you sell
more than one type of item, you need to repeat this process for each type of item.

Business bank accounts

To describe your business bank account (or bank accounts), click the Add button in
the third box shown in Figure 1-6. When QuickBooks displays the Add Your Bank
Accounts worksheet window (not shown), provide each bank account’s name,
account number, and balance on the conversion date. When you finish entering
this information, click Continue.

Identifying the Starting Trial Balance

88

Whether you use the default Start version or the Detailed Start/EasyStep Interview
version of the QuickBooks Setup process, you don’t get a complete trial balance
in the QuickBooks company file simply by setting up. Assuming that you follow
the instructions and tips provided in the preceding paragraphs, you get only your
bank account, accounts receivable, inventory, and accounts payable balances in
QuickBooks. Yet you need to enter all the missing trial balance information in
QuickBooks, too, to begin getting good reports out of QuickBooks and to use the
software for supplying financial data to your tax returns. I end this chapter by
talking about how you get the rest of the trial balance data into the QuickBooks
company file.

A simple example to start

To record the rest of your starting trial balance, you record a journal entry. The
journal entry records the remaining trial balance amounts for all your other
accounts at the conversion or start date: accounts other than your bank accounts,
accounts receivable, accounts payable, and inventory.

To see how this process works, suppose that you have the trial balance shown
in Table 1-1. Note that these trial balances are used in the discussion in Book 1,

BOOK 2 Getting Ready to Use QuickBooks



TABLE 1-1

Chapter 2 and shown in that chapter’s Table 2-19. Also notice that no balance
is recorded for a bank account, no balance is recorded for accounts receivable
(because this account doesn’t even show up in the trial balance), and no balances
are recorded for inventory or accounts payable (because these accounts have zero
balances at the conversion date). For purposes of this example (but not the next
example), the cash balance isn’t a bank account but is actually cash: a desk drawer
full of low-denomination, used bills with nonsequential serial numbers.

A Trial Balance

Account Debit Credit
Cash $5,000

Inventory 0

Accounts Payable $0

S. Nelson, Capital 1,000
Sales Revenue 13,000
Cost of Goods Sold 3,000

Rent Expense 1,000

Wages 4,000

Supplies 1,000

Totals $14,000 $14,000

Figure 1-8 shows how the Make General Journal Entries window looks when it
records the missing trial balance information from Table 1-1. After this journal
entry is recorded, the trial balance is correct as of the start date.

For more information about how to record a journal entry by using the Make Gen-
eral Journal Entries window, see Book 4, Chapter 1. If you want to try this on your
own with no further instruction from me, choose the Company <> Make General
Journal Entries command. When QuickBooks displays the Make General Journal
Entries window, shown in Figure 1-8, use the Account, Debit, and Credit columns
to record your journal entry.

If the idea of making a journal entry terrifies the heck out of you, you may find
yourself in a bit of a pickle. You need to become comfortable working with double-
entry bookkeeping to set up QuickBooks at a time other than the beginning of the
year. This means, unfortunately, that if you’re setting up QuickBooks sometime
during the middle of the year, you must enter a general journal entry to fix the
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FIGURE 1-8:
The Make

General Journal
Entries window,
showing a simple

90

trial balance.

weirdness that the QuickBooks Setup creates. If you don’t know how double-entry
bookkeeping works — if debits and credits aren’t your friends — you probably
need to get somebody’s help. I suggest that you call your CPA or some other friend
who truly understands accounting. Get them to come over and enter the last part
of the trial balance for you by using the Make General Journal Entries window.

Pine Lake Porcelain LLC - Intuit QuickBooks Enterprise Solutions: Accountant 24.0 - [Make General Journal Entries]

Edit View Lists Favorites Accountant Company Customers Vendors Employees Banking Reports Window Help '@‘ DhOEY Q|- = x

e e LN [
My Company Cash Flow Hub Income Tracker Bill Tracker Calendar Snapshots Customers. Docs

Vendors Employees | Bank Feeds

=

Main | Reports

@ P i E g@ B create a Copy 'l g @ 6 =

Find New Save Delele & Memorize Reverse Print | Aftach Hide Send
= File List GUEs

~

perz 011012024 B =vtavio. (1

G ENTRY

Cash 5,000.00 ‘A

Cost of Goads Sold 3,000.00 (]
RentExpense 500.00
Wages 4,000.00
Supplies 1,000.00
Sales Revenue 12,500.00 Mel's Gourmet Eats
v
Totals 13,500.00 13,500.00

List of Selected General Journal Entries:  Last Month -

saves Close | [EEC ST Revert

Note: This project shouldn’t be a big one if you decide to call your CPA. If they
come over to your office, and if you have the trial balance ready, it should take
them only a few minutes to enter the necessary general journal entry. Perhaps you
can buy them a nice lunch, and that will settle the score.

A real-life example to finish

Okay, true confessions. The example I give in the preceding section? You prob-
ably won’t be lucky enough that your starting trial balance journal entry will be so
simple. You probably will have to deal with a bank account and with account bal-
ances in your accounts receivable, accounts payable, or inventory accounts. Now I
show you how this process works.
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TABLE 1-2

Suppose that you have the trial balances shown in Table 1-2. Note that in this
example (unlike the preceding example), the first account shown — the one with
$5,000 — is a bank account.

A Trial Balance

Account Debit Credit
Checking $5,000

Accounts Receivable 4,000

Inventory 2,000

Loan Payable 5,000
S. Nelson, Capital 2,000
Sales Revenue 13,000
Cost of Goods Sold 3,000

Rent Expense 1,000

Wages 4,000

Supplies 1,000

Totals $20,000 $20,000

Here’s the tricky part of recording this trial balance. You don’t need — I repeat,
don’t need — to record all this trial-balance information through a journal entry.
Because the bank account, accounts receivable, accounts payable, and inventory
portions have already been recorded if you added customer, vendor, item, and
bank account information during the QuickBooks Setup process, you just need to
enter the rest of the trial balance.

Because you won’t be recording all the trial balance, however, your journal entry
not only won’t match your actual trial balance, but also won’t balance. To make it
balance, therefore, you plug the difference into an account that QuickBooks sup-
plies for just this sort of bookkeeping madness: the Opening Balance Equity account.
Figure 1-9 shows this journal entry.
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pare 01012024 ENTRY NO. |2
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Find New Save Delete {3 Memorize Reverse Print

]
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File
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Hide Send
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Loan Payable 5,000.00
S Nelson Capital 2,000.00
Sales Revenue 13,000.00
Cost of Goods Sold 3,000.00 l
Rent Expense 1,000.00
Wages 4,000.00
Supplies 1,000.00
Big National Bank 5,000.00
v
Totals 20,000.00 20,000.00
List of Selected General Journal Entries; Last Month A

FIGURE 1-9:

The Make
General Journal
Entries window,
showing the final
part of a more-
complicated

trial balance.

Clear

Save & Close
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Chapter 2

Loading the Master
File Lists

hen you set up QuickBooks 2024, as a practical matter, you not only cre-
ate a company file that you’ll use to store financial information about
your business, but also set up master file lists. These master file lists
store information that you can use and reuse. One of the master file lists describes
each of your customers; this master file of customer information includes the
customer’s name and address, contact information, account numbers, and so on.

In this chapter, I walk you through the process of adding information to each of
the master files — or lists, as QuickBooks calls them — that you need to fill (or
mostly fill) before you begin using QuickBooks on a day-to-day basis.

One important note: You don’t need to completely fill your master files before you
start doing anything. If you enter your active customers into the customer master
file, your active vendors into the vendor master file, and so forth, that amount of
information may be all you need to get started. With the information you entered
through the QuickBooks Setup process (as described in Book 2, Chapter 1) and
the addition of a few more entries in key master files, you may be able to add
everything else on the fly. QuickBooks enables you to add entries to the various
master files as you work with windows and dialog boxes that reference master file
information.
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Setting Up the Chart of Accounts List

The Chart of Accounts list is a list of accounts that you use to categorize your income,
expenses, assets, liabilities, and owner’s equity amounts. If you want to see a par-
ticular line item of financial data on a report, you need an account for that line
item. If you want to budget by a particular line item, you need an account for that
budget amount. If you want to report some bit of financial information on your tax
returns, you need an account to collect that specific data.

Fortunately, the steps for creating new accounts are quite straightforward. To set
up a new account within your Chart of Accounts list, follow these steps:

1 . Choose the Lists &> Chart of Accounts command.

QuickBooks displays the Chart of Accounts window, shown in Figure 2-1.

Jorcelain LLC - Intuit Qui

= File Edit View Lists Favorites Company Customers Vendors Employ
Home My Company Cash Flow Hub Income Tracker Bil Tracker La:jar Snapshots Customers Vendors Employees  Bank Feeds
Look for account name or number
& ! NAME - £ TveE BALANCE TOTAL ATTACH
. Bank Senice Charges Expense A
[+ Big National Bank Bank 266,938 96
» Capital Stack Equity 0.00
|+ Cash Bank 1,525.00
- Computer and Intermet Expenses Expense
| Consulting Revenue Income .
|- Cost of Goods Sold Expense
|+ Cost of Goods Sold 2 Cost of Goods Sold
+ Depreciation Expense Expense
+ Estimates Non-Posting
|+ Finance Charges Other Income
[+ Frequent Flyer Card Credit Card 0.00
» Furniture and Equipment Fixad Asset 0.00
- Insurance Expense Expense
- Interest Expense Expense
< Interest Income Other Income
[+ Inventory Asset Other Current Asset 12,283 50
+ Janitorial Expense Expense
|+ Loan Payable Other Current Liability 5,000.00
|+ Meals and Entertainment Expense
[+ MerchantAccount Fees Cost of Goods Sold
|- Office Supplies Expense
FIGURE 2-1: |, opening Batance Equry Equity 9,387.50
The Chart of Y
Accounts window. Account v | Activites v| Reports v | Attach

2. Click the Account button at the bottom of the window.

QuickBooks displays the Account menu. One of the Account menu options is
New, which is the command that you use to add a new account.
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FIGURE 2-2:

The first Add New
Account: Choose
Account Type
window.

3.

% Chonse one account type and click Continue.

Categorize money your bUSiNess eams of spends
~ Income

* Expense

Or, frack the value of your assets and liabilities see a description here.
* Fixed Asset (major purchases)

* Bank

) Loan

) Credit Card

* Equity

7 Other Account Types <select- -

Help me choose the right account type. Cancel

Add an account by choosing Account => New.

QuickBooks displays the Add New Account: Choose Account Type window, as
shown in Figure 2-2.

rcelain LLC - Intuit Qui ountant 24.0 - [Add N

Edit View Lists Favorites Company Customers Vendors Banking Reports Window Help

@ € @ H

y Company Cash Flow Hub Income Tracker Bil Tracker Calendar = Snapshots Customers Vendors Employees = Bank Feeds

Click an account type on the left to

4,

Use the account-type buttons to identify the type of account that you're
adding.

QuickBooks supplies the following account types: Income, Expense, Fixed
Asset, Bank, Loan, Credit Card, and Equity, as well as (if you select Other
Account Types and open the Other Accounts Types drop-down list) Accounts
Receivable, Other Current Asset, Other Asset, Accounts Payable, Other Current
Liability, Long Term Liability, Cost of Goods Sold, Other Income, and Other
Expense. If you have a question about which account type your new account
fits into, you should review Book 1, Chapter 1, which describes how financial
statements work. These account groups essentially tell QuickBooks the area of
a financial statement account in which data gets reported. Note, too, that the
first Add New Account window shows examples of the selected account type in
the box above the Continue and Cancel command buttons.

Click Continue.

QuickBooks displays the second Add New Account window, as shown in Figure 2-3.
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ccountant 240 - [Add Ne

= File Edit View Lists Favorites Accountant Company Customers Vendors Employees Banking Reports Window Help

o

Home My Company Cash Flow Hub Income Tracker Bil Tracker Calendar = Snapshots Customers Vendors Employees —Bank Feeds

7| AccountType  |Bank -

Account Name Select from Examples
Subaccount of
OPTIONAL
Description
BankAcct No.
Routing Mumber
TagLine Mapping BiS-Assets: Cash ¥ | Howdo | choose the right tax line?
Enter Opening Balance... Should | enter an opening balance?

Remind me to order checks when | reach check number
\'&' Order checks | can print from QuickBooks Learn more

Save & Close Save & New Caneel

FIGURE 2-3:

The second Add
New Account
window.

6. Use the Account Name box to give your new account a unique name.
The name that you give the account will appear on your financial statements.

7. Ifthe account you're adding is a subaccount of a parent account, identify
the parent account by selecting the Subaccount Of checkbox.

After you select the Subaccount Of checkbox, name the parent account by
using the Subaccount Of drop-down list.

8. (Optional) If you're setting up a bank account that uses a currency other
than your home-country currency, choose the bank account currency
from the Currency drop-down list.

In Book 2, Chapter 3, | talk a bit more about working with multiple currencies.
But let me say this here: If you told QuickBooks that you work in multiple
currencies (you would have done this during the QuickBooks EasyStep
Interview setup process, discussed in Book 2, Chapter 1), QuickBooks wants
you to identify those bank accounts, customers, and vendors that use a
currency different from your home currency.

Note: The Currency drop-down list doesn't appear in Figure 2-3 because within
the example QuickBooks file | used for this book, the multiple-currency
tracking feature isn't turned on. To turn on the multiple-currency feature,
choose the Edit => Preferences command, select the Multiple Currencies
preferences settings, click the Company Preferences tab, and then select the
Yes | Use More Than One Currency radio button.
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WARNING

9. (Optional) Provide a description for the new account.

10

1"

12

You don't need to provide a description. Without a description, QuickBooks can still
use the account name in financial statements. If you want a more-descriptive label
placed in accounting reports, however, use the Description box for this purpose.

Provide other account information.

The Add New Account window shown in Figure 2-3 includes a Bank Acct. No.
box that lets you record the bank account number for a particular bank
account. Other account types may have similar boxes for storing related
account information. The credit card account type version of the Add New
Account window lets you store the card number, for example. If you do have
another box or two in which to store account information, use that space, if
necessary, to collect the bits and pieces of data that you want to save.

Identify the tax line on which the account information is to be reported by
choosing a tax form and tax line from the Tax-Line Mapping drop-down list.

You may not need to assign a particular account to a tax line if that account
data isn't reported on the business's tax return. Cash account balances aren't
reported on a sole proprietor’s tax return, for example, so a bank account for a
sole proprietor doesn't have any required tax line data. Cash account balances
are recorded on a corporation’s tax return, however. So, if you're adding a
bank account for a corporation, you use the Tax-Line Mapping drop-down list
to identify the tax line on which the bank account information gets reported.

(Optional but dangerous) Consider recording an opening balance for the
account.

Typically, you shouldn’t supply an opening account balance for an account, but
the second Add New Account window does let you do so. In the window shown
in Figure 2-3, you can click the Enter Opening Balance command button. When
you click this button, QuickBooks displays a dialog box that you can use to set a
starting account balance. All this sounds rather innocuous, but seriously, this is
something you rarely do. (You should set starting balances for accounts by
using a journal entry, as discussed at the end of Book 2, Chapter 1.) If you know
something | don't, though, you can use this capability to set the starting
balance for the account as of some date. One last caution, however. My
accounting professors taught me two things that suggest that this approach to
setting account balances is crazy:

Debits are supposed to equal credits. If you're setting the opening balance for
an account as part of setting up the new account, you're recording only
half of the accounting transaction.

Entering the opening balance as part of setting up a new account means that no
audit trail exists for the transaction. Rather than having an invoice associated
with a transaction or a check, or even a general journal entry, you're setting
balances on the fly. But hey, maybe you do know something | don't.
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TIP

TIP

Setting

13. after you describe the new account that you want to set up, click either Save &
Close or Save & New to save the new account to the Chart of Accounts list.

1 4 (Optional) Click the Next button to save the account information and
then redisplay the Add New Account window so that you can add
another account.

If you look closely at Figure 2-3, you’ll note some boxes, buttons, and even some
hyperlinks that I haven’t talked about. QuickBooks does supply other fields for
collecting account information. And occasionally, QuickBooks also provides click-
able hyperlinks and buttons that you can use to perform special tasks associated
with the particular type of account. In the case of a bank account, for example,
QuickBooks supplies an Order Checks hyperlink that you can use to learn more
about this process.

And that’s almost everything you need to know about adding accounts. The one
other thing I should mention is the fact that the Account menu — the menu of
commands that QuickBooks displays when you click the Account button in the
Chart of Accounts window (refer to Figure 2-1) — provides several other useful
commands for working with accounts. These commands include Delete, which
you use to delete the selected account (as long as you haven’t already used the
account). The menu also provides an Edit button that you can use to make any
changes in the selected account information (by using a window that looks very
much like the New Account window shown in Figure 2-3). The Account menu also
provides other commands that you can use to work with the Chart of Accounts
list. Fortunately, most commands have self-descriptive names: Print List, Make
Inactive, and so on.

The Activities button, which appears at the bottom of the Chart of Accounts win-
dow (refer to Figure 2-1), displays a menu of commands that you can use to write
checks, make deposits, enter credit card charges, transfer funds, make journal
entries, reconcile a bank account, use a register, and produce a working trial bal-
ance report. The Reports button displays a menu of commands that you can use to
print reports containing account information. The Attach button lets you upload
files — a PDF receipt for an equipment purchase, for example — from your com-
puter to save into QuickBooks.

Up the Item List

If you choose the Lists = Item List command, QuickBooks displays the Item List
window, as shown in Figure 2-4. This window lists all the items that you’ve set up
as part of running QuickBooks Setup and items that you’ve added manually since
running the Setup Wizard.
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FIGURE 2-4:
The Item List
window.

REMEMBER

in LLC - Intuit Quic

= File Edit View Lists Favorites Company Customers Vendars E

A a et B @ €

Home My Company CashFlow Hub Income Tracker Bil Tracker Calendar —Snapshots Customers Vendors Empioyees —Bank Feeds.
Loak for in Al fields - Search within results
o Consulting Senvice Sales Reven 0.00
+ Consulting Service Senvice Consulting R. 75.00
< Blue blug Blue Coffee Mug Invent... Sales Reven -35 0 12.00
+ Gut Buster Chili Dog Invent... Sales Reven 80 0 6.00
> Rainbow Mug Rainbow Coffee Mug Invent... Sales Reven. 304, 0 12.00
> Red Box Invent... Consulting R... 500 0 7.50
+ Red Mug Red Coffee Mug Invent... | Gales Reven. 455 0 16.00
+ Red Paper Invent... Sales Reven 1,000 0 1.00
< Stainless Mug Invent... | Sales Reven 440 0 20.00
< Valentines Box Invent... Sales Reven 225 0 5.00
< Yellow Mug Yellow Coffee Mug Invent... Sales Reven 285 0 10.00
© Gift Box Invent... Consulting R. 400 0 0.00
o Valentine's Day Box Invent... Sales Reven. 0 0 55.00
> Consignment Item Consigned Non-inventory Part item Deseription Non-i.. Consulting R... 0.00
<+ Non-inventory ltem Nen-inventary part item description Nor-... | Consulting R... 0.00
< Fin Chg Finance Charges on Overdue Balance Other . Finance Cha 10.0%
+ Reimb Subt Reimbursable Expenses Sublotal Subtot
+ Reimb Group Total Reimbursable Expenses Group
+ Discount Disco... | Sales Disca. -10.0%
< Local Tax Local Sales Tax Sales . Sales TaxPa 0.0%
+ Out of State Out-of-state sale, exempt from sales tax Sales . Sales TaxPa 0.0%
o State Tax State Sales Tax Sales ... Sales TaxPa 0.0%
o WA Sales Tax Sales ... Sales TaxPa 10.0%

ltem = Aclivies v  Reports ¥ | Excel v Attach | Go toCategory List

I don’t talk about how you add items to the Item List window here, because Book 3,
Chapter 3 details that process.

Note, however, that the Item list is very important! It lets you keep track of what
you buy, hold, and sell to your customers.

Working with the Price Level List

The Price Level list lets you create price adjustments that you can use on the fly as
you invoice customers, issue credit memos, and so forth. Because the Price Level
list relates directly to how you work with and bill for inventory items, I describe
how you work with that list in Book 3, Chapter 3. Rather than repeat information
that’s of interest to only a few people and isn’t essential for getting started with
QuickBooks, I refer you instead to Book 3, Chapter 3.
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Using Sales Tax Codes

The Sales Tax Code list keeps a list of codes, or abbreviations, that you can use to
describe items as taxable or nontaxable. If you choose this command, QuickBooks
displays a window listing the existing sales tax codes. (Usually, you see two exist-
ing codes: Tax and Non.)

The Sales Tax Code list doesn’t appear unless you tell QuickBooks to track sales
tax during setup or afterward. To add sales tax codes, take the following steps:
1. choose Edit > Preferences.

2. Click the Sales Tax item in the preferences list.

3. Click the Company Preferences tab.

4. Answer the Do You Charge Sales Tax question by clicking the Yes box.

To add a new sales tax code, click the Add Sales Tax item and enter the new sales
tax details when QuickBooks displays the New Item dialog box (not shown). Do

this by naming the sales tax item, describing it briefly, and then providing the
sales tax rate and tax agency.

Setting Up a Payroll Item List

100

The Payroll Item list identifies items that appear on employee payroll check stubs.
If you’re using an outside payroll service bureau to handle your payroll — and
this isn’t a bad idea — you don’t even need to worry about the Payroll Item list. If
you’re using the QuickBooks Enhanced Payroll Service, again, don’t worry about
the Payroll Item list. (In either case, the QuickBooks folks set up the payroll items
that you use for recording payroll.) And in the case of Intuit’s full-blown “we-do-
everything” Payroll Service, you don’t even need to track payroll inside QuickBooks,
because the QuickBooks people do it at their office location on their computers.

If you do need to add payroll items, follow these steps:

1. choose the Lists = Payroll Item List command.
QuickBooks displays the Payroll Item List window (not shown).

2. Toaddanew payroll item, click the Payroll Item button and then choose
Payroll Item => New.

QuickBooks displays the Add New Payroll Item dialog box (not shown). You can
choose to set up a new payroll item by using either the EZ Set Up method or
the Custom Set Up method:
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EZ Set Up. If you want QuickBooks to help you, and you're setting up a
common payroll item, click the EZ Set Up button, click Next, and simply
follow the onscreen instructions.

Custom Set Up. If you want to perform a custom setup of a payroll item,
click the Custom Set Up button and then click Next. QuickBooks walks you
through a multiple-screen interview — like the EasyStep Interview dis-
cussed in Book 2, Chapter 1 — that asks you about the payroll item to set
up. The first dialog box that QuickBooks displays, for example, asks you to
identify the type of payroll item that you want to create. You answer this
question by selecting one of the radio buttons and then clicking Next.

3. Namethe payroll item.

After you identify the type of payroll item, you name it. QuickBooks provides
another version of the Add New Payroll Item dialog box that includes a field
you fill in to give the new item a name.

4. Tofinish the payroll item setup, click the Next button to move through
the remaining payroll item setup questions.

You identify the name of the government agency to which the liability is paid,
the taxpayer identification number that uniquely identifies you to the taxing
agency, the liability account that you use to track the items, the tax-form line
that you use to report the item, the rules that QuickBooks should use for
calculating the item (such as whether the item is subject to taxes), and a couple
of other miscellaneous pieces of data. After you supply all this information and
click the Finish button (which appears in the last Add New Payroll Item
window), QuickBooks adds the new payroll item to the Payroll Item list.

The Payroll tem menu supplies commands that are useful for working with the
Payroll Item list. In addition to the commands that you use to add an item to
the list, the menu supplies commands for deleting payroll items, renaming
TIP payroll items, making payroll items active, and printing the list of payroll items.

Setting Up Classes

QuickBooks lets you use classes to segregate or track financial data in ways that
aren’t possible when you use other bits of accounting information, such as the
account number, the customer, the sales rep, the item, and so forth. A firm can
use classes, for example, to segregate financial information by stores, business
units, or geographical territories.
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To set up classes, follow these steps:

1.

= File

Home

[+ Store 1
|+ Store 2
> Store 3

FIGURE 2-5:
The Class List

Choose the Lists = Class List command.
QuickBooks displays the Class List window, as shown in Figure 2-5.

If you don't see the Class List command, choose Edit &> Preferences, click the
Accounting icon, click the Company Preferences tab, and select the Use Class
Tracking for Transaction checkbox.

Pine Lake elain LLC - Intuit Quic E ons: Accountant 24.0 - [Class List]

Edit View Lists Favorites Accountani Company Customers Vendors Employees Banking Reports Window Help < BiSCOVERY Q|- 5 x

e o | R
My Company Cash Flow Hub Income Tracker Bill Tracker Calendar ~ Snapshots Customers Vendors Employees Bank Feeds Docs

+ Chili Dogs

+ Hot Dogs

window.

Class + | Reports v

2.

To create a new class, choose Class => New at the bottom of the window.
QuickBooks displays the New Class dialog box, as shown in Figure 2-6.

To name the new class, enter a name or abbreviation in the Class
Name box.

Note that you enter the class name whenever you record a transaction that falls
into the class. For this reason, you don't want to create lengthy or easy-to-mistype
class names. Keep things short, simple, and easy.

If the class that you're setting up is actually a subclass of a parent class,
select the Subclass Of checkbox and then choose the parent class from
the Subclass Of drop-down list.
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FIGURE 2-6:
The New Class
dialog box.

Subclass of Cancel

Next

Classis
inactive

5.

Q

TIP

Click OK to save the class.

Alternatively, click Cancel to not save the class or click the Next button to save
the class and redisplay the New Class dialog box.

If you don’t want the class to be used anymore, you can select the Class Is
Inactive checkbox.

The Class menu, which appears when you click the Class button, also supplies
commands for editing the information of the selected class, for deleting the
selected class, for making the selected class inactive, and for printing a list of
classes, as well as several other useful commands. All these commands are
pretty straightforward. Experiment with them to find out how they work.

Setting Up a Customer List

A Customer list keeps track of all your customers and customer information, such
as billing and shipping addresses.
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Follow these steps to add a customer to the Customer list:

1 . Choose the Customers > Customer Center command.

QuickBooks displays the Customer Information window, as shown in Figure 2-7.

Yorcelain LLC - Intuit Qui

A 2 B ®w B a € a
Home My Company Cash Flow Hub Income Tracker Bil Tracker Calendar  Snapshols Customers Vendors Employees BankFeeds
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‘Customers & Jobs C t I f t @ &
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¢ Castle 0.00 Port Gardner, WA 987¢ Show Estimates
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< Rainy Day Collect 11,250.00 Estimate 2 071612024 Estimates 297000 &
+ Sound Retail 4,125.00 General Journal 4 0710112024 Accounts Receivable 1,653.82
+ Super Grab N Go 0.00 Invoice 29 07/01/2024 Accounts Receivable 330.00
+ The Sausage Sh 0.00 Invoice 30 07/01/2024 Accounts Receivable 2,970.00
Payment 051212024 Undeposited Funds 4977.62
Invoice 15 0212212024 Accounts Receivable 873.13
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2. Toaddanew customer, click the New Customer & Job drop-down list on
the toolbar and then choose the New Customer command.

QuickBooks displays the New Customer window, as shown in Figure 2-8.
3. Use the Customer Name box to give the customer a short name.

You don't need to enter the customer’s full name in the Customer Name box.
That information can go in the Company Name box, shown on the Address Info
tab. You just want some abbreviated version of the customer name that you can
use to refer to the customer within the QuickBooks accounting system.

4, (Optional) If you bill your customer in a currency different from your usual
home currency, choose that currency from the Currency drop-down list.

If you told QuickBooks that you work in multiple currencies — you would have
done this during the EasyStep Interview setup process — QuickBooks wants you
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FIGURE 2-8:
The New
Customer
window.

TIP

to identify when you invoice a customer and collect payments from a customer
in a currency different from your home currency. (Note: The Currency drop-
down list doesn't appear in Figure 2-8 because the multiple-currency tracking
feature isn't turned on. If you want more information, see Book 2, Chapter 3.)
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Copy >>

oK Cancel Help

5.

(Usual rule) Ignore the Opening Balance and As Of boxes.

You typically don't want to set the customer’s opening balance by using the
Opening Balance and As Of boxes. That's not the right way to set your new
customer accounts receivable balance. If you do this, you're essentially setting
up the debit part of an entry without the corresponding credit part. Later, you'll
have to enter crazy, wacky journal entries to fix your incomplete bookkeeping.
But an exception to the usual rule exists, as discussed in the tip that follows.

Although the usual rule is that you don't want to set an opening balance for a
customer, this rule has an important exception. As discussed at the end of
Book 2, Chapter 1, you record your accounts receivable balance on the
conversion date by setting an opening balance for each customer as of the
conversion date. The sum of these opening balances is what QuickBooks uses
to determine your total accounts receivable on the conversion date.
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6. Use the boxes of the Address Info tab to supply the company name and
contact information, including contact name, phone numbers, fax
numbers, email addresses, billing and shipping addresses, and so on.

I'm not going to tell you that you should enter somebody’s first and last name in
the Full Name boxes or that the phone numbers of your customer go in the
boxes labeled Main Phone and Work Phone. | figure that you don't need that
kind of help.

7. Cclick the Payment Settings tab to display the set of boxes shown in
Figure 2-9.

You can record the customer’s account number, credit limit, payment terms,
preferred payment and delivery methods, and even credit card information.
Note that the Online Payments checkboxes let you indicate that a customer
can pay you by using a credit card or bank transfer — but you need to have set
up these services already. If you haven't set up the services, QuickBooks
prompts you to set them up when you check one of these boxes.

@ | discuss the Price Level list and how it works in Book 3, Chapter 3.

Pine Lake Porcelain LLC - Intuit QuickBooks Enterprise Solutions: Accountant 24.0 -
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[ oK Cancel Help.

FIGURE 2-9:
The Payment
Settings tab.

Customer is inactive
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8. (Optional) If you're tracking sales taxes, click the Sales Tax Settings tab to
display the boxes you'll use to identify this customer’s sales tax rate.

The Sales Tax Settings tab (not shown) includes a Tax Code drop-down list that
you use to indicate which sales tax code applies to this particular customer. You
can also identify the actual sales tax item and, if relevant, the resale number.

0. Supply a bit of additional information about the customer.

If you click the Additional Info tab, shown in Figure 2-10, QuickBooks displays
several other boxes that you can use to collect and store customer informa-
tion. You can use the Customer Type drop-down list, for example, to categorize
a customer as fitting into a particular customer type. (I talk about setting up a
Customer Type list later in this chapter.) And you can use the Rep drop-down
list to identify the customer’s default sales rep. Finally, you can click the Define
Fields button to specify additional fields that you want to collect and report for
the customer.

PN

Home My Company CashFlow Hub Income Tracker Bil Tracker Calendar Snapshots Customers Vendors Employees = Bank Feeds

oF 01/01/2024 @ How do | determine the opening balance?

Address Info CUSTOM FIELDS

csroenmes [ =)

ReP -

Payment Settings
Sales Tax Settings
Additional Info

Job Info

Define Fields

oK Cancel Help

FIGURE 2-10:
The Additional
Info tab.

Customer is inactive

10. (Optional) Click the Job Info tab to describe the customer job.

The Job Info tab (not shown) lets you describe information associated with a
particular job being performed for a customer. You use the Job Info tab if you
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Setting

FIGURE 2-11:
The Vendor
Information

window.

not only set up a customer, but also set up a job for that customer. See Book 4,
Chapter 5 for more information on how job costing works.

11. When you finish describing the customer, click the Save & Close or Save &

New button to save your description.

Up the Vendor List

Just as you use a Customer list to keep records of all your customers, you use a
Vendor list to keep records of your vendors. Like a Customer list, a Vendor list
lets you collect and record information, such as the vendor’s address, the contact

person, and so on.

To add a vendor to your Vendor list, follow these steps:

1 . Choose the Vendors > Vendor Center command.

When you do, QuickBooks displays the Vendor Information window, as shown
in Figure 2-11.
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FIGURE 2-12:
The New Vendor
window.

Address Info
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To add a new vendor, click the New Vendor drop-down list on the toolbar
and then choose New Vendor.

QuickBooks displays the New Vendor window, as shown in Figure 2-12.

acker Bil Tracker Calendar = Snapshols Customers

ASOF |01/01/2024 B How do | determine the opening balance?

N —

Mrims. First M. | |Last

3.

Give the vendor a name in the Vendor Name box.

As is the case with the Customer list, you use this name to refer to the vendor
within QuickBooks. For this reason, an abbreviation is fine. You just want
something easy to enter and easy to remember.

(Optional) If you pay your vendor in a currency different from your usual
home currency, choose that currency from the Currency drop-down list.

If you told QuickBooks that you work in multiple currencies — you would have
done this during the EasyStep Interview setup process — QuickBooks wants
you to identify when you receive bills from or pay a vendor in a currency
different from your home currency. (Note: Figure 2-12 doesn't show the
Currency drop-down list because the multiple-currency tracking feature isn't
turned on.)
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5. (Usual rule) Ignore the Opening Balance and As Of fields.

Don't do anything with the Opening Balance and As Of boxes. People who
don't know better use those boxes to enter the opening balance owed a
vendor and the date the amount is owed, but these entries only create
problems later. At some point in the future, this poor soul's accountant will
need to find and correct this error. As when you add new customers, however,
an exception to the usual rule exists, as discussed in the tip that follows.

Although the usual rule is that you don't want to set an opening balance for a

vendor, this rule has an important exception. As discussed at the end of Book
2, Chapter 1, you record your accounts payable balance on the conversion date

TIP by setting an opening balance for each vendor as of the conversion date. The

sum of these opening balances is what QuickBooks uses to determine your
total accounts payable on the conversion date.

6. Supply the vendor address information.

The Address Info tab supplies a bunch of easy-to-understand boxes that you
use to collect vendor name and address information. You enter, predictably,
the vendor’s full name in the Company Name box.

You can click the Edit buttons on the Address Info tab to display another dialog
box called the Edit Address Information dialog box, which lets you enter the
address in typical street address, city, state, and ZIP-code format. The Edit
buttons appear to the right of the Billed From and Shipped From address
blocks.

7. Supply any additional information necessary.

The Payment Settings tab (see Figure 2-13) collects the most relevant vendor
information, including account number, credit limit, and payment terms, but if
you click the Tax Settings tab, the Account Settings tab, or the Additional Info
tab, QuickBooks displays a handful of other boxes that you can use to collect
and store information:

The Tax Settings tab lets you collect the vendor's tax identification number
so that you can (as sometimes required by federal tax laws) send the
vendor a Form 1099 at the end of the year.

The Account Settings tab lets you specify which accounts QuickBooks should
use to prefill account fields when entering a transaction for the vendor.

The Additional Info tab lets you categorize the vendor according to type and
also lets you create other custom fields.

If you're paying a vendor for the first time, a good guideline is to get their tax ID
number. If a vendor won't give you their tax ID number — thereby making it
impossible for you to report payments that you make to them — it's probably a
TIP sign that something is a bit amiss.
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FIGURE 2-13:
The Payment
Settings tab.
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The New Vendor window closes, and you go back to the Vendor Center.

If you click the Account Settings tab (the fourth tab available in the New Vendor
window), QuickBooks displays boxes you can use to list the accounts that you want
QuickBooks to fill in for you automatically when you record a check to some vendor
or when you record a bill from some vendor. If the check to the phone company
pays telephone expenses, for example, you could tell QuickBooks to prefill that
expense category the next time you enter a bill or record a check to pay that vendor.
It won’t enter an amount, as (obviously) the amount can change, but you won’t
have to search all your accounts to find telephone expenses if you use this option.

Up a Fixed Assets List

If you choose the Lists = Fixed Asset Item List command, QuickBooks displays the
Fixed Asset Item List window. You can use this window to see a list of the fixed
assets — furniture, equipment, machinery, vehicles, and so forth — that you’ve
purchased. That is, you can see this list after you click the Item drop-down list,
choose New, and fill in the New Item window for each fixed asset. Figure 2-14
shows the New Item window you use to describe each fixed asset.
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FIGURE 2-14:
You describe

each fixed asset
by using the New

Item window.
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Let me make a couple of comments about the QuickBooks Fixed Asset Item list.
The Fixed Asset Item list doesn’t really integrate with the QuickBooks general
ledger. You record the purchase or disposal of fixed assets by using regular old
QuickBooks transactions. You might record the purchase of a particular fixed asset
simply by entering a check in the usual fashion. And you might record the disposal
of a fixed asset by entering a general ledger journal entry.

The Fixed Assets Item list, then, just acts as a standalone list that lets you track
the fixed assets you purchased. Because the list is so standalone-ish, I’'m not
going to spend much time talking about it in this book. Let me also say that your
CPA probably — no, surely — maintains a list of your fixed assets because they
need that list to correctly include depreciation on your tax return and in your
financial statements (if you get a CPA to help prepare them). For this reason, some
people — including me — see the Fixed Asset Item list as being a little bit
redundant.

Setting Up a Price Level List

112

A price level changes the sales price up or down when you do things like invoice.
You might create a price level that amounts to a preferred customer discount on
specified items. When you create an invoice for those items, rather than use the
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standard price for the item (which appears in the Create Invoice window’s Price
column), you could select the price level preferred customer discount (in the Price
column) to use the discounted preferred customer.

To create a price level, choose the Lists = Price Level command. When QuickBooks
displays the Price Level List window (not shown), click the Price Level drop-down
list and then choose New. When QuickBooks displays the New Price Level dialog
box, give the price level a name in the Price Level Name text box, use the Price
Level Type box and list to specify to which items the price level applies, and then
use the Adjust Price and Rounding boxes to set the new price level’s prices. When
you click OK, QuickBooks redisplays the Price Level List window — this time with
your new price level. You can edit and delete existing price levels by using other
commands that become available when you click the Price Level button.

Setting Up a Billing Rate Level List

A billing rate sets the amount that you charge for service items. Whereas a law
firm might sell only hours of legal advice, for example, the item “legal advice”
would be billed at different rates for different attorneys. An attorney just out of
law school might have their time billed at one rate, whereas a senior partner in the
firm might bill at another, probably much higher rate.

To set up a billing rate, you choose the Lists = Billing Rate Levels List command.
When QuickBooks displays the Billing Rate Level window (not shown), click the
Billing Rate Level drop-down list and then choose New to display the New Billing
Rate Level dialog box. You use the New Billing Rate Level dialog box to define a
billing rate, giving the billing rate level a name, and then set a fixed hourly rate for
the billing-rate level or different hourly rates for different service items.

After you create billing-rate levels with the Billing Rate Levels List command,
by the way, you need to connect those levels with specific employees so that
the correct rate gets used when an employee’s time is billed. To do this, dis-
play the Employee Center window by choosing the Employees <> Employee Cen-
ter command. Then right-click the employee, choose Edit Employee from the
shortcut menu, click the Additional Info tab when QuickBooks displays the Edit
Employee dialog box, and select the appropriate billing rate in the Billing Rate
Level list box.
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Setting Up Your Employees

If you choose the Employees &> Employee Center command, QuickBooks displays
the Employee Center window (not shown). You can use this window to see a list
of the employees — active or inactive — whom you’ve identified to QuickBooks.
You can also use this window’s New Employee button to add employees to the list.

Because I discuss how to add employees to the Employee list in Book 3, Chapter 5,
I won’t repeat that information here.

Setting Up an Other Names List

If you choose the Lists &> Other Names List command, QuickBooks displays the
Other Names List window (not shown). The Other Names list identifies those
businesses or people that you pay but that don’t fall into one of these other stan-
dard categories: customers, vendors, and employees. You might use the Other
Names list to identify government agencies that you pay, for example.

To add a name to the Other Names list, click the Other Names button, which
appears at the bottom of the Other Names window. When QuickBooks displays
the Other Names menu, choose New. The New Name window that QuickBooks
displays after you choose the New command provides boxes for entering a name,
identifying the entity, recording an address, and so on. I don’t show this window
here because it’s a simplified version of the window that you use to identify and
describe a customer, vendor, or employee.

Setting Up the Profile Lists

114

If you choose the Lists & Customer & Vendor Profile List command, QuickBooks
displays a submenu of commands that you use to create some of the mini-lists
that QuickBooks uses to ease your bookkeeping and accounting. The Profile lists
include lists of sales reps, customer types, vendor types, job types, payment
terms, customer messages, payment methods, shipping methods, and vehicles.
Most of the Profile lists are pretty darn simple to use. If you choose the Sales Rep
List command, for example, QuickBooks displays the Sales Rep List window. Then
you click the Sales Rep drop-down list and choose New. QuickBooks displays the
New Sales Rep dialog box, as shown in Figure 2-15. I bet you can figure out how
to use this dialog box.
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FIGURE 2-15:
The New Sales
Rep dialog box.
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In case you’re still experiencing a certain amount of accounting anxiety, let me
just point out that you enter the name of the sales representative in the Sales Rep
Name box. Then, throwing caution to the wind, you enter the sales rep’s initials
in the Sales Rep Initials box. When you click OK, QuickBooks adds the sales rep to
your Sales Rep list.

The other Profile lists work in the same simple, scaled-down fashion. You choose
the Profile list from the submenu, click the Profile List button, and choose New.
When QuickBooks displays a window, you use one or two boxes to describe the
new Profile list.

Just to prove to you that this process really is as easy as I say, take a look at the
New Customer Message dialog box (accessible from the Customer Message list),
shown in Figure 2-16. This dialog box is the one you use to create a new customer
message for placement at the bottom of customer invoices and credit memos.

If you want to track vehicle mileage within QuickBooks — and note that you usu-
ally must track business vehicle mileage to claim business vehicle expenses as a
tax deduction — you can maintain a list of business vehicles by using the Vehicle
list. This list makes it easy to track your business vehicles — something you do by
choosing the Company = Enter Vehicle Mileage command.
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FIGURE 2-16:
The New
Customer
Message
dialog box.
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QuickBooks may provide access to other lists via the Lists menu. You can access
templates you create for invoicing and other forms by choosing the Lists =
Templates command. (I discuss form templates in Book 3, Chapter 1.) And depend-
ing on how you’ve installed the software, QuickBooks may add lists I haven’t
mentioned here. Depending on your installation and the state where you operate,
QuickBooks may display a list of Workers Compensation items, for example.
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IN THIS CHAPTER

» Setting preferences for various
options, reminders, and settings

» Changing the accounting, checking,
and finance charge rules

» Controlling jobs and estimates, as
well as time tracking

» Accounting for multiple currencies,
sales, customers, and sales tax

» Setting up payroll and employees

» Setting purchases and vendors’
preferences along with 1099
reporting rules

Chapter 3
Fine-Tuning QuickBooks

ou can fine-tune how QuickBooks works for you by setting preferences.

In fact, just so you know, much of what you do when you run QuickBooks

Setup via the Detailed Start route (also known as the QuickBooks EasyStep
Interview) is provide information that QuickBooks uses to fine-tune how it works
for you. If you indicate that you charge customers sales tax, for example, the
EasyStep Interview describes how sales tax should work for your business by
using the sales tax preferences.

Because these preferences have so much effect on how QuickBooks works and on
how a particular user works with QuickBooks, I devote this chapter to describing
how you change the preferences. None of this material is particularly complicated,
but because QuickBooks provides a rich set of preferences options, I cover quite a
bit of material. Don’t worry: You don’t have to read this chapter from beginning
to end. Simply use it as a reference when you have a question about how to change
the way QuickBooks works in a particular area.
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Accessing the Preferences Settings

18

You can set preferences within QuickBooks in two ways:

3 During the Detailed Start/EasyStep Interview. You actually set all the
preferences, or at least all the starting preferences for QuickBooks, when
you run the EasyStep Interview. Most of the time, the preferences that the
Detailed Start/EasyStep Interview sets are correct. QuickBooks is very smart
about the way it asks questions and translates your answers into preferences
settings. But if your business changes, if you make a mistake during the
setup interview, or if someone in your office ran the Detailed Start/EasyStep
Interview for you, you may still need to check and fiddle-faddle with these
preferences.

3 By changing the preferences manually. You can change the preferences
manually by choosing the Edit => Preferences command. QuickBooks displays
the Preferences dialog box, as shown in Figure 3-1. QuickBooks groups
categories of preferences. All the accounting preferences, for example, are
grouped into an accounting preference set, and all the checking account
preferences are grouped into a checking preference set. If you look closely at
Figure 3-1, you see that along the left edge of the Preferences dialog box,
QuickBooks displays a list of icons. The first icon is Accounting. The second
icon is Benefits & HR. To see the preferences within one of these groups, you
click that preference’s icon.

One other item to note about the Preferences dialog box is that it supplies, in
general, two tabs of preferences for each preference set. Preferences that
are specific to an individual user appear on the My Preferences tab, shown in
Figure 3-1. Preferences that are tied to the company data file appear on the
Company Preferences tab, shown in Figure 3-2.

Not every My Preferences tab gives you options for changing the way that
QuickBooks works. Sometimes, a particular set of preferences gives personal
options; sometimes, it doesn’t.

The My Preferences tab of the Bills set of preferences, for example, provides no
personalized options. In other words, you can’t tell QuickBooks that in your firm,
billing works differently for different users. This makes sense, right? Billing
needs to work the same way for every user within a firm. With other preferences
settings, QuickBooks may allow different options for different users. You see this
as I discuss the various sets of preferences in the remainder of this chapter.

Now I’m going to walk you through a discussion of each of these preferences
sets. I talk about both the My Preferences option (if available) and the Company
Preferences option.
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FIGURE 3-1:

The My
Preferences tab
of the Accounting
Preferences
dialog box.

FIGURE 3-2:
The Company
Preferences tab
of the General
Preferences
dialog box.
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Setting the Accounting Preferences

The My Preferences tab of the Accounting Preferences dialog box (refer to
Figure 3-1) provides a single option: You can tell QuickBooks that you want it to
autofill information when recording a general journal entry.

Don’t get irritated with the lack of personalization, however. This almost total
lack of individually personalized preferences makes sense, if you think about it.
Accounting for a business needs to work the same way for Jane as it does for Joe
and for Susan.

You do have the option to set several company preferences for accounting,
however. Again, this makes sense if you think about it. Different companies run
their accounting systems in different ways.

Figure 3-3 shows the Company Preferences tab of the Accounting Preferences
dialog box.
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Using account numbers

By default, QuickBooks lets you use names to identify accounts in the Chart of
Accounts list or in the accounts list. The account that you use to track wages
expense may be known as “wages,” for example, but you can select the Use
Account Numbers checkbox to tell QuickBooks that you want to use account
numbers rather than account names for identifying accounts. Larger businesses
and businesses with very lengthy lists of accounts often use account num-
bers. When you use numbers, you can more easily control both the ordering of
accounts on a financial statement and the insertion of new accounts into the
Chart of Accounts list.

The Show Lowest Subaccount Only checkbox (refer to Figure 3-3) lets you tell
QuickBooks that it should display the lowest subaccount rather than the higher
parent account in financial statements. QuickBooks allows you to create sub-
accounts, which are accounts within accounts (discussed further in Book 2,
Chapter 2). You can also create sub-subaccounts, which are accounts within
subaccounts. You use subaccounts to more finely track assets, liabilities, equity
amounts, revenue, and expenses.

Setting general accounting options

The Company Preferences tab (not shown) provides the following six gen-
eral accounting checkboxes, as well as date warnings and closing date settings.
(The checkboxes are probably self-explanatory to anybody who has done a bit
of accounting with QuickBooks, but for new QuickBooks users, I provide a brief
description of what each one does.)

3 Use Account Numbers: The Use Account Numbers checkbox, if selected,
enables you to enter an account number for a transaction. The associated
checkbox, Show Lowest Subaccount Only, tells QuickBooks to display only the
name and account number of a subaccount (if you're using one) instead of the
full heritage of the account. If you use a lot of levels of subaccounts, this
option can really clean up views, making it easier to tell what account you're
looking at.

3 Require Accounts: The Require Accounts checkbox, if selected, tells
QuickBooks that you must specify an account for a transaction. This makes
sense. If you aren't using accounts to track the amounts that flow into and out
of the business, you aren't really doing accounting. It would never make sense,
in my humble opinion, to deselect the Require Accounts checkbox.
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Use Class Tracking for Transactions: The Use Class Tracking for Transactions
checkbox lets you tell QuickBooks that you want to use not only accounts to
track your financial information, but also classes. Classes let you split account-
level information in another way. This sounds complicated, but it's really quite
simple. The account list, for example, lets you track revenue and expenses by
categories of revenue and expense. You may track expenses by using catego-
ries such as wages, rent, and supplies. Classes, therefore, provide you a way to
track this information in another dimension. You can split wages expense into
those wages spent for two locations of your business, for example. A restaura-
teur with two restaurants may want to do this. Note that QuickBooks also
provides boxes you can check to indicate that QuickBooks should prompt you
to assign classes and to assign classes to accounts, items, or names.

Automatically Assign General Journal Entry Number: This checkbox tells
QuickBooks to assign numbers to the general journal entries that you enter
by using the Make General Journal Entries command. You want to leave this
checkbox selected. General journal entries, by the way, are typically entered
by your CPA or your professional on-staff accountant.

Warn When Posting a Transaction to Retained Earnings: This checkbox
tells QuickBooks to display a warning message whenever you attempt (or
someone else attempts) to directly debit or credit its retained earnings
account. (Normally, you don't want to directly debit or credit the retained
earnings account, and only skilled accountants would enter transactions
directly into retained earnings in any case.)

Hide Opening Balance Fields in Names and Items: Check this box to tell
QuickBooks to hide opening balance information for customers, vendors, and
other names and for items.

Date Warnings: The Date Warnings boxes tell QuickBooks to warn you when
you enter (or someone else enters) a transaction with a date too far in the
past or too far into the future. If you check either of the Date Warnings boxes,
you also want to specify how many days are too far into the past or too far
into the future.

Closing Date setting: The Closing Date checkbox lets you identify a date
before which your QuickBooks data file can't be changed. In other words, if
you set the closing date to December 31, 2024, you're telling QuickBooks that
you don't want any changes made to the QuickBooks data file before this date.
This means that someone can't modify a transaction that's dated before your
closing date without getting a scary warning message. It also means that
someone can't enter a transaction by using a date before this closing date.
You can click the Set Date/Password button to display a dialog box that lets
you specify a closing date and create the password required when someone
wants to add or modify an old transaction.
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box. All recent versions of QuickBooks provide an always-on audit trail, however,

TIP so you don’t see an Audit Trail checkbox accounting preference anymore. An audit
trail, by the way, simply keeps a list of who makes which changes to transactions.
Accountants, predictably, love audit trails. Audit trails enable someone, such as
your CPA or an Internal Revenue Service auditor, to come in after the fact and
figure out why an account balance is what it is.

Long ago, past versions of QuickBooks let you turn an Audit Trail feature on and
off by using the Company Preferences tab of the Accounting Preferences dialog

Setting the Bills Preferences

If you display the Preferences dialog box and click the Bills icon, you can set
company-level preferences for handling vendor bills. You can specify, for exam-
ple, that bills are considered to be due a certain number of days after their receipt
by entering a value in the appropriate text box. You can also use these company-
level preferences to specify that early-payment discounts should be used and to
choose an account for recording the value of these discounts. (I don’t show you
a figure of the Company Preferences tab of the Bills Preferences dialog box. It’s
really not worth your time.)

Setting the Calendar Preferences

If you display the Preferences dialog box and click the Calendar icon, you can set
your personal preferences for showing calendar information within QuickBooks,
including a preference to remember previous calendar settings, the view used to
show weeks, which transactions you want to appear on the calendar, and how you
want calendar reminders to show. (As with the Bills Preferences, I don’t show you
a figure of the My Preferences tab of the Calendar Preferences dialog box because
the boxes are straightforward.)

Setting the Checking Preferences

If you display the Preferences dialog box and click the Checking icon, QuickBooks
displays either the My Preferences tab, shown in Figure 3-4, or the Company
Preferences tab, shown in Figure 3-5.
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The My Preferences tab of the Checking Preferences dialog box lets you tell
QuickBooks which account it should suggest as a default account when you open
particular types of windows within QuickBooks. If you look closely at Figure 3-4,
you see the Open the Write Checks checkbox, which is the first checkbox on the
tab. To the right of the Open the Write Checks checkbox, you see the Form with
X Account drop-down list. If you select the Open the Write Checks checkbox, you
can choose an account from the Form with X Account drop-down list. This setting
tells QuickBooks to use or suggest the specified account every time you open the
Write Checks window.

The My Preferences tab also includes checkboxes that you can use to specify the
default account for the Pay Bills window, the Pay Sales Tax window, and the
Make Deposits window. If you have multiple checking accounts set up, setting
the default accounts by using the My Preferences tab is a good idea. Setting these
preferences makes it less likely that you’ll erroneously write checks on or pay bills
from the wrong account.

The Company Preferences tab, shown in Figure 3-5, provides options that you can
use to describe how checks work within QuickBooks:

3 Print Account Names on Voucher. This checkbox lets you indicate to
QuickBooks that it should print account names on the voucher portion of
the check.

¥ Change Check Date When Non-Cleared Check Is Printed. Select this
checkbox to tell QuickBooks to use the current system date as the
printed check date.

3 Start with Payee Field on Check. Select this checkbox to tell QuickBooks to
place the insertion point, or text cursor, in the Payee field when you open the
Write Checks window.

3 Warn about Duplicate Check Numbers. Selecting this checkbox tells
QuickBooks to alert you to duplicate check numbers. (You want to leave this
checkbox selected, obviously, so that you don't use duplicate or erroneous
check numbers.)

3 Autofill Payee Account Number in Check Memao. Select this checkbox to
tell QuickBooks to fill in the payee account number automatically when you
write a check. QuickBooks retrieves the account number for a payee from the
Vendor list or from the Other Names list.
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3 Select Default Accounts to Use. These checkboxes let you specify which
account QuickBooks suggests when you open the Create Paychecks window
or open the Pay Payroll Liabilities window. Essentially, then, these checkboxes
let you tell QuickBooks which checking account you use to write payroll checks
and to pay payroll liabilities, such as federal income tax withholding amounts.

3 Bank Feeds. If you've turned on online banking for QuickBooks, QuickBooks
provides option buttons you can use to change the way that online transac-
tion information appears in the online banking window. Book 3, Chapter 4
discusses the QuickBooks online banking tool set.

Changing the Desktop View

126

Figure 3-6 shows the My Preferences tab of the Desktop View Preferences dialog
box. The My Preferences tab provides View radio buttons — One Window and
Multiple Windows — that let you indicate whether QuickBooks should use one
window or multiple windows for displaying all its information. The Multiple
Windows option looks like older versions of Microsoft Windows. When this
option is selected, an application such as QuickBooks displays multiple float-
ing document windows within the application program window. If you have a
question about how this feature works, your best bet is simply to try both view
settings.

The Desktop radio buttons let you specify whether and when QuickBooks should
save the current appearance, or view, of the desktop. You can select the Save When
Closing Company radio button to tell QuickBooks that it should save the view of
the desktop when you close a company. When you reopen a company, QuickBooks
reuses this desktop view. You can also select the Save Current Desktop radio but-
ton to tell QuickBooks to save the current view and then reuse this view when
QuickBooks later opens. If you don’t want to make changes to the default desktop
view, select the Don’t Save the Desktop radio button.

The Desktop checkboxes let you specify whether QuickBooks should display the
QuickBooks home page and use colored icons and a light background for the top
icon bar. If you select a checkbox, QuickBooks adds the home page or tweaks the
icon-bar coloring.
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FIGURE 3-6:
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The Windows Settings buttons let you access the Windows Display Properties and
Windows Sounds Properties settings. Typically, you’d make changes to Windows
Display Properties and Windows Sounds Properties by using the Control Panel
tools, but you can make changes from within QuickBooks by clicking these two
buttons. (In actuality, when you click these buttons, QuickBooks starts the Control
Panel tools.)

If you have questions about how Windows Display Properties or Sounds Proper-
ties work, refer to the Windows Help file or to a good book such as Windows 11 For
Dummies, by Andy Rathbone (John Wiley & Sons, Inc.).

The Company Preferences available for the Desktop View Preferences let you
specify what icons appear on the QuickBooks home page, as shown in Figure 3-7.
The Customers set of checkboxes, for example, lets you specify which customer-
related accounting tasks are available via icons on the home page. The Vendors
checkbox lets you specify whether you want to enter and pay bills using the Enter
Bills and Pay Bills command. Near the bottom of the Company Preferences tab of
the Desktop View Preferences dialog box, QuickBooks supplies hyperlinks you can
click to turn on and off the display of other accounting task icons.
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Setting Finance Charge Calculation Rules

The Finance Charge Preferences settings let you specify how QuickBooks should
calculate finance charges on overdue invoices to customers. None of the My Pref-
erences options is available for finance charges — only Company Preferences
options. Because I describe how the Company Preferences tab of the Finance
Charge Preferences dialog box works in Book 3, Chapter 1, I won’t repeat that
information here.

Setting General Preferences

Figure 3-8 shows the My Preferences tab of the General Preferences dialog box.
This tab provides checkboxes that you can select to tell QuickBooks to do the
following:

¥ To move the selection cursor from one field on the window to the next field
when you press Enter

¥ To open drop-down lists automatically when you're typing
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3 To beep when you record a transaction

¥ To place a decimal point two digits from the right end of the number
automatically

3 To warn you when you're editing an existing transaction

¥ To bring back all the one-time Help messages that you may have suppressed
¥ To turn off pop-up messages for products and services

¥ To show tooltips for clipped text

3 To warn you when you're deleting an existing transaction or some unused
items on a list

¥ To run QuickBooks in the background even when you're not using QuickBooks
(to make QuickBooks start faster)

¥ To recall account or transaction information automatically — telling
QuickBooks, for example, to automatically recall the last transaction for a
particular customer, vendor, or employee

¥ To use either today's date or the last entered date as the default date
¥ To keep custom item information changed as part of entering a transaction
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TIP

FIGURE 3-9:
The Company
Preferences tab
of the General
Preferences
dialog box.

If you have specific questions about the My Preferences checkboxes that are avail-
able for the General Preferences options, click the Help button that appears along
the right edge of the Preferences dialog box. QuickBooks provides brief but useful
descriptions of how the Preferences options work and what they do.

Figure 3-9 shows the Company Preferences tab of the General Preferences dialog
box. The Time Format radio buttons let you specify whether QuickBooks should
show the minutes in an hour as a decimal value or as minutes. The Time Format
radio button descriptions include examples of how these two approaches vary,
so look closely at the dialog box if you have questions. The Company Preferences
tab includes a checkbox that lets you specify that QuickBooks should always show
years using four digits. The tab also includes a checkbox that you can select to tell
QuickBooks not to update the name information for a particular customer, vendor,
employee, or other name when you’re saving a new transaction for that customer,
vendor, employee, or other name. The Manage Login Settings section allows users
to open the company file or switch to another company file without having to
re-enter login credentials for a specified period of time. Enabling this feature is
probably not a good idea if multiple users are accessing the same company file on
the same computer.
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Controlling Integrated Applications

FIGURE 3-10:
The Company
Preferences tab
of the Integrated
Applications
Preferences
dialog box.

The Integrated Applications Preferences aren’t personal, so no options are avail-
able on the My Preferences tab. The Company Preferences tab of the Integrated
Applications Preferences dialog box, however, does control and track other appli-
cations or computer programs that open the QuickBooks company data files.
Figure 3-10 shows the Company Preferences tab of the Integrated Applications
Preferences dialog box.
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The checkbox titled Don’t Allow Any Applications to Access This Company File,
if selected, tells QuickBooks that it shouldn’t allow other applications to access
this company data file. The checkbox titled Notify the User Before Running Any
Application Whose Certificate Has Expired, if selected, tells QuickBooks that it
shouldn’t allow any program whose security certificate is out of date to open the
QuickBooks company data file without first notifying the user (that’s you).

The list box shows the names of the applications that previously requested access

to the QuickBooks company data file. You can remove an application from this list
by selecting the application and then clicking the Remove button. You can change
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the rules or properties that the QuickBooks program applies to access this other
application by selecting the application and then clicking the Properties button.

Controlling Inventory

No personal preferences are available for inventory tracking and control, but
QuickBooks provides several Company Preferences features regarding inventory
and items, as shown in Figure 3-11. You can turn the QuickBooks inventory and
purchase order features on and off. You can specify that you want to be warned if
you enter a purchase order number you’ve previously used. And you can specify
how QuickBooks determines whether you have or don’t have enough inventory
to sell. (In the Enterprise Solutions version of QuickBooks, you can also indicate
whether negative inventory balances are allowed.)
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If you buy or sell an item using more than one unit of measure — say, you sell
fabric both by the yard and by the bolt (the rolled-up fabric) — QuickBooks lets
you quantify your inventory items by using more than a single unit of measure.
If you’re interested in doing this, select Multiple U/M Per Item from the Unit of
Measure drop-down list.
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If your business operation processes multiple inventory receipts for a single
vendor bill, multiple vendor bills for a single item receipt, or prepayments for
inventory, you may want to consider enabling the QuickBooks Enhanced Inven-
tory Receiving (EIR) feature if you’re using QuickBooks Enterprise Solutions. By
turning on this feature, you probably can improve your inventory item counts and
avoid the sorts of item count and QuickBooks errors that often occur in these more
complicated inventory situations. You can’t turn off Enhanced Inventory Receiving
after you turn it on, however. Accordingly, research the details of the QuickBooks
EIR feature (by clicking the Learn More hyperlink) or consult your accountant
before you click the Enable button in the Enhanced Inventory Receiving section.

Controlling How Jobs and Estimates Work

TIP

Because no personal preferences are available for Jobs & Estimates preferences,
the My Preferences tab of this Preferences dialog box shows no options. You have
several company preferences available regarding jobs and estimates, however, as
shown in Figure 3-12. The Pending text box lets you describe what term or word
should be used for jobs that have been submitted but haven’t been accepted or
rejected. The Awarded text box lets you provide a term or description that you
want to use within QuickBooks to identify those jobs that customers or clients
have accepted. The default description of an awarded job is, cleverly, Awarded. The
In Progress, Closed, and Not Awarded text boxes similarly let you describe what
term you want to use for jobs that fit into these categories.

The Do You Create Estimates? radio buttons let you indicate to QuickBooks whether
you want to create job estimates for customers. You select the radio button — Yes
or No — that answers the question. The Do You Do Progress Invoicing? radio
buttons let you indicate whether you do progress billing for jobs. The Warn about
Duplicate Estimate Numbers checkbox, if selected, tells QuickBooks to warn you
about using duplicate estimate numbers. The Don’t Print Items That Have Zero
Amount checkbox, if selected, tells QuickBooks not to print estimates that have
zero balances.

Book 4, Chapter 5 talks more about setting up jobs and estimates. You may want

to refer to it if you have questions about how project costing and job costing work
within QuickBooks.
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FIGURE 3-12:
The Company
Preferences

tab of the

Jobs & Estimates
Preferences
dialog box.
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Dealing with Multiple Currencies

134

QuickBooks supports multiple currencies. To turn on the multiple-currencies
feature, choose the Edit = Preferences command, select the Multiple Currencies
option in the list box, and click the Company Preferences tab. Then select the Yes
I Use More Than One Currency button, and choose your home currency from the
drop-down list.

After you tell QuickBooks that you’ll be working with multiple currencies, you
need to set up a bank account for each extra currency in which you want to work
(currencies in addition to your home currency). After that, you can indicate which
currency a vendor or customer uses when you set up a new vendor or customer.
You can also select a transaction currency for vendors or customers with which
you haven’t yet transacted any business. You can’t change the currency for a
vendor or customer with which you’ve already transacted business in your home
currency, however.

After you’ve performed this setup work, you can work with foreign-currency
units (euros rather than dollars, or vice versa) as you pay the foreign currency to
vendors, collect the foreign currency from customers, and move money in and out
of your foreign-currency bank account.

BOOK 2 Getting Ready to Use QuickBooks



Furthermore, using the currency exchange information available in the Currency
list (available when you choose Lists = Currency List), QuickBooks converts
foreign-currency amounts to home-currency amounts so you can prepare reports
that use your home currency. QuickBooks, of course, updates its records con-
cerning foreign exchange rates if you display the Currency List window, click the
Activities button, and choose Download Latest Exchange Rates.

within QuickBooks, QuickBooks sprinkles little currency reminders throughout its

windows and dialog boxes. Amount boxes, for example, show a little abbreviation
TIP for the currency that goes into a particular box, thereby reminding you that in this

particular text box, you’re supposed to enter (for example) British pounds.

; One final multiple-currency factoid: If you turn on the Multiple Currency feature

Starting Integrated Payment Processing

The Payments preferences provide several checkboxes and links you can use to
control the way QuickBooks handles payments.

The Receive Payments checkboxes, for example, let you indicate that you want
to automatically apply and automatically calculate payments, as well as use the
Undeposited Funds account as a temporary holding account for customer pay-
ments. (For more information about the Undeposited Funds account and customer
payments, see Book 3, Chapter 1.)

The Payments preferences also let you indicate that you’ll allow customers to
pay you using credit cards and bank transfers via the Automated Clearing House
(ACH) system. If you set this preference, QuickBooks adds a link on invoices that
customers can use to make credit card payments or bank transfers.

Not surprisingly, Intuit charges a modest fee for this service, so if you’re
interested, pay close attention to current pricing — information that’s available
when you check the boxes that turn on this feature. (At the time I’'m writing this
chapter, the fee runs 2 to 3 percent for credit card payments and 50 cents for an
ACH payment, and may require a modest monthly fee.)

Controlling How Payroll Works

The Payroll & Employees Preferences set includes only the Company Preferences
tab, shown in Figure 3-13. The QuickBooks Payroll Features radio buttons let
you tell QuickBooks how you want to handle payroll: Enhanced Payroll, Payroll,
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FIGURE 3-13:

The Company

136

Preferences
tab of the
Payroll &
Employees
Preferences
dialog box.

or Payroll Premium. Note that QuickBooks displays only radio buttons that make
sense given the version of QuickBooks you’ve selected.
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The Pay Stub & Voucher Printing button lets you tell QuickBooks what employee
information to print on the payroll check: employee address, company address,
sick-pay information, vacation-pay information, and pay-period information.
You can figure out how this works by clicking the button and looking at the dialog
box that QuickBooks displays.

The Sick and Vacation button lets you fine-tune how QuickBooks monitors
employee sick- and vacation-pay accrual and use. Again, click either of these but-
tons to see a screen that provides more information about how the button works.

In roughly the middle of the Company Preferences tab of the Payroll & Employees
Preferences dialog box, QuickBooks supplies several other checkboxes and radio
buttons.

3 Copy Earnings Details from Previous Paycheck: Another duh.

3 Recall Quantity Field on Paychecks: QuickBooks recalls or reuses paycheck
quantity information from the last pay period's paychecks. (The QuickBooks
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Help file suggests that you use this option when you have a “fixed quantity
that occurs from paycheck to paycheck.” The Help file uses the example of
tiered sales commissions where the commission amount is set for each tier.)

3 Recall Hour Field on Paychecks: QuickBooks recalls or reuses hours-worked
information from the last pay period’s paychecks. You use this option when
you have a fixed number of hours that occurs from paycheck to paycheck.

3 Job Costing, Class, and Item Tracking for Paycheck Expenses: QuickBooks
lets you track payroll expenses not just by account, but also by job, class,
or item.

3 Assign One Class Per: The Entire Paycheck and Earnings Iltem options enable
you to break wage expenses into classes more finely. You can indicate, for
example, that you want to use a different class for each item that appears on
an employee’s paycheck. (Note: These options appear only if classes are
enabled.)

The Display Employee List By radio buttons let you choose how employee lists are
sorted on reports: by first name or by last name.

If you click the Employee Defaults button, QuickBooks displays a dialog box that
you can use to set employee payroll default information, such as deductions for
taxes or health insurance.

Finally, at the bottom of the dialog box, QuickBooks provides two other options for
handling payroll. The Mark New Employees As Sales Reps checkbox, if selected,
does what you’d expect: It marks new employees that you add to the Employee list
as sales reps. And the checkbox titled Display Employee Social Security Numbers
in Headers on Reports, if selected, also does what you’d expect: It adds employee
Social Security numbers to reports.

Telling QuickBooks How Reminders
Should Work

The My Preferences tab of the Reminders Preferences dialog box consists of just
one checkbox, which you can use to tell QuickBooks that you want to see the
Reminders list when you open a company file. Because the My Preferences tab
includes only a single checkbox, I don’t show it here as a figure.
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FIGURE 3-14:

The Company

138

Preferences
tab of the
Reminders
Preferences
dialog box.

The Company Preferences tab, shown in Figure 3-14, provides a bunch of radio
buttons that you can use to specify how QuickBooks should remind you of account-
ing and bookkeeping tasks that you need to complete: Checks to Print, Paychecks
to Print, Invoices/Credit Memos to Print, Overdue Invoices, Almost Due Invoices,
Sales Receipts to Print, Sales Orders to Print, Inventory to Reorder, Assembly Items
to Build, Bills to Pay, Memorized Transactions Due, Money to Deposit, Purchase
Orders to Print, To Do Notes, and Open Authorizations to Capture.
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For each of these accounting or bookkeeping tasks, you indicate whether you
want to see a reminder for the item in the Show Summary list that appears in the
QuickBooks Company Preferences Reminders list. You can also choose to actually
see the list of tasks — such as the list of checks to print — or you can indicate
that you don’t want to be reminded of some particular category of accounting or
bookkeeping. For some of the reminder notes, you indicate how many workdays
in advance you want to be reminded. If you indicate that you want to be reminded
to print checks, for example, you must indicate how many days before the check
date that you want the reminder to appear. You do this by entering a numeral in
one of the Remind Me text boxes.
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Specifying Reports and Graphs
Preferences

FIGURE 3-15:
The My
Preferences tab
of the Reports &
Graphs
Preferences
dialog box.

The My Preferences tab of the Reports & Graphs Preferences dialog box is shown
in Figure 3-15. This tab provides radio buttons that you can use to indicate how
QuickBooks should refresh reports when the information upon which the report
is based changes. The default refresh option is Refresh Automatically. You can
also select the Prompt Me to Refresh radio button to have QuickBooks (politely)
suggest that you refresh a report only whenever the data changes. (You may
not want to refresh automatically if you have a large data set and many reports.
Refreshing a report can be rather time-consuming.) You can also select the
Don’t Refresh radio button if you don’t want or don’t need to be reminded about
refreshing a report.
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The checkbox titled Prompt Me to Modify Report Options Before Opening a Report,
if selected, tells QuickBooks to open the Modify Report window whenever you cre-
ate a report. You can use the Modify Report window to control what information
is included in a report (such as what date range the report is based on) and other
reporting options as well. If this checkbox isn’t selected, QuickBooks creates a
report by using the default reporting options.
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TIP

FIGURE 3-16:
The Company
Preferences
tab of the
Reports &
Graphs
Preferences
dialog box.

140

The Graphs Only checkboxes let you control the way QuickBooks graphs report
information. You can select the Draw Graphs in 2D checkbox to tell QuickBooks to
draw 2D rather than 3D graphs. (QuickBooks draws 2D graphs much more quickly,
so you may want to use that kind.) Note that 2D graphs are visually more precise
than 3D graphs. You can also select the Use Patterns checkbox to tell QuickBooks
to draw a graph that uses crosshatching patterns rather than colors for the dif-
ferent pieces of a chart.

For a complete discussion of the Modify Reports window, take a look at the dis-
cussion in Book 4, Chapter 2.

Figure 3-16 shows the Company Preferences tab of the Reports & Graphs Pref-
erences dialog box. This tab provides several useful options for default report
generation rules. The Summary Reports Basis radio buttons, for example, let you
indicate whether the default accounting method used to create a report should be
accrual-basis accounting or cash-basis accounting. The Aging Reports radio but-
tons let you specify how the age of an invoice or bill should be calculated: from
the due date or from the transaction date. The Reports - Show Accounts By radio
buttons let you specify how account information appears in reports: account name
only, description only, or both name and description.
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WARNING

FIGURE 3-17:

The Header/
Footer tab of the
Reports & Graphs
Preferences
dialog box.

Two other options are especially noteworthy. The Classify Cash button displays a
dialog box that lets you indicate whether changes in a particular account balance
should appear in the operating, investing, or financing portion of the statement
of cash flows.

If you're not a professional accountant, you want to get your CPA’s help with
making changes in this area of QuickBooks. The rules for presenting a statement
of cash flows are quite involved.

If you clear the Default Formatting for Reports checkbox and click the Format
button, QuickBooks displays the Reports & Graphs Preferences dialog box, which
lets you customize the report header and footer information. Figure 3-17 shows
the Header/Footer tab of the Reports & Graphs Preferences dialog box. The Show
Header Information checkboxes let you specify what information should appear
in the report header area. The Show Footer Information checkboxes let you make
the same specifications for the report footer. The Alignment drop-down list in
the Page Layout section lets you specify how information should be aligned on the
report page.
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FIGURE 3-18:
The Fonts &
Numbers tab of
the Reports &
Graphs
Preferences
dialog box.

Q

TIP

Figure 3-18 shows the Fonts & Numbers tab of the Reports & Graphs Preferences
dialog box. On this tab, you specify what font and formatting you want to use for
bits of report information. If you want to change the font for the report’s column
labels, for example, click the Column Labels entry in the Change Font For list box;
then click the Change Font button. QuickBooks displays a Font Formatting dialog
box (not shown) that lets you specify the font, font style, point size, and other
special effects.
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If you’re confused about changing report formatting, check out Book 4, Chapter 2,
which talks about all this stuff.

Setting Sales and Customers Preferences

I won’t show you the My Preferences tab. The personalized preferences for deal-
ing with sales and customers are pretty basic. The tab lets you specify whether
QuickBooks should prompt you to invoice a customer for time or costs you’ve
previously said are billable to that customer.
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FIGURE 3-19:
The Company
Preferences tab
of the Sales &
Customers
Preferences
dialog box.

The company preferences deserve more explanation. Figure 3-19 shows the
Company Preferences tab of the Sales & Customers Preferences dialog box. The
Sales Forms options relate to the invoice information you supply to customers.
The Usual Shipping Method drop-down list lets you specify the default shipping
method. The Usual FOB text box lets you set the default free on board (FOB) point.
You can select a checkbox to tell QuickBooks whether it should warn you when you
use duplicate invoice numbers.
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The Choose Template for Invoice Packing Slip drop-down list in the Miscellaneous
section lets you specify how packing slips should look.

The Collections Center radio button allows you to enable a list of all overdue and
almost-due invoices in a single screen.

The Custom Pricing radio buttons — No Custom Pricing and Enable Price Levels —
let you turn on the price-levels features in QuickBooks. I won’t say more about
these features here. Price levels are discussed in detail in Book 3, Chapter 3.

The Sales Orders checkboxes let you control how the QuickBooks sales orders

work, including whether you even want to use sales orders, how numbering
should work, and how they should look when they print. The Sales Orders options
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also include drop-down list boxes you can use to specify how sales orders should
look and a checkbox you can select to tell QuickBooks not to sell more stuff to
customers with overdue balances.

Specifying How Sales Are Taxed

Although no personal preferences are available for sales tax, company preferences
do exist. Figure 3-20 shows the Company Preferences tab of the Sales Tax Prefer-
ences dialog box. The Do You Charge Sales Tax? radio buttons, which appear at the
top of the tab, control whether you can charge sales tax within QuickBooks. You
select the radio button — Yes or No — that answers the question.
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The Taxable Item Code and Non-Taxable Item Code drop-down lists let you define
what code QuickBooks should use to identify taxable and nontaxable sales. By
default, QuickBooks uses the clever “tax” code for taxable sales and the equally
clever “non” code for nontaxable sales. You can choose the Add New entry from
either drop-down list, however, and use the dialog box that QuickBooks displays
to create your own taxable and nontaxable codes.
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TIP

TIP

The Add Sales Tax item under the Set Up Sales Tax Item section allows you to set
up an item for the sales tax you charge on invoices. You can indicate the default
(or most common) sales tax item that you want to include by entering this sales
tax item name in the Your Most Common Sales Tax Item drop-down list. To add
the sales tax item, choose Add New from this list and complete the dialog box that
QuickBooks displays. The New Item dialog box lets you name the sales tax item
and identify the sales tax rate.

You can also add a new sales tax item by clicking the Add Sales Tax Item button.

The Taxable Item Code and Non-Taxable Item Code drop-down lists let you select
the code words to designate invoice items as subject to sales tax. The checkbox
titled Identify Taxable Amounts as “T” for “Taxable” When Printing, if selected,
tells QuickBooks to flag taxable amounts on an invoice with the code T.

The When Do You Owe Sales Tax? radio buttons let you indicate when the taxing
authority says you owe sales tax: as of the invoice date (which means that the
taxing authority requires accrual-basis accounting) or upon receipt of payment
(which means that the taxing authority allows cash-basis accounting).

The When Do You Pay Sales Tax? radio buttons (Monthly, Quarterly, and Annu-
ally) let you tell QuickBooks how frequently you must remit sales tax amounts.

You select the radio button that corresponds to your sales tax payment frequency.

Book 2, Chapter 2 describes how to set up sales tax items.

Setting the Search Preferences

The My Preferences tab of the Search Preferences dialog box provides a checkbox
you can use to indicate that you want the Search box to appear on the QuickBooks
icon toolbar. (This seems pretty self-explanatory, but if you’re confused, check
the box, click OK, and then look at the way that QuickBooks has modified your
icon toolbar.)

The Company Preferences tab of the Search Preferences dialog box (not shown)
lets you specify how frequently QuickBooks updates the index of company data
file and menu items that are used when you search for data within the Quick-
Books program. By default, QuickBooks does its update every hour, but you can
request more frequent or less frequent updates. An update of the index takes a few
minutes, and during the update, QuickBooks runs more slowly. The Search Com-
pany Preferences tab also includes a button you can click to demand an immediate
update of the index.
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Setting the Send Forms Preferences

The My Preferences tab of the Send Forms Preferences dialog box lets you check
a box to specify whether the To Be E-Mailed checkbox is selected for customer
invoices, and click an option button to specify when emailed forms should be
processed with web mail (such as Gmail or QuickBooks email). It also provides
buttons you can click to build a list of email accounts to use for web mail.

The Company Preferences tab of the Send Forms Preferences dialog box is shown
in Figure 3-21. This tab lets you specify the default message text, message
subject, and salutation for emailed invoices, estimates, and statements. To use
the Company Preferences tab, you use the Show drop-down list to specify which
type of message text you want to change. Next, click the message you want to
change, and then click the Edit button. When QuickBooks displays the Edit Email
Template dialog box (not shown), change the default message however you want.
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FIGURE 3-21:
The Company
Preferences
tab of the
Send Forms
Preferences
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Service Connection Add Template Edit

@ Book 3, Chapter 1 talks about invoicing customers and emailing customer invoices.

TIP
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Fine-Tuning the Service Connection

FIGURE 3-22:
The My
Preferences tab
of the Service
Connection
Preferences
dialog box.

The My Preferences tab of the Service Connection Preferences dialog box provides
two checkboxes you can select to control how QuickBooks works when you’re
making web connections, as shown in Figure 3-22. One checkbox gives you the
option of saving downloaded files. The other tells QuickBooks not to close your
web browser when it finishes using the web.
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The Service Connection Preferences dialog box offers two Company Preferences
options (not shown). You can indicate, for example, whether QuickBooks should
automatically connect to QuickBooks Services without asking for a password
or whether it should always ask for a password. To make this decision, simply
select the appropriate radio button. You can also select the Allow Background
Downloading of Service Messages checkbox to tell QuickBooks that background
collection of messages is okay. (If you select this checkbox, QuickBooks down-
loads new messages during idle times so that it doesn’t slow your other Internet
activities.)
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Controlling Spell Checking

FIGURE 3-23:
The My

Preferences tab
of the Spelling

148

Preferences
dialog box.

No company preferences exist for the Spelling Preferences dialog box, but the My
Preferences tab (shown in Figure 3-23) provides several options for controlling
how spell checking works for you within QuickBooks. Select the checkbox titled
Always Check Spelling Before Printing, Saving, or Sending Supported Forms if you
want to have automatic spell checking performed before you distribute a docu-
ment to an outside party, such as a customer or vendor.
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You can use the Ignore Words With checkboxes to tell QuickBooks not to spell-
check words or phrases that aren’t going to appear correctly spelled because
they aren’t real words. Select the Internet Addresses checkbox, for example, to
tell QuickBooks that it shouldn’t check Internet URL addresses. And select the
All UPPERCASE Letters checkbox to tell QuickBooks that it shouldn’t attempt to
spell-check words that are acronyms and abbreviations, such as OK and ASAP.

QuickBooks also lets you remove custom-spelled words from your spell-
checking dictionary. (You add custom-spelled words during spell checking by
telling QuickBooks that a word flagged as possibly misspelled is in fact spelled
correctly. To do this, click the Add button when the Check Spelling dialog box
appears.)
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Controlling How 1099 Tax Reporting Works

FIGURE 3-24:
The Company
Preferences tab
of the Tax: 1099
Preferences
dialog box.

No personal preferences exist for 1099 tax reporting. Company preferences exist,
however, as indicated by the Company Preferences tab, shown in Figure 3-24.
This tab lets you tell QuickBooks when you’re required to file 1099-MISC forms.
(Answer the Do You File 1099 Forms? question in the affirmative by selecting the
Yes radio button.) The tab also lets you map QuickBooks accounts to the different
boxes on the 1099 form you use to report payments to independent contractors.
(To do this, click the You Can Do It Here hyperlink.) Confer with your tax adviser
if you have questions about these boxes or the 1099 reporting threshold amounts
or visit the IRS website at www. irs.gov.
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Setting Time and Expenses Preferences

Figure 3-25 shows the Company Preferences tab of the Time & Expenses Prefer-
ences dialog box. To turn on time tracking within QuickBooks, enable Do You
Track Time? by selecting the Yes radio button. You can also use the First Day
of Work Week drop-down list to indicate which day should appear first on the
Weekly Time Sheet window. (This setting is what you use to describe billable time
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FIGURE 3-25:

The Company

Preferences
tab of the

Time & Expenses

150

Preferences
dialog box.

Q

TIP

for the week.) Book 3, Chapter 1 talks about billing for time in more detail. You
may want to look there if you have questions about tracking time and billing for
that time.
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You may need to scroll down the list of Preferences to see the Time & Expenses
preference settings.

Use the Invoicing Options checkboxes to indicate how you want to track reim-
bursed expenses. To indicate that you sometimes want to base invoices on accu-
mulated time and expenses, select the Create Invoices from a List of Time and
Expenses checkbox. Furthermore, to indicate that you want to track reimbursed
expenses that you bill and then later collect from customers or clients as income,
select the Track Reimbursed Expenses As Income checkbox. The Default Markup
Percentage text box lets you specify a default retail markup percentage to use in
your pricing (although you should double-check that it’s showing up properly in
estimates before you count on it). The Default Markup Account drop-down list
lets you specify which account QuickBooks should use for tracking your markups.
If you select the Mark All Expenses as Billable checkbox, you can choose expenses
that should be reimbursed when entering bills and code them to a specific
customer job.
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IN THIS CHAPTER

» Deciding which invoice form to use

» Customizing your invoices

» Invoicing customers on paper or
by email

» Billing your customers for time

» Recording sales receipts, credit
memos, and payments

» Calculating finance charges

Chapter 1
Invoicing Customers

uickBooks provides several tools for invoicing your customers. This
chapter describes these tools, as well as a handful of related tools for
recording customer payments and for issuing credit memos.

If you’ve already been invoicing customers by using some manual method —
perhaps you’ve been preparing invoices with a word processor — you’ll find
QuickBooks to be a godsend. QuickBooks not only makes invoicing and related
tasks easier, but also collects invoice information, recording this information in
the QuickBooks data file. Happily, this means that you get the extra benefit of
recording accounting transactions simply by using QuickBooks for invoicing.

Choosing an Invoice Form

QuickBooks allows you to use an invoice form that matches the requirements of
your business. Businesses that sell products — such as retailers and wholesalers —
need an invoice that includes descriptions of the product items that are sold.
Businesses that sell services — such as law, architectural, engineering, and
consulting firms — need an invoice that appropriately describes these services.
Businesses that sell both products and services need a blend of attributes.
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Fortunately, QuickBooks lets you choose the invoice form that best matches
your business. To choose an invoice form, display the Create Invoices window by
choosing the Customers > Create Invoices command. When QuickBooks displays
the Create Invoices window, use the Template drop-down list, which appears in
the top-right portion of the window, to choose the invoice form that you want.
This drop-down list provides choices such as an attorney’s invoice, a finance-
charge invoice, a fixed-fee invoice, a product invoice, a service invoice, and a
professional invoice. Choose the invoice template that seems to best match your
business. QuickBooks redraws the Create Invoices window when you choose a new
invoice form template. This means that you can see what an invoice form template
looks like simply by choosing an option from the Template drop-down list.

Customizing an Invoice Form

154

Although you can choose a predefined invoice form template for your invoices,
QuickBooks gives you more flexibility than that. You can also create custom invoice
form templates to design an invoice that looks just the way you want. To do this,
you can start with one of the basic invoice form templates and then customize it
so that it perfectly matches your requirements.

Choosing a template to customize

To choose a template to customize, display the Create Invoices window by choos-
ing the Customers = Create Invoices command. Then, from the Template drop-
down list, choose the template that most closely matches what you want your
ultimate invoice to look like.

Reviewing the Additional
Customization options

The form customization tools in QuickBooks easily confuse new users. But typi-
cally, the way to start any customization is to fiddle with what QuickBooks calls
its Additional Customization options.

To perform this fiddling, click the Create Invoice window’s Formatting tab and
then click the Customize Data Layout button. You can’t use the Additional Custom-
ization dialog box if you’re working with one of the default invoice templates —
only if you’re working with a copy. Accordingly, QuickBooks may prompt you to
make a copy of an invoice template when you click the Additional Customization
button. In any event, QuickBooks displays the Additional Customization dialog
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FIGURE 1-1:

The Header tab
of the Additional
Customization
dialog box.

TIP

box, as shown in Figure 1-1. This dialog box gives you control of both the informa-
tion that appears on your invoices and the way that invoices print.
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Specifying header information

The Header tab of the Additional Customization dialog box (refer to Figure 1-1)
lets you specify what information goes in the top portion of the Create Invoices
window and the top area of an actual printed invoice form. This information,
called the header, provides the invoice number, the invoice date, and the bill-
ing and shipping information. You can also choose how information is labeled by
filling in or editing the contents of the text boxes. The Default Title checkboxes,
for example, let you specify whether the form title should appear in the screen
version of the invoice (inside the Create Invoices window) and in the printed ver-
sion of the invoice. The Default Title text box lets you specify what the form title
should be. In a similar fashion, the Date checkboxes let you specify whether the
date should appear in both the screen and print versions of the invoice, as well as
what label should be used to describe the invoice date. Figure 1-1 uses the clever
descriptive text Invoice as the invoice form’s title.

As you make these customizations, QuickBooks updates the Preview box, shown

on the right side of the Additional Customization dialog box, so you can see what
your changes look like.

CHAPTER 1 Invoicing Customers 155

siawo3sn) Suioau|



TIP

FIGURE 1-2:

The Columns tab
of the Additional
Customization
dialog box.

If you don’t need a particular piece of information in an invoice, don’t select the
Screen and Print checkboxes for that bit of data. Leaving these checkboxes dese-
lected tells QuickBooks that it shouldn’t include that piece of header information
in the window or print version of the invoice form.

Specifying columns information

The columns portion of an invoice describes in detail the items for which an
invoice bills. Product invoice columns describe the specific products, including
price and quantity; they also describe the items being invoiced. A service invoice’s
columns describe the specific services being billed. As you may guess from look-
ing closely at Figure 1-2, the Columns tab of the Additional Customization dialog
box looks like the Header tab. You use the Screen and Print checkboxes to indicate
whether a particular piece of column-level information should appear as a column
in the Create Invoices window or in the actual created invoice. Similarly, you use
the Title text boxes to provide the descriptive labels that QuickBooks uses in the
Create Invoices window and in the printed invoice form.
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The only unusual options shown on the Columns tab are the Order text boxes.
These boxes let you indicate the order (from left to right) in which the columns
should appear. If the item number or code should appear in the first column on the
left, for example, enter the value 1 in the Item row’s Order box.
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TIP

Specifying prog columns information

The “prog columns” portion of an invoice provides information relevant to situa-
tions in which you’re using progress billings. You can click the Prog Cols tab of the
Additional Customization dialog box to add and remove such information as the
ordered amount, the previously invoiced amount, and any back-ordered amounts.

The Header, Columns, and Prog Cols tabs let you make changes in your invoice
forms, but don’t get too nervous about making perfect changes the first time. You
can easily see exactly how your changes look by using the Preview box (if your
eyesight is better than mine) or by clicking OK and then carefully reviewing the
new version of the Create Invoices window. If you realize that you’ve made an
error — perhaps you’ve used the wrong bit of descriptive text, or you’ve incor-
rectly ordered the columns — you can customize your invoice again and thereby
fix your earlier mistakes.

Specifying footer information

The Footer tab of the Additional Customization dialog box lets you specify what
information appears in the Create Invoices window below the columns area and
in the actual printed invoice below the columns area. As Figure 1-3 indicates, the
footer information includes a customer message, the invoice total, payments and
credit information, a balance-due field, and (optionally) a longer text box. You
work with the Footer tab in the same manner that you work with other tabs. If you
want some bit of information to appear, select the Screen checkbox and the Print
checkbox. To change the bit of text that QuickBooks uses, edit the contents of the
Title text box.

Specifying print information

The Print tab of the Additional Customization dialog box, shown in Figure 1-4,
lets you exercise a bit of control over how QuickBooks prints invoices that use
the template you’ve customized. The radio buttons at the top of the tab let you
specify that when printing this particular invoice template, QuickBooks should
use the regular old invoice printer settings or other, special print settings. The
Print settings also let you tell QuickBooks how it should number the pages of a
multiple-page invoice.

You can return all the customized invoice settings to their default condition by

clicking the Default button. When you do, however, you remove any changes or
customizations that you’ve made.
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FIGURE 1-5:
The Basic
Customization
dialog box.

Moving on to basic customization

The Additional Customization dialog box (refer to Figure 1-4, for example) pro-
vides a Basic Customization button. If you click this button, QuickBooks displays
the Basic Customization dialog box, shown in Figure 1-5, which provides several
easy-to-make customization choices.
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To identify which invoice form template you want to customize, click the Manage
Templates button; then, when QuickBooks displays the Manage Templates dialog
box (see Figure 1-6), choose the invoice template you want to customize. Quick-
Books initially supplies a custom invoice template and a finance-charge template
that you can customize.

Alternatively, you can select one of these existing templates and click Copy to
create and then customize it. When you click OK, QuickBooks closes the Manage
Templates dialog box and returns you to the Basic Customization dialog box.

Logo, please

To add a logo to your invoices, select the Use Logo checkbox (shown in Figure 1-5).
Then, when QuickBooks displays the Select Image dialog box (not shown), use it
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FIGURE 1-6:
The Manage
Templates
dialog box.

to select the graphic-image file that shows your logo. The Select Image dialog box
works like a standard Windows open-file dialog box.
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Color you beautiful

To add color to your invoices — say you have a color printer, and you don’t care
whether you spend a small fortune on colored ink — choose the color scheme you
want to use from the Select Color Scheme drop-down list. Then click the Apply
Color Scheme button.

Fiddle with invoice fonts

You can choose the font that QuickBooks uses for the bits of text that go into an
invoice. Just select the bit of text you want in the Change Font For list box and
then click the Change Font button. QuickBooks displays the Example dialog box,
shown in Figure 1-7. Use its Font, Font Style, and Size boxes to specify what the
selected bit of text should look like. The Example dialog box includes a Sample box
that shows how your font changes look. When you complete your specification of
the font, click OK.
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FIGURE 1-7:
The Example
dialog box.

TIP
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Specifying company and transaction information

The Company & Transaction Information options, also shown in Figure 1-5, let
you indicate what information should appear on the form template. You select
the checkbox that corresponds to the bit of information. If you want the com-
pany name to appear in the invoice form, for example — which means that you
aren’t using letterhead or preprinted invoice forms — select the Company Name
checkbox.

If you need to change some bit of company information, click the Update
Information button. QuickBooks displays the Company Information dialog box
(not shown), which you can use to edit or update your company name, address,
telephone number, and so on.

Working with the Layout Designer tool

Okay. Perhaps you’ve used the Basic Customization dialog box to make some
changes in your invoice’s appearance, and you haven’t been satisfied. Maybe
you’ve gone the extra mile and noodled around with the Additional Customization
dialog box to make further changes, and maybe even that hasn’t left you happy
with the appearance of your invoice.
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FIGURE 1-8:
The Layout
Designer.

Do you have any additional recourse? Are you stuck with an invoice that doesn’t
look right or that doesn’t work for your organization? Heck, no!

If you click the Layout Designer button, which is available in both the Basic Cus-
tomization and Additional Customization dialog boxes, QuickBooks displays the
Layout Designer, as shown in Figure 1-8. The Layout Designer lets you move
invoice information around in the actual printed invoice. Your best bet for finding
out how to work with the Layout Designer is experimenting with it. My recom-
mendation is that you create an example invoice form template — something you
don’t really care about — and then use this new invoice form template for some
goofing around.
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Here are some of the things that you may want to try.

3 Moving and resizing objects: You can move and resize objects in the form
pretty easily. To move some bit of the form, select the bit by clicking it; then
use the arrow keys or drag the mouse to move the selected bit. You can resize
the selected bit in a similar way. Resize the selected object by dragging the
black squares (called resizing handles), which show that the object is selected.
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When moving and resizing invoice form objects, keep two points in mind:

You can select the Show Envelope Window checkbox to have QuickBooks
draw envelope windows in the invoice form to show you where these
elements appear. You want to have envelope windows shown to make sure
that your customized invoice still has its address information showing through.

You can click the Grid button to display the Grid and Snap Settings dialog
box (not shown). This dialog box provides two checkboxes where you

can indicate whether QuickBooks should use a grid (the dots you see in
Figure 1-8) to line up invoice objects more accurately in the form. The Grid
and Snap Settings dialog box also includes a Snap to Grid checkbox so that
you can tell QuickBooks that it should make gridlines sticky. Sticky gridlines
automatically attract invoice objects so that you can more easily line up the
objects against the gridlines. Further, the Grid and Snap Settings dialog box
includes a Grid Spacing checkbox that you can use to specify how wide or
narrow the gridlines should be.

Selecting objects: You can select multiple objects in the invoice by dragging
the mouse. To do so, click at a point above the top-leftmost object that you
want to select, and drag the mouse to a point just below the bottom-rightmost
object that you want to select. As you drag the mouse from one corner to the
other, QuickBooks draws a rectangle. Any object that's inside this rectangle
when you release the mouse gets selected.

Resizing multiple objects: You can change the height, width, and size of
multiple selected objects by clicking the Make Same Width, Make Same
Height, and Make Same Size buttons. To use these Make Same buttons, you
first select the objects that you want to make the same.

Positioning text within fields: If you click an invoice object and then click the
Properties button, QuickBooks displays the Properties dialog box, shown in
Figure 1-9. The Properties dialog box includes a Text tab that lets you specify
how text should appear within an invoice object area. The dialog box also
includes a Border tab that lets you specify whether QuickBooks should draw a
border along the edges of the invoice object. What's more, you have the option
to add a solid background color to any box by using the Background tab.

Changing fonts: You can change the font used for the selected object by
clicking the Properties button, clicking the Text tab of the Properties dialog
box, and then clicking the Font button that appears on this tab. QuickBooks
displays the Example dialog box (refer to Figure 1-7). The Example dialog box
lets you choose a font; font style; point size; and special effects, such as
strikeout, underlining, and color.

Adjusting margins: If you click the Margins button, QuickBooks displays the
Margins dialog box (not shown), which includes Top, Bottom, Left, and Right

text boxes that you use to specify the margin around the invoice. The default
or initial margin settings equal half an inch.

CHAPTER 1 Invoicing Customers 163

siawo3isn) SuidioAu|



FIGURE 1-9:

The Properties
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Center a selected object in an invoice form by clicking the Center button to activate
the Layout Designer. You can click the Zoom In and Zoom Out buttons to see more
or less detail. If you want to undo your most recent change, click Undo, or click the
Redo button to undo your last undo option.

After you use the Layout Designer to make whatever changes are appropriate in
your new invoice form template, click OK to save your changes.

Working with the web-based Forms
Customization tool

QuickBooks provides one other form design tool that you can tap to create invoice
forms (and other QuickBooks forms) that more closely match your requirements:
the web-based QuickBooks Forms Customization tool.

You access this tool from the Create Invoices window by clicking the Customize
Design button on the Formatting tab. When you do this, QuickBooks displays a
webpage that steps you through a full-fledged graphic design session for the
invoice form. To use this approach, simply follow the webpage’s instructions.
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Invoicing a Customer

FIGURE 1-10:
The Create
Invoices window.

TIP

To invoice a customer, use the Create Invoices window to identify the customer
and specify the amount that the customer owes. To display the Create Invoices
window, choose the Customers = Create Invoices command. When you do,
QuickBooks displays a Create Invoices window like the one shown in Figure 1-10.
Note, however, that the Create Invoices window you see may not look exactly like
the one shown in Figure 1-10.
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As previously described, you can use more than one type of invoice form. You can
also choose to customize an invoice form so that it perfectly matches your busi-
ness requirements. In the following steps, I describe generally how to invoice a
customer. The specific steps that you take may be ever-so-slightly different if
you’re working with a different invoice form template.

If you want to declutter your Create Invoices window, you can close the Open
Windows list along the left edge (not shown) of the QuickBooks window to provide
more room. You can close your Open Windows list by clicking its close box (the
small box marked with an X that appears in the top-right corner of the list).
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To redisplay the Open Windows list after you’ve closed it, choose View = Open
Window List. You can also collapse the History panel on the right edge of the
QuickBooks window to provide more room for invoice information.

You can also move or hide the icon bar, shown at the top of Figure 1-10. You can
change the location of the icon bar by choosing View and then choosing Top, Left,
or Hidden.

After you display the Create Invoices window, take the following steps to invoice
a customer:

1. Identify the customer and, if appropriate, the job.

To do this, choose the customer or customer and job combination from the
Customer:Job drop-down list. (Don't worry about this “job” business if you
aren’t familiar with it; | describe how jobs work in Book 4, Chapter 5. You
should understand how customers work, however. You must identify the
specific customer you're invoicing by choosing that customer from the
Customer:job list.) If the customer is a new customer that you haven't yet
invoiced or described in the Customer List, enter a brief name for the
customer — such as an abbreviation of the customer’s business name — in
the Customer:jJob list. QuickBooks indicates that the customer doesn't yet exist
in the Customer List and asks whether you want to add the customer; indicate
that you do. When prompted, supply the customer information that
QuickBooks requests.

For more information about adding customers in QuickBooks, refer to Book 2,
Chapter 2.
TIP You can also classify an invoice as fitting into a particular category by using the

Class drop-down list. Don't worry at this point about using class tracking. Book 4,
Chapter 4 describes how you can use classes to get a better handle on your
business's finances.

2. Confirmor provide new invoice header information.

After you identify the customer, QuickBooks fills out the Bill To field and
possibly the Ship To field. You probably don't need to change any of this
information. You should review the information shown in these boxes to make
sure that it's correct, however. Typically, for example, you wouldn't invoice
someone unless you've already shipped the product or provided the service.
Therefore, you probably should confirm that the invoice date follows the
product shipment date or the provision-of-service date. You may also want to
confirm that the Ship To address is correct.
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3.

Provide or confirm the invoice field information.

Invoices include field information that records items such as purchase order
numbers, payment terms, ship date, and shipping method. You should make
sure that whatever QuickBooks shows in these text boxes is correct. If a
customer has provided a purchase-order number, for example, enter that
number in the P.O. Number box. Confirm that the payment terms shown in
the Terms box are correct. If your invoice includes the Ship Date Field, confirm
that the date shown is correct. These boxes are all in a single line above the
detailed description of the item(s) you're selling. If the billing and shipping
addresses are different, make sure that the Ship To box in the top-right portion
of the invoice is filled in properly. Not all these fields need to be filled in for
every invoice, but you want to supply any information that makes it easier for
a customer to pay an invoice, tie an invoice to their purchasing records, and
figure out how and when an item is being shipped.

Describe the items sold.

How the columns area of your invoice looks really depends on whether you're
selling products or services. Figure 1-11 shows the columns area for products.
The columns area for a service looks simpler because you don't provide much
information when describing service items. In the columns area, you want to
describe each item — each product or service — for which an invoice bills. To do
this, you use a single row for each item. The first item that you want to bill for,
then, goes in row 1 of the columns area. For each item, you enter the quantity
ordered, the code for the item, and a price or rate. QuickBooks retrieves an item
description from your Item list and places this data in the Description column.
QuickBooks also calculates the amount billed for the item by multiplying the
quantity by the price or rate. You can edit both the Description and Amount
fields, however. If you edit the Amount field, QuickBooks recalculates the Price
Each field by dividing the amount by the quantity.

To enter additional items in the invoice, enter additional rows. Each item that you
want to bill for — each item that should appear as a separate charge in the
invoice — appears as a row in the columns area. If you want to invoice a cus-
tomer for some product, one line in the columns area of the invoice is used for
that product. If you want to charge a customer for freight, one line of the invoice
area describes that freight charge. If you want to bill a customer for sales tax,
again, one line or row of the columns area shows that sales tax charge.

Discounts represent tricky line items to include in an invoice. For this reason,

| provide an example of how a discount item appears in an invoice. Assume
that you want to grant some customer a 10 percent discount. To do this, as
you now know (or should be able to guess), you include a discount line item in
your invoice. But although QuickBooks includes a discount item in its Item list,
a discount percentage can be applied only to the previous line item in the
invoice. For this reason, QuickBooks also supplies a subtotal line item. You use
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a subtotal line item to total all the previous items shown in the invoice.

By subtotaling all the product items shown in the invoice in Figure 1-11, for
example, the business can grant the customer a 10 percent discount on
these products.
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You need to include the percentage symbol to tell QuickBooks to calculate a
@ discount equal to a percentage of the subtotal. If you omit the percentage
symbol, QuickBooks assumes that you want a dollar discount, not a percent-
TIP age discount. In Figure 1-11, for example, omitting the percentage symbol

would turn the 10 percent discount into a $10 discount.

5. Use the Customer Message box at the bottom of the Create Invoices
window to supply a customer message that appears at the bottom of the
invoice.

If you've created a custom invoice form template that includes other footer
information, these footer boxes also appear at the bottom of the Create
Invoices window. You can use them to collect and transfer additional footer
information.
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6. (Optional) Check your spelling.

If you click the Spelling button, which appears along the top edge of the Create
Invoices window's Formatting tab, QuickBooks checks the spelling of the words
that you use in the invoice. If QuickBooks finds no spelling errors, it displays a
message telling you that the spelling check is complete. If QuickBooks finds a
spelling error — product code abbreviations often produce spelling errors in
QuickBooks — it displays the Check Spelling on Form dialog box, shown in
Figure 1-12. (In Figure 1-12, I've misspelled the word Yellow, much to the horror
of my editor.)
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You can use the Change To box to correct your spelling error — if it actually is a
spelling error. You can select one of the suggested replacements from the
Suggestions list box by clicking the suggestion and then clicking the Replace
button. You can replace all occurrences of the misspelling by clicking the
Replace All button. If the word that QuickBooks says is misspelled is actually
correctly spelled, you can click the Ignore button to tell QuickBooks to ignore
this word or the Ignore All button to tell QuickBooks to ignore all occurrences
of this word in the invoice form.
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TIP

TIP

QuickBooks lets you add historical information about a customer to — and remove
that information from — the Create Invoices window, the Create Credit Memos/
Refunds window, and most other customer information windows. To add histori-
cal information about a customer to a window, click the Show History button that
appears in the top-right corner of the window, a bit to the right of the Template
drop-down lists; it looks like an arrowhead. You can click links in the historical
information panel to drill down and get more information about, for example, a

If you use terms that are always popping up as misspelled words, at least in
QuickBooks, you can click the Add button that appears on the Check Spelling
on Form dialog box. Clicking the Add button tells QuickBooks to add the word
to its spelling dictionary. After you've added a word to the QuickBooks spelling
dictionary, QuickBooks doesn't see the word as being misspelled.

Also note that you can click the Options button to display the Spelling Options
dialog box (not shown). The Spelling Options dialog box includes checkboxes
that you can use to turn certain types of spell-checking logic on or off. You can
select a checkbox to tell QuickBooks to always check the spelling of forms
before printing, saving, or sending the form, for example. The dialog box also
includes checkboxes that tell QuickBooks to ignore certain sorts of words, such
as those that use numbers, those that are all uppercase, and those that are
mixed case.

Click either the Save & Close button or the Save & New button to save
your invoice.

Click the Save & Close button if you want to save the invoice and close the
Create Invoices window. Click the Save & New button if you want to save the
invoice and then enter another invoice in the blank version of the Create
Invoices window.

Click the Send/Ship tab (shown near the top-left corner of Figure 1-10 earlier in
this chapter, located directly above the Customize Data Layout icon and
between the Formatting and Reports drop-down menus) and then click the
FedEx, UPS, or USPS button to start the QuickBooks Shipping Manager
window, which lets you automate some of the steps in shipping packages via
Federal Express (FedEx), United Parcel Service (UPS), or the US Postal Service
(USPS). The first time you start the Shipping Manager, you need to do a bit of
setup work.

To page through invoices that you've already created, click the Previous and
Next buttons. Or click the Find button and use the Find Invoices dialog box to
describe the invoice that you want to locate.

listed transaction.
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Billing for Time

Most of the time, line items that appear in an invoice are items that you describe
in the Item list and then quantify directly in the invoice. In some service busi-
nesses, however, you may actually sell many units of the same item. A lawyer may
sell hours or partial hours of legal advice, and that time may be all that they sell.
A CPA may sell hours of consulting, accounting, or tax preparation work.

In these circumstances, you don’t want to have an invoice go out to the customer
with one line in it that says, for example, “Legal services, 100 hours, $20,000” —
unless you don’t want to stay in business. Instead, you want an invoice that details
each of the tasks that the lawyer performed: estate planning for 1.5 hours, review
of a contract for 4 hours, preparation of a new real estate lease for 2 hours, and so
forth. To provide this level of detail — detail that’s really beneath the item — you
use the QuickBooks Time Tracking feature.

QuickBooks supplies two methods for tracking the time spent that will be billed
in an invoice as an item. You can use the weekly time sheet, or you can time or
record individual activities. I briefly describe how both time-tracking methods
work; neither is difficult. Professional service providers — accountants, attor-
neys, consultants, architects, and so on — who bill based on the time spent should
consider using one of these features to make sure that they keep accurate records
of the time spent working for a client or customer.

Using a weekly time sheet

To use the weekly time-sheet method, choose Customers = Enter Time = Use
Weekly Timesheet. QuickBooks displays the Weekly Timesheet window, shown
in Figure 1-13. To use the Weekly Timesheet window, first use the Name box to
identify the employee, vendor, or other person performing the service. You should
be able to choose this person’s name from the Name drop-down list. If you can’t
choose the person’s name from the Name drop-down list, enter it in the box;
then, when prompted, tell QuickBooks to which list (employee, vendor, or other
names) the name should be added.

After you’ve added the name of the person who performed the work, use the col-
umns of the Weekly Timesheet window to describe the customer or job for which
the work was performed, the service code, a brief description or note, the payroll
item (if you’re using QuickBooks for payroll), the class (if you’re tracking classes),
and then the hours spent per day. You can enter as many lines in the Weekly
Timesheet window as you want. Each line appears separately in an invoice. The
notes information appears in the description area of the invoice. For this reason,
you want to use appropriate and descriptive notes.
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FIGURE 1-13:
The Weekly
Timesheet
window.
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Timing single activities

If you want to record service activities as they occur, choose Customers => Enter
Time = Time/Enter Single Activity. QuickBooks displays the Time/Enter Single
Activity window, as shown in Figure 1-14.

To time or record a single activity, record the activity date in the Date box. Use the
Name box to identify the person who performed the service. In the Customer:Job
box, identify the customer or the job for which the service was performed.
Choose the appropriate service item from the Service Item drop-down list and
(if you’re tracking an employee) the appropriate payroll item from the Payroll
Item drop-down list. If you’re tracking classes, predictably, you can also use the
Class drop-down list to classify the activity. Use the Notes box to record a brief,
appropriate description of the service. This description appears in the invoice, so
be thoughtful about what you write.

After describing or providing this general information about the service, you have
two ways to record the time spent on the service:

3 Record time manually. You can manually record the time spent on an activity
by using the Duration box to enter the time. If you spent 10 minutes, for
example, enter 0:10 in the Duration box. If you spent 3 hours and 40 minutes,
enter 3:40 in the Duration box.
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FIGURE 1-14:
The Time/Enter
Single Activity
window.
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¥ Have QuickBooks record the time. You can also have QuickBooks record
the time that you spent on the activity. Just click the Start button in the
Duration box when you start the activity, and click the Stop button when you
stop the activity. If you want to pause the timer (while you take a phone call,
for example), click the Pause button.

After you use the Time/Enter Single Activity dialog box to describe the activity
that you’re performing, click the Save & New or Save & Close button to save the
activity information.

Verify that the Billable checkbox (in the top-right corner of the dialog box) is
selected. By selecting the Billable checkbox, you tell QuickBooks that it should
keep this record of a billable activity for later inclusion in an invoice.

You can use the Previous and Next buttons, which appear at the top of the dialog
box, to page back and forth through your records of activity timing. Note, too, that
a Spelling button is available. Click that button to spell-check the notes descrip-
tion that you enter — which is a good idea, because this information will appear
in an invoice later.
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FIGURE 1-15:
The Choose
Billable Time and
Costs dialog box.

Q

TIP

Including billable time on an invoice

To add billable time and cost to an invoice, create the invoice in the usual way, as I
describe previously. After you identify the customer (if you’ve entered time for the
customer), and if you’ve been tracking costs for the customer, QuickBooks dis-
plays a message box asking whether you want to bill for any of the time or costs.
If you answer yes, QuickBooks displays the Choose Billable Time and Costs dialog
box, shown in Figure 1-15.
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The Time tab of this dialog box shows each of the times that you’ve recorded for
a customer. To add these times to the invoice, click the Use column for the time.
(The Use column is the leftmost column, displaying a check mark.) Or, if you want
to select all the times, click the Select All button. Then click OK. QuickBooks adds
each of these billable times to the invoice as separate lines. Figure 1-16 shows how
billable time information appears in the Create Invoices window.

If you leave the checkbox titled Print Selected Time and Costs As One Invoice Item
unselected (refer to Figure 1-15), QuickBooks puts each time recording you log
on a separate line of the invoice, as shown in Figure 1-16. If you check the box,
however, QuickBooks lets you combine individual time recordings into a single
invoice line item. (You may want to experiment with this feature a bit if you’re
interested.)
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billable time.

As Figure 1-15 suggests, you can click the Items, Expenses, or Mileage tab to see
@ lists of the items, out-of-pocket expenses, or business miles incurred on behalf
of a customer. You add charges to an invoice for these sorts of things in the
TIP same way that you add charges for time. You can even apply a markup to your
out-of-pocket expenses. In Book 2, Chapter 3, I talk about how to record reim-
bursed expenses (out-of-pocket expenses that you want to charge to customers).
And you can record and then bill for miles you incur on behalf of customers by
choosing the Company = Enter Vehicle Mileage command. (When you choose the
Enter Vehicle Mileage command, use the dialog box that QuickBooks displays to
log the miles covered and identify the customer.) By the way, if you want to return
to the Choose Billable Time and Costs dialog box, and you’re viewing the Create
Invoices window, click the Add Time/Costs button, which appears at the top of the

Create Invoices window.

Printing Invoices

You can print invoices and then mail the printed invoices in a couple of ways:

3 You can print individual invoices by clicking the Print button at the top of the
Create Invoices window.
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TIP

¥ You can print a batch of invoices by clicking the arrow button below the Print
button, choosing Batch from the menu that QuickBooks displays, and then
using the Select Invoices to Print dialog box (which QuickBooks displays) to
select the To Be Printed Invoices for printing. After you select the invoices that
you want to print by clicking them, click OK.

The menu that QuickBooks displays when you click the Print button includes a
Preview command. You can choose the Preview command to see a preview version
of the printed invoice.

Emailing Invoices

176

WARNING

You can email an invoice from QuickBooks. To do this, click the Email button,
which appears at the top of the Create Invoice window, on the Main tab. If you
haven’t already set up email preferences, indicate which email account you
want to use (web mail, an email application such as Microsoft Outlook, or the
QuickBooks emailing system), and provide the email address and (optionally) a
new email message. Then, not coincidentally, click the Send Now button to send
the invoice.

You can set up email preferences by choosing the Edit => Preferences command
and selecting the Send Forms section of the Preferences dialog box. Figure 1-17
shows what an emailed invoice would look like after you set up your business
email address and using the default invoice text. You can play around with these
options to speed your invoicing process.

The first time you click the Email button, QuickBooks may ask you to describe
your email account or accounts, which you do by following the onscreen prompts.
QuickBooks may also suggest that you use its mailing service, which means that
you email the invoice to Intuit and then Intuit snail-mails the paper invoice to
your client. If you’re interested in Intuit’s invoice mailing service, follow the
onscreen prompts.

Much to the consternation of many users, recent versions of the QuickBooks
program added a message and clickable link to the bottom of your printed and
emailed invoices that prompted those users’ customers or clients to use a free (for
them) online payment system to pay your invoice. This service, called the Intuit
Payment Network, costs you a few dollars a month and a 2 to 3 percent service
charge for credit card payments. For more information, see the last section of this
chapter, “Using Odds and Ends on the Customers Menu.”
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FIGURE 1-17:
The Send Invoice
dialog box.
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Recording Sales Receipts

TIP

To bill a customer, you create an invoice, as I describe earlier in this chapter.
To record the fact that you sold the customer some item — presumably because
the customer simultaneously purchases and pays for the item or service — you
don’t invoice the customer. Rather, you create a sales receipt. A sales receipt
looks very, very similar to an invoice. It doesn’t include shipping information,
however (because that’s irrelevant), and it lets you record the amount that the
customer pays.

To record a sales receipt when appropriate, choose the Customers = Enter Sales
Receipts command and then follow these steps:

1 . Inthe Enter Sales Receipts window (shown in Figure 1-18), use the Customer:job
drop-down list to describe the customer or, optionally, the customer and job.

2. Usethe Class drop-down list to identify the class, if you're performing
class tracking.

If you have questions about how the Customer:Job or Class list works, refer to
“Invoicing a Customer” earlier in this chapter. The invoice shown in Figure 1-18
displays the class tracking between the Customer Job and Template drop-down
columns.
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You can customize a sales receipt in the same basic way that you customize an
invoice form. Go back to “Customizing an Invoice Form” at the beginning of this
chapter.

TIP

3. Provide the sales receipt header info.

A sales receipt, like an invoice, includes some header information. Specifically,
the sales receipt includes a sales receipt date and a sales number. The sales
receipt also includes a Sold To box, which shows the customer name and
address. You should confirm that this information is correct — as it should be if
you're recording timely sales receipts and have an up-to-date customer list.

4. Use the Item column to describe the items that you're selling.

The Item column of a sales receipt works exactly the same way as the ltem
column of an invoice. Therefore, rather than repeat myself, I'll direct you to go
back to the earlier discussion of how this column works.

5. (Optional) If you want, enter a customer message in the footer area of
the Enter Sales Receipts window.

This option is available directly above the Memo and Customer Tax Code fields.
If you've added other footer information to the Enter Sales Receipts window —
because you've customized the sales receipt form template — you can include

that information, too.
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6. Describe where the sales proceeds go.

If the Use Deposited Funds option is disabled, a drop-down list to the right of
the Class field will be visible (not visible in Figure 1-18). Use this drop-down list
to indicate what to do with the money that you receive from this sale. If you
immediately deposit the amount in a bank account, choose the account into
which you want to deposit the check. If you want to batch this receipt with a
bunch of other receipts — maybe you're going to deposit the day's receipts
together in one lump sum — choose Group with Undeposited Funds.

If you don't see the Deposit To drop-down list, you may have indicated
(perhaps even inadvertently) during setup that you want QuickBooks to
assume that funds are deposited in an undeposited-funds account. This
probably works just fine. If you do want to specify an account where sales
proceeds go when you record the sales receipt, choose the Edit &> Preferences
command, click the Payments icon, click the Company Preferences tab, and
then deselect Use Undeposited Funds As a Default Deposit to Account.

©

-
o

Book 3, Chapter 4 talks about making deposits of undeposited funds.

©

(Optional) To print a copy of the receipt, click the Print button.

-
o

When you've printed the receipt, you can hand it to your customer.

The Previous, Next, Find, Spelling, Show/Hide History, and Time/Cost functions
(found within the Main, Formatting, Send/Ship, Reports, Payments, and Search
tabs at the top) in the Enter Sales Receipts window work identically to the same
TIP buttons in the Create Invoices window.

©

8. Click the Save & Close or Save & New button to save the sales receipt.

These buttons work the same way in the Enter Sales Receipts window as they
do in the Create Invoices window.

Both the Create Invoices window (described earlier in the chapter) and the Enter
Sales Receipts window (just described) include a Print Later checkbox on the
toolbar of the Main tab. If you select this checkbox, QuickBooks adds the invoice
TIP or sales receipt to its list of unprinted invoices or sales receipts. You can print
invoices and sales receipts that appear on either side of these lists by choosing
File & Print Forms and then choosing either the Invoices or the Sales Receipt
command. There's also an Email Later checkbox that you can select if you want
to email a receipt later. (See the earlier section, “Emailing Invoices.")

©)

Recording Credit Memos

Credit memos show when a customer no longer owes you money or when you owe
a customer money. Credit memos may occur because your customer returns items
that you previously sold to them. Credit memos may also occur because you issue a
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FIGURE 1-19:

The Create Credit
Memos/Refunds
window.
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customer a refund for some other good reason; perhaps the product wasn’t of the
quality that you usually sell, or a service wasn’t provided in the manner in which
it should have been.

To record a credit memo, follow these steps:

1 . Choose the Customers = Create Credit Memos/Refunds command to
display the Create Credit Memos/Refunds window.

2. Identify the customer, or the customer and the job, in the Customer:job
drop-down list, shown in Figure 1-19.

Use the Class drop-down list for class tracking if you've decided to do that. If you
have questions about how either of these lists works, refer to the earlier discussions
of these lists, which work the same way for credit memos as they do for invoices.

The Create Credit Memos/Refunds window supplies a bunch of buttons on the
various tabs that work the same way here as they do in the Create Invoices
window: Previous, Next, and so on. For information about how to use these
buttons if you have questions, refer to the earlier section on this topic.

As is the case with invoices, you can create custom credit memo forms. To do this,
you click the Formatting tab’s Customize Data Layout button. Customizing a credit
memo works the same way as customizing an invoice form. Refer to the earlier

section on this topic if you have questions about how to customize a credit memao.
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Provide the credit memo date and number and confirm customer
information.

Credit memos, like invoices and sales receipts, include a header. This header
includes the transaction date, number, and customer information. You should
confirm that the credit memo header information is correct in the Create
Credit Memos/Refunds window. If it isn't, edit the default information that
QuickBooks uses to fill the Create Credit Memos/Refunds window.

In the columns area, describe the reason for the credit memo.

If the customer returned items, for example, use the columns to describe
these items and the original price that you're refunding.

Click the Print button to print the credit memo.

Note, too, that you can print credit memos in a batch. Obviously, after you
print credit memos, you need to distribute them.

You can email a copy of the credit memo directly from QuickBooks, too. The
steps for emailing a credit memo mirror those for emailing an invoice, which is
described earlier in the section, “Emailing Invoices.”

Click either Save & Close or Save & New to save the credit memo.

At the time you save your credit memo, QuickBooks allows you to indicate
what you want to do with it: Retain it for later application to a customer invoice,
immediately apply it to a customer invoice, or issue a refund check. You apply
credit memos to invoices as described in the next section of this chapter. You
write a refund check the same way that you write other checks. Book 3,
Chapter 4 describes writing checks.

Receiving Customer Payments

When a customer pays an invoice that you’ve sent, you choose a command from
the Customers menu to record the payment. To record a customer payment, fol-
low these steps:

1.

2.

Choose the Customers => Receive Payments command.
QuickBooks displays the Customer Payment window, shown in Figure 1-20.

Use the Received From drop-down list to identify the customer who's
paying you.
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3. Record the payment information in the Payment Amount, Date, and
Reference # fields on the left side of the window, below the heading,
Customer Payment.

You can also choose a payment method by clicking the Cash, Check, Credit
Debit, or e-Check button to the right of these fields.

4, Identify the invoice or invoices paid.

QuickBooks lists the open invoices for the customer in the columns area of the
Receive Payments window. You can identify which invoices a customer
payment pays by clicking the invoices that you see listed.

5. To apply any credit memos to open invoices as you apply the payment,
follow these steps:

a. Click the Discounts and Credlits button.
QuickBooks displays the Discount and Credits dialog box, shown in Figure 1-21.

b. To apply a credit to the selected invoices, click the Credits tab and then select the
credit that you want to apply.

c. Apply any discounts to the open invoices, and click Done.

Discounts work like credits. In fact, you use the same dialog box (refer to
Figure 1-21). When you click Done, QuickBooks closes the Discount and
Credits dialog box.
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FIGURE 1-21:
The Discount
and Credits
dialog box.
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Save & Close

Use the Deposit To box to select the account into which you want to
deposit the check, or select the Undeposited Funds option if you want to
batch the payments for later deposit.

The Deposit To drop-down list appears in the Receive Payments window when,
during the QuickBooks Setup interview, you indicate that you may want to
bunch the payments that you later deposit.

If you have a question about how these buttons work, refer to the discussion of
these buttons in the section, “Recording Sales Receipts,” earlier in this chapter.

Click the Get Online Pmts button to receive online payment information for a
customer. (The Get Online Pmts button appears only if you're using online
billing or online banking.) Book 3, Chapter 4 provides more information about
how online banking works.

Click the Save & Close or Save & New button to save the customer
payment information.
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Assessing Finance Charges

FIGURE 1-22:

The Company
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options.

You can tell QuickBooks to assess finance charges on overdue customer invoices.
To do this, you first set up the finance-charge calculation rules. Then you can
easily assess finance charges on overdue amounts by choosing the QuickBooks
command Customers > Assess Finance Charges.

Setting up finance-charge rules

To set up the finance-charge rules, choose the Edit = Preferences command.
When QuickBooks displays the Preferences dialog box, click the Finance Charge
icon and then click the Company Preferences tab. The Preferences dialog box at
this point should look like the one shown in Figure 1-22.
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To tell QuickBooks how it should calculate the finance charges, enter the annual
interest rate that you’ll use for calculating charges in the Annual Interest Rate (%)
box. Enter the minimum finance charge amount that you assess in the Minimum
Finance Charge box. If you want to create a grace period, enter the number of
grace-period days in the Grace Period (Days) box. Use the Finance Charge Account
drop-down list to specify the QuickBooks income account to which finance charge
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TIP

FIGURE 1-23:
The Assess
Finance Charges
dialog box.

revenue should be credited. Select the checkbox titled Assess Finance Charges
on Overdue Finance Charges if you want to charge finance charges on finance
charges. Finally, use the Calculate Charges From radio buttons — Due Date and
Invoice/Billed Date — to specify the date from which finance charges should be
calculated. After you’ve provided this information, you can click OK to save your
finance-charge calculation rules.

QuickBooks assumes that you don’t want to print finance-charge invoices. For
this reason, the Mark Finance Charge Invoices “To Be Printed” checkbox isn’t
selected. Finance charges typically appear only in customer statements.

Calculating finance charges

After you set up the finance-charge rules, you can easily assess finance charges
on overdue invoices. To do this, choose Customers = Assess Finance Charges.
QuickBooks displays the Assess Finance Charges dialog box, as shown in Figure 1-23.
This dialog box lists all the overdue invoices that customers owe you and, based on
your finance-charge calculation rules, calculates a finance charge.

et s B €

ly Company Cash Flow Hub Income Tracker Bil Tracker Calendar | Snapshots Customers Vendors E

Click the assess column for each customer for whom you wish to create a finance charge invoice.
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v The Sausage Shack 33000 2208
Mark All Unmark All Mark Invoices "To be printed”
Customers with *s have payments or credit memas which have not been
applied to any invoice. The overdue balance does not indude these credits
Settings Collection History Assess Charges Cancel
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To assess the finance charge to a particular customer, click the Assess (Ass.) field
for the customer. (By default, QuickBooks assumes that you want to assess finance
charges whenever a customer’s account is past due.) If you don’t want to assess
finance charges to a particular customer, remove the check mark from the Assess
field by clicking it. After you’ve identified which customers should be assessed
finance charges, click the Assess Charges button. QuickBooks essentially creates a
new invoice for each of these customers. These new invoices charge the customers
a finance fee.

Using Odds and Ends on the
Customers Menu

186

In this chapter, I discuss most of the important commands on the Customers menu.
This menu, however, supplies several other commands that are noteworthy —
perhaps even useful — and deserve discussion somewhere in this book. For this
reason, [ want to briefly describe the other commands that may be available on your
Customers menu.

3 Customer Center: Displays the Customer Center window, which includes
information about your customer list, including the amounts that your
customers owe.

3 Create Estimates: Displays a window you can use to create an estimate for a
customer to show, for example, what a product or service will cost if you sell it
to that customer.

3 Create Sales Orders: Displays a window you can use to create a sales order.
Essentially, a sales order is an invoice for something you haven't yet really sold
or for services you haven't yet provided. You prepare a sales order to record
an order from a customer or client and document the order details.

3 Sales Order Fulfillment Worksheet: Displays the Sales Order Fulfillment
Worksheet window, which lists all your unfulfilled sales orders. You can print
batches of sales orders by using this worksheet, too. (Note: If you've created
sales orders for a particular customer or client, QuickBooks asks whether you
want to turn a sales order into an invoice whenever you start working on an
invoice for that customer.)

3 Create Batch Invoices: Displays the Batch Invoice dialog box, which lets
you identify a group of customers you want to bill for some specified item.
After you've grouped, or batched, the customers in this manner, you can tell
QuickBooks to create a bunch (a batch) of invoices. If you charge customers a
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monthly retainer fee, for example, you could batch the customers on retainer
and then create an invoice for each of them that bills for the “monthly retainer
fee” item.

Enter Statement Charges: Displays the Accounts Receivable Register. You
shouldn't need to use this command, but you can use it to add amounts to the
accounts receivable for a particular customer. The amounts appear in the
customer’s next statement.

Create Statements: Displays a window that you can use to create a set of
monthly statements for customers. Such statements show the amounts that a
customer owes, invoices created for the month, credit memos issued for the
month, and payments made during the month.

Income Tracker: Displays the Income Tracker window, which graphically
organizes your estimates, orders, and invoices to show the flow of sales
revenue you'll (ideally) receive and also graphically organizes your vendor
bills and payments data to show you the flow of expenses you have or will
experience.

Lead Center: Displays the Lead Center window, which lets you store and
monitor customer leads. The window lets you name names, collect notes, and
keep a to-do list of lead-generation activities.

Add Credit Card Processing: Displays a webpage that explains and tries to
talk you into buying Intuit's credit card processing service.

Link Payment Services to Company File: Makes the connection between
your QuickBooks data file and the Intuit servers — something that's necessary
if you sign up for credit card or electronic check processing.

Add Marketing and Customer Tools (available in the Enterprise Solutions
version of QuickBooks): Displays a list of webpages you can visit to get
information about a work-order management feature and an electronic data
interchange feature that work with QuickBooks.

Learn about Point of Sale: Provides more information about setting up a
point-of-sale system. You can also request a 30-day free trial.

Item List: Displays the Item list, which shows the items that may be included
in the invoice or credit memo.

Change Item Prices: Lets you change the prices of a bunch of items at one
time — increasing every price by 5 percent, for example.
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IN THIS CHAPTER

» Working with purchase orders

» Recording receipts and bills
» Sending payments to vendors

» Using the other vendor menu
commands

Chapter 2
Paying Vendors

ou can make the process of tracking vendor information as simple or as

sophisticated as you like. In this chapter, I assume that you’re going for

sophisticated. You can make vendor management simpler, however, by not
using purchase orders or an accounts payable system.

(amounts that you owe vendors) as part of setting up QuickBooks. You can change
your decision about using purchase orders or accounts payable later. To do this,

TIP you choose the Edit = Preferences command. For more information, refer to
Book 2, Chapter 3.

; You decide whether to use purchase orders and whether to track accounts payable

Creating a Purchase Order

A purchase order serves a simple purpose: It tells a vendor that you want to
purchase some item. In fact, a purchase order is a contract to purchase.

Many small businesses don’t use purchase orders. But when they grow to a certain
size, many businesses decide to use them because purchase orders become per-
manent records of items that they’ve ordered. What’s more, using purchase
orders often formalizes the purchasing process in a company. You may decide,
for example, that nobody in your firm can purchase anything that costs more
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FIGURE 2-1:

The Create
Purchase Orders
window.

than $100 unless they get a purchase order. If only you can issue purchase orders,
you’ve effectively controlled purchasing activities through this procedure.

Creating a real purchase order

To use QuickBooks to create purchase orders, follow these steps:

1. Ten QuickBooks that you want to create a purchase order by choosing
Vendors > Create Purchase Orders.

QuickBooks displays the window shown in Figure 2-1.

If the Vendors menu doesn't supply a Create Purchase Orders command,
QuickBooks doesn’t know that you want to create purchase orders. Follow
the instructions described in Book 2, Chapter 3 to turn on the purchase
order feature.

B B €
e MyCompany CashFlow Hub Income Tracker Bil Tracker Calendar = Snapshols Customers Vendors Employees — Ba
Main Formatting  Reports  Search oA
> B B K Boewacw B = vemiee R ——
Find New Save Delete &b Memorize print  Email EmailLaler  Amtach  Create em Approval
e S S File Receipts List

P h O d D= VENDOR SHIPTO -
urchase oraer 020002 M

Pine Lake Porcelain LL
PO.NO 123 Main Street
Pine Lake, WA98765

TOTAL

VTN save & New | Clear

2. Use the Vendor drop-down list to identify the vendor from which you

want to purchase the item.

The Vendor drop-down list shows each of the vendors in your vendor list.
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4.

(Optional) Classify the purchase using the Class drop-down list.

For more information about how you can use classes, read Book 4, Chapter 4. Note
that you don't see a Class drop-down list unless you've turned on class tracking.

(Optional) Choose a different Ship To address from the Drop Ship To
drop-down list in the top-right corner.

The Drop Ship To drop-down list displays a list of all your customers, vendors,
and employees. You change the Ship To address by choosing one of these
other names. After you choose an entry from the Ship To list, QuickBooks fills
in the Ship To address box with the appropriate information.

The Create Purchase Orders window's Main, Formatting, and Reports tabs
supply some standard and, | hope, familiar buttons and boxes: Previous, Next,
New, and so on. Because | spend quite a bit of time talking about these buttons
and boxes in Book 3, Chapter 1, | don't provide a redundant discussion of these
buttons and boxes here. If you have questions about what the Previous and
Next buttons do, refer to Book 3, Chapter 1.

Confirm the purchase order date.

Initially, QuickBooks puts the current system date in the Date box. You should,
however, confirm that the date that QuickBooks enters as the purchase order
date is correct. This date is the contract date. Often, the date sets contractual
terms, such as the number of days within which the item is to be shipped.

Confirm the purchase order number.

The purchase order number, or P.O. number, uniquely identifies the purchase
order document. QuickBooks sequentially numbers purchase orders for you
and places the appropriate number in the P.O. No. box. The guess that
QuickBooks makes about the right purchase order number is usually correct. If
it isn't correct, you can enter a replacement number.

Confirm the Vendor and Ship To information.

The Vendor block and the Ship To block identify the vendor from which you're
purchasing the item and the address to which you want the vendor to send the
shipment. This information should be correct if your vendor list is up to date
and you've correctly used the Ship To drop-down list to identify, if necessary,
an alternative Ship To address. Nevertheless, confirm that the information
shown in these two address blocks is correct. If the information isn't correct, of
course, fix it. You can edit address-block information by selecting the incorrect
information and then retyping whatever should be shown.

Describe each item that you want to order.

You use the columns of the Create Purchase Orders window to describe in
detail each item that you want to order as part of the purchase. Each item goes
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in its own row. To describe an item that you want to purchase from the vendor,
you provide the following bits of information.

Item: The Item column is where you record the unique item number for the
item that you want to buy. Remember that items need to be entered, or
described, in the Item list. Book 2, Chapter 2 discusses briefly how you go
about setting up the Item list. Book 3, Chapter 3 talks in more detail about
the Item list. The main thing to know about the Item list is that anything
that you want to show in the invoice — or, for that matter, in a purchase
order — must be described in the item file.

Description: In the Description column, you describe the item that you
select. You can also edit the Description field so that it makes sense to
customers or vendors.

Qty: The Qty column specifies the quantity of the item that you want.
Obviously, you enter the number of items that you want in this column.

U/M: The U/M column allows you to show quantities, prices, rates, and costs for
an item. A unit of measurement can be set up as a single unit or multiple units.

Rate: The Rate column specifies the price per unit or rate per unit for the
item. Note that QuickBooks uses different labels for this column depending
on the type of business that you've set up.

Customer: The Customer column identifies the customer for which the item
is being purchased.

Class: In the Class column, you classify purchase order items at the item level
rather than at the purchase order level. Note that you won't see this column
unless you've turned on class tracking.

Amount: The Amount column shows the total expended for the item.
QuickBooks calculates the amount for you by multiplying the quantity by the
rate (or price). You can edit the column amount. In this case, QuickBooks
adjusts the rate (or price) so that quantity times rate always equals the amount.

You enter a description of each item that should be included in the purchase
order. This means, for example, that if you want to order six items from a
vendor, your purchase order should include six lines of information.

Print the purchase order.

The purpose of recording a purchase order in QuickBooks is to create a formal
record of a purchase. You almost always want to transmit this purchase order
to the vendor. The purchase order tells the vendor exactly what you want to
purchase and the price that you're willing to pay. To print the purchase order,
you can click the Print button. You can also print purchase orders in a batch
later if you select the Print Later checkbox (available on the Main tab) when
you're creating purchase orders, save all the purchase orders that you want to
print later, and then choose File => Print Forms => Purchase Orders.
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10. save the purchase order.

To save your purchase order, click either the Save & Close button or the Save &
New button. If you click the Save & New button, QuickBooks saves that
purchase order and redisplays an empty version of the Create Purchase
Orders window so that you can record another purchase order.

Using some purchase order tips and tricks

Even though the preceding section details all you need to know to create a pur-
chase order, I want to make a few more important observations:

3 Not every purchase deserves a purchase order. If you're not used to
working with purchase orders, it's easy to go overboard when you start using
this handy tool. Nevertheless, keep in mind that not all purchases warrant
purchase orders (see the next item).

3 Use purchase orders to manage buying. Typically, businesses use purchase
orders as a way to control and document purchases. In fact, many purchases
don't really require a purchase order. Amounts that you've agreed to pur-
chase that are documented through standard contracts — such as bills from
the telephone company, the gas company, and your landlord — don't need
purchase orders, obviously. In addition, modest purchases, such as office
supplies, often don't need purchase orders. You definitely need a way to
control these expenditures, but purchase orders probably aren't the
way to go.

3 Consider other, complementary control tools. Other budgetary controls,
such as “approval from the supervisor” or a simple budget, often work
just as well.

Recording the Receipt of Items

When you receive items from a vendor, you can record the receipt. You typically
do this when you want to record the receipt of an item even before you receive a
bill for the item. In any business with inventory, for example, you want to know
exactly how much inventory you have in your warehouse or on your store floor.
You don’t want to wait to adjust your inventory records for these purchases until
you receive the invoice from the vendor. In this scenario, you record when you
receive items.
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To record item receipts, follow these steps:

1 . Choose the Vendors => Receive Items command.

QuickBooks displays the Create Item Receipts window, as shown in Figure 2-2.

Pine Lake Porcelain LLC - Intuit QuickBooks Enterprise Solutions: Accountant 24 0 - [Create ltem Receipts]

mpany Cash Flow Hub Income Tracker BilTracker Calendar | Snapshots Customers Vendors Employees —Bank Feeds
Main | Reporis  Search oA
¢« BB X Qoo B @ B E @
Find New Save Delete €@bMemorize Print Attach Select Clear Recalculate
= ¥ File PO Splits
Bil Received

0272612024 [

veve  [Received items (bill to follow)
Expenses $0.00  Items $0.00

FIGURE 2-2:
The Create Item save & Close Clear

Receipts window.

2. From the Vendor drop-down list, choose the vendor from which you're
receiving items.

3. select any purchase orders that you're receiving items from.

If open purchase orders exist for the vendor, QuickBooks displays a message
box, asking whether you want to receive items against one of the open
purchase orders. If the items that you receive are items that you set up in

a purchase order, click Yes. When QuickBooks displays the Open Purchase
Orders dialog box — the dialog box lists only open purchase orders —

select the one that ordered the items you're now receiving and then click OK.
QuickBooks fills out the Items tab of the Create Item Receipts window by using
the information from the purchase order. This automatic data entry of
purchase order information should save you time if the items that you're
receiving match items in the purchase order.
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4. confirm the receipt date.

Use the Date field to confirm the date of receipt. As with the Date field in other
places in QuickBooks, enter the date in mm/dd/yyyy format. Or click the
Calendar button that appears to the right of the Date field and choose the date
from the pop-up calendar that QuickBooks displays.

5. (Optional) Enter a reference number.

You can use the Ref. No. field to provide a reference number. You may want to
reference the vendor’s order number, for example.

6. Use the Total box to identify the total value of the order received, if available.

QuickBooks calculates this total for you by adding the individual item costs, so
you can wait until later.

7. (Optional) Provide a description in the Memo text box.
8. Describe the items received.

Use the Items tab to identify the items that you've received. The Items tab of
the Create Item Receipts window resembles and works like the Items tab of the
Create Purchase Order window, as described (briefly) earlier in this chapter
and (in some detail) in the preceding chapter. For this reason, | don't discuss
how you enter, for example, item codes in the Item column. If you have
questions about how the Items tab works, refer to one of the other appropri-
ate chapters in this book.

9. Describe any related expenses.

The Expenses tab of the Create Item Receipts window works like the Expenses
tab of the Write Checks window. If you have questions about how the
Expenses tab works, see the discussion of writing checks in Book 3, Chapter 4.

10. click either the Save & Close or Save & New button to save the receipt item.

If you click the Save & Close button, QuickBooks saves your item receipt
information and closes the Create Item Receipts window. If you click the Save &
New button, QuickBooks saves the item receipt information and redisplays a
fresh, clean version of the Create Item Receipts window. You can use the
window to describe the receipts of some other set of items.

That’s about all you need to know to work with the Create Item Receipts window.
Nevertheless, let me quickly describe a few command buttons that I don’t refer-
ence in the earlier discussions.

¥ Select PO: This toolbar button displays the Open Purchase Orders dialog box,
which lists the purchase orders open for the selected vendor. By selecting a
listed purchase order, you tell QuickBooks to fill out the Items tab with the
information from that purchase order or orders.
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FIGURE 2-3:
The Select Time
Period dialog box.

196

»

»
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»
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Receive All/Clear Qtys: This button is located in the bottom-left corner of the
Item Receipt window; it can change depending on whether you have quanti-
ties entered. When it's labeled Receive All, this command button says you've
received all the items you ordered in some purchase order; when it's labeled
Clear Qtys, the button clears the received quantities shown on the Items tab if
you've specified a purchase order. When you click this button, it changes from
Receive All to Clear Qtys to Receive All, and so on.

Show PO: This command button shows the selected purchase order and is
located next to the Receive All/Clear Qtys button.

Clear Splits: This toolbar button erases any expense or item information that you've
entered on the Expenses or Items tab and moves the total to the Expenses tab.

Recalculate: This toolbar button recalculates the total amount by using the
information that you've entered on the Expenses and Items tabs.

Clear: This button (which appears in the bottom-right corner of the window) clears
all the information that you've entered in the Create Item Receipts window, including
Expenses-tab information, Items-tab information, and the vendor information
shown at the top of the window. In effect, the Clear button lets you start over.

Enter Time: This toolbar button opens the Select Time Period dialog box,
shown in Figure 2-3, which you use to specify the date range of the work for
which you're paying.
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Simultaneously Recording the
Receipt and the Bill

FIGURE 2-4:
The Enter Bills
window.

You can record a bill for items that you receive at the same time that you record the
receipt of the items. You can do this simply by selecting the Bill Received checkbox
that appears near the top of the Create Item Receipts window (refer to Figure 2-2).

If you know that you’re going to record a bill at the same time that you record the
receipt of items, you can also choose the Vendors > Receive Items and Enter Bill
command. In other words, rather than choose the Receive Items command from
the Vendors menu, you choose the Receive Items and Enter Bill command. When
you do this, QuickBooks displays the Enter Bills window, shown in Figure 2-4.
Essentially, the Enter Bills window is another version of the Create Item Receipts
window except that the Bill Received checkbox is already selected. To simultane-
ously record items that you’ve received and enter a bill, you follow the same steps
that you do to record the receipt of the items.

Pine Lake Porcelain LLC - Intuit Quic s Enterprise Solutions: Accountant 240 - [Enter Bills]
= File Edit View Lists Favorites Accountant Company Customers Vendors Employees Banking Reports Window Help Beta - DESOVERY €g- = x
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One item worth noting about simultaneously recording bills and the receipt of
items, however, is this: When you enter a bill, you need to be very precise about
the charges of the vendor. In all probability, you won’t pay just for the ordered
items, for example; you may also pay certain shipping and handling fees. These
amounts won’t necessarily get recorded on the Items tab. They’ll probably be
recorded on the Expenses tab.

Entering a Bill

198

TIP

If you told QuickBooks during the setup process that you want to track unpaid
bills, also known as accounts payable, you can enter bills as you receive them. As
you do this, QuickBooks keeps track of the unpaid bills.

Good, accurate record keeping of unpaid bills, or accounts payable, is essential if
you want to do good accrual-basis accounting. As I discuss in Book 1, Chapter 1,
accrual-basis accounting produces more accurate financial statements than other
methods do.

To enter a bill, you follow either of two sequences of steps.

If you haven't previously recorded
an item receipt

If you’re entering a bill for which you haven’t previously recorded an item receipt,
you follow these steps:
1. choose the Vendors = Enter Bills command.

QuickBooks displays the Enter Bills window, shown in Figure 2-5. You use this
window to describe the bills that you need to pay later.

. Use the Vendor drop-down list to identify the vendor.

3. Use the Date, Amount Due, and Bill Due fields to describe the invoice
date, the invoice due date, and the invoice amount.

. (Optional) Use the Terms drop-down list to identify the payment terms
and the Ref. No. box to identify the vendor’s reference number.

5. (Optional) If you want to, enter a memo description for the bill in the
Memo box.
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FIGURE 2-5:
The Enter Bills
window again.

TIP

Pine Lake Porcelain LLC - Intuit QuickBooks Enterprise Solutions: Accountant 24 0 - [Enter Bills]
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Identify the expenses billed.

Use the Expenses tab of the Enter Bills window to identify the expenses that the bill
represents. To identify expenses, you supply the account number that should be
debited; the amount; and (optionally) the Memo, Customer:Job, and Class informa-
tion. If you have questions about how the Expenses tab works, see the discussion
of writing checks in Book 3, Chapter 4. The Expenses tab of the Write Checks
window works the same way as the Expenses tab of the Enter Bills window.

Identify the items billed on the Items tab.

Use the Items tab of the Enter Bills window to describe any items for which the
vendor bills you. Use the Item column to identify the thing that you purchased,
for example; then use the Qty, Cost, and Amount columns to identify what the
item cost. You can also use the Customer:Job column if you're tracking bills by
customers. If you have questions about how to work with the Items tab, be
aware that the Items tab of the Enter Bills window works the same way that
the Items tabs of other QuickBooks windows work. You can, for example, refer
to the discussion of the Create Invoices window in Book 3, Chapter 1.

The buttons available in the Enter Bills window — Select PO, Receive All, Show PO,
Clear Splits, Recalculate, and Clear — work the same way as the similarly titled
command buttons scattered around the edges of the Create ltem Receipts window,
discussed in the section, “Recording the Receipt of Items,” earlier in this chapter.

Click either the Save & Close or Save & New button to save the bill.
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FIGURE 2-6:
The Select
Item Receipt
dialog box.

Q

TIP

200

If you have previously recorded
an item receipt

To enter a bill when you’ve already recorded the receipt of the item for which the
bill invoices, follow these steps:

1 . Choose the Vendors => Enter Bill for Received Items command.

QuickBooks displays the Select Item Receipt dialog box, shown in Figure 2-6.

ountant 24.0 - [Enter Bills]
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2. To identify the item receipt for which you're now recording a bill, choose
the vendor from the Vendor drop-down list.

3. When QuickBooks displays a list of item receipts for the vendor, select
the item receipt that corresponds to your bill and click OK.

QuickBooks displays the Enter Bills window for the item. QuickBooks fills out
much of the Enter Bills window by using the information from the item receipt,
as shown in Figure 2-7.

You may be able to skip Steps 4 to 8 if your item receipt information correctly
and completely fills the Enter Bills window.
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FIGURE 2-7:
The Enter Bills
window yet again.
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Use the Date, Amount Due, and Bill Due fields to describe the invoice

date, the invoice due date, and the invoice amount.

(Optional) Use the Terms drop-down list to identify the payment terms

and the Ref. No. box to identify the vendor’s reference number.

Memo box.

that the bill represents.

(Optional) If you want to, enter a memo description for the bill in the

Use the Expenses tab of the Enter Bills window to identify the expenses

To identify expenses, you supply the account number that should be debited,
the amount, and (optionally) the Memo, Customer:Job, and Class information.
If you have questions about how the Expenses tab works, see the discussion of
writing checks in Book 3, Chapter 4. The Expenses tab of the Write Checks
window works the same way as the Expenses tab of the Enter Bills window.

which the vendor bills you.

Use the Items tab of the Enter Bills window to describe any items for

Use the Item column to identify the thing that you purchased, for example;
then use the Qty, Cost, and Amount columns to identify what the item cost.
You can also use the Customer:Job column if you're tracking bills by customers.
If you have questions about how to work with the Items tab, be aware that the
Items tab of the Enter Bills window works the same way that ltems tabs of
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other QuickBooks windows work. You can, for example, refer to the discussion
of the Create Invoices window in Book 3, Chapter 1.

9. Click either the Save & Close or Save & New button to save the bill and
item receipt information.

The only difference in recording a credit memo is that you select the Credit radio

@ You record credit memos from vendors by using the Enter Bills window, too.
button.

REMEMBER

Paying Bills

If you use QuickBooks to keep track of the bills that you owe, you don’t use the
Write Checks window (described in Book 3, Chapter 4) to record the bills that you
want to pay. Rather, you tell QuickBooks to display a list of these unpaid bills that
you’ve already recorded — and then you choose which bills QuickBooks should
pay and the bank account on which QuickBooks should write the check.

Follow these steps to pay bills in this manner:

1. choose the Vendors = Pay Bills command.

QuickBooks displays the Pay Bills window, shown in Figure 2-8. You use this
window to describe the payment that you want to make.

2. Describe which bills you want to pay.

Use the Show Bills radio buttons at the top of the Pay Bills window to identify
what you want to see. Select the Due On or Before radio button to show only
those bills that are due on or before the specified date. To specify the date,
enter the date in the Due On or Before box. To see a list of all the bills that you
have to pay, select the Show All Bills radio button.

You can use the Sort By drop-down list to select the order that QuickBooks
uses for listing your bills. You can sort bills by due date, discount date, vendor,
and amount due.

TIP
3. Select the bills that you want to pay.

To select bills that you want to pay, click the check column. (The check column
is the leftmost column in the list of unpaid bills; it's headed by a check mark.)
When you click the check column, QuickBooks marks the bill with a check
mark. The check mark tells QuickBooks that you want to pay that bill. To
deselect a bill, click the check column again. QuickBooks removes the

check mark.

202 BOOK 3 Bookkeeping Chores



FIGURE 2-8:
The Pay Bills
window.

TIP

ain LLC - Intuit Qui ountant 24 0 - [Pay Bills]
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4. (Optional) Review a specific bill.

You can review detailed information about a specific bill by first clicking the bill
to highlight it in the list and then clicking the Go to Bill button. When you do
this, QuickBooks opens the Enter Bills window, displaying the bill information.
To close the Enter Bills window, click the Close button.

Set the discount and credit and then click Done.

If you click the Set Discount button, QuickBooks displays the Discount tab of
the Discount and Credits dialog box, as shown in Figure 2-9. You can use the
Discount tab to enter a discount amount for the bill. If you enter a discount
amount for the bill, you also enter the discount account. This account is the one
that gets credited for the reduction — the discount — in the correct amount.

If you click the Pay Bills window's Set Credits button, QuickBooks displays the Credits
tab of the Discount and Credits dialog box, shown in Figure 2-10. The Credits tab
lists any credit memos from this vendor. To apply a credit memo to the amount
due to a vendor, click the check mark next to the credit and click Done. QuickBooks
marks applied credits by placing a check in the marked column.

When you complete your work with the Discount and Credits dialog box, click
the Done button to close the dialog box and return to the Pay Bills window.

Click the Clear button in the Discount and Credits dialog box to clear the
applied credits shown on the Credits tab.
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FIGURE 2-9:

The Discount tab
of the Discount
and Credits
dialog box.

FIGURE 2-10:
The Credits tab
of the Discount

and Credits
dialog box.
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SELECT BILLS TO BE PAIl

ts Cu

unt and Credit

@ Dueond Bt
Show bills
@ showall] Vendor Country Coffee Supplies
Ref.No. Amount Due 3,300.00
Date 031022024 Discount Used 25.00
v Original Amt 3,300.00 Credits Used 0.00 T.
7 031202024 Amt. To Pay 3.275.00 3,300.00
™ 031202024 0.00
Discount Credits
Discount Date
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Suggested Discount 0.00
Amount of Discount 2500
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Discount Class 3,300.00
e ans el - e
DISCOUNT & CREDIT INF¢
Vendor Country Coffee Supplies Terms Number of Credits 0
Bill Ref. No. Sugg. Discount 0.00 Total Credits Available 0.00
Go to Bill Set Discount Set Credits
PAYMENT
Date Method . Account
® To be printed
03/02/2024 Check printed Big National Bank -
Assign checknumber ¢ i Balance 261.138.96
Pay Selected Bills Cancel
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Discount and Credits

@ Dueonq siLL
Show bills
@ showal] Vendor Country Coffee Supplies
Ref. No Amount Due 3,300.00
Date 03/02/2024 Discount Used 25.00
& Original Amt.  3,300.00 Credils Used 0.00 T
& loan2zozs Amt. To Pay 3,275.00 3,300.00
I~ 03122024 P 0.00
Discount Credits
v 0, . AT,
Totals 0.00 0.00 0.00
Clear 3,300.00
Clear Selections m Ccancel Help
DISCOUNT & GREDIT INF
Vendor  Country Coffee Supplies Terms Number of Credits []
Bill Ref. No. Sugg. Discount 0.00 Total Credits Available 0.00
Go to Bill Set Discount Set Credits
PAYMENT
Date Method Account
@ To be printed
030022024 @ Check @ be printed Big National Bank -
Assign check number Ending Balance 261.138.96
Cancel
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6. Use the Account drop-down list in the bottom-right corner to select the
bank account to be used for making payments.

You can double-check to make sure you have enough money in the bank
account, because the ending balance is displayed in the account you selected
after you complete this payment (refer to Figure 2-8).

7. Use the Method drop-down list in the Payment section to select the
payment method.

If you want to pay your bills by check, for example, choose Check. Assuming
that you'll print the checks in QuickBooks, select the To Be Printed radio
button; otherwise, select the Assign Check Number radio button to have
QuickBooks assign the next consecutive check number. You can also pay bills
by other methods, such as by credit card and by online payment (if you're set
up for online payment or online banking).

8. Use the Date box in the Payment section to record the payment date.

This entry interacts with the entry in Step 7. The payment date that you set, for
example, affects when an online payment gets made. The payment date also
corresponds to the date that's shown on printed checks.

9. After you select the bills that you want to pay and describe how you want
to pay them, click Pay Selected Bills.

QuickBooks records the payment transactions in the bank account to pay the
selected bills and closes the Pay Bills window.

10. Complete your task.

You still need to print any unprinted checks necessary to pay bills if you're
using checks to pay the bills. You also need to transmit any online payment
instructions necessary to pay the bills, if that's how you've chosen to pay the
bills. If you're going to handwrite checks, you (obviously) need to handwrite the
checks and then mail them. In other words, all QuickBooks does at this point is
record the payment transactions in the QuickBooks data file. You need to print
the checks, send the online payment instructions, or handwrite the checks!

Reviewing the Other Vendor
Menu Commands

In the preceding paragraphs of this chapter, I talk about the most important com-
mands on the Vendor menu. Nevertheless, before I wrap up this little dog-and-pony
show, I quickly review for you the other commands and what they do.
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FIGURE 2-11:
The Vendor
Center window.
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Vendor Center window

The Vendor Center window, shown in Figure 2-11, displays a list of vendors and
detailed vendor information for the selected vendor. To use it, choose from the
Active Vendors drop-down list the vendor for which you want to see detailed
information. The Vendor Center shows a bunch of information for a vendor. All
this information comes from the Vendor list, by the way, which is discussed in
Book 2, Chapter 2.

If you keep records of your vendors, including information such as their tele-
phone numbers, just about the best place to store that information, in my humble
opinion, is the Vendor list. You have to maintain the Vendor list for QuickBooks
to work. Why not also go to a little bit of extra effort and keep all your vendor
information there? If you adopt this approach, the Vendor Center window is the
window that you can use to quickly look up things such as the vendor’s phone or
fax number.

The Bill Tracker toolbar button, shown in Figure 2-11, is very useful for keeping
track of unbilled purchase orders, open bills, overdue bills, and bills that have
been paid within 30 days. The information is neatly presented to make this infor-
mation visible at a quick glance.

Pine Lake Porcelain LLC - Intuit QuickB

ks Enterprise Solutions: Accountant 24 0 - [Vendor Center: MugsRUs]

= File Edit View Lists Favorites Company Customers Vendors Employs Banking Reports Window Help Beta '@' piEOgvVERY €G- = x

@ € a @ 0

Home My Company CashFlow Hub Income Tracker Bill Tracker Calendar = Snapshots Customers Vendors Employees —Bank Feeds

New Vendor.. ¥ JE| New Transactions ¥ (=) print ¥ Excel ¥ [ wora ¥ [ BilTracker
Vendors V d I f t 0 &
enaor information * HoTE
Active Vendors - >
Company Name
jel Full Name
REPORTS FOR THIS VENDOR
Billed From
2 ] AME = BALANCE TOTAL : ATTACH QuickReport
Country Coffee Sup. 3,300.00 Open Balance
Crispy Ceramics 0.00
Landlord 0.00
MugsRUs 2,500.00 Order 1098 Forms
Office Supplies 0.00
Order Checks
Office Warehouse 0.00
Puget Sound Energy 450.00
Super Shippers 0.00 _ Transactjons Contacts ToDo's Notes. Sent Email
WA Dept. of Revenue 102528 g
e AllTrans.. « FILTER EY All 4 DATE Al v
ltem Receipt 03/02/2024 Accounts Payable -2,500.00
Manage Transactions v Run Reports ~ | Schedule Online Payment
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Sales Tax menu commands

The Sales Tax command displays a submenu of commands that pay sales tax
amounts you’ve collected to the appropriate tax agency; adjust the sales tax lia-
bility due; and produce reports on the sales tax liability you owe, the sales tax
revenue you’ve generated, and the sales tax codes you’ve set up.

Note: To see this menu, you need to tell QuickBooks that you collect sales tax. You
may tell QuickBooks that you collect sales tax during the QuickBooks setup pro-
cess. You can also choose Edit => Preferences and set your Sales Tax preferences
for the company.

To pay the sales taxes you owe, simply choose Vendors => Sales Tax = Pay Sales
Tax. When QuickBooks displays the Pay Sales Tax dialog box (which lists the
amounts you owe various sales tax collection agencies), you select the agencies
you want to pay or click the Pay All Tax button. QuickBooks records checks in the
bank account register (see Book 3, Chapter 4 for details about how to work with
the bank register), and you print the checks in the usual way.

To adjust the amount that QuickBooks thinks you owe a sales tax collection
agency, you can choose Vendors = Sales Tax = Adjust Sales Tax Due. When Quick-
Books displays the Sales Tax Adjustment dialog box, select a sales tax agency in
the Sales Tax Vendor box and an appropriate expense or income account in the
Adjustment Account box. Next, select the appropriate button (Increase Sales Tax
By or Decrease Sales Tax By) and enter the adjustment amount in the Amount box.

To print one of the sales tax reports, simply select the command that corresponds
with the report. To print the Sales Tax Liability report, for example, choose
Vendors = Sales Tax = Sales Tax Liability.

The Manage Sales Tax command displays a window with buttons and clickable
hyperlinks that you can use to get sales tax information and perform some of the
tasks described in the preceding paragraphs.

Visiting the Sales Tax Code List enables you to add, delete, or edit codes. It also
provides drop-down lists that give you options to do things described earlier, such
as pay sales tax liability or view reports that show transactions on which sales tax
was charged.

Inventory Activities menu commands

The Inventory Activities command displays a submenu of commands that you use
to work with QuickBooks inventory features and with the related Item list. ’'m
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not going to discuss this stuff here — not because I’'m lazy, but because I discuss
inventory and the Item list in Book 3, Chapter 3.

Print/E-file 1099s commands

The Print/E-file 1099s command displays a submenu of commands that let you
print 1099-MISC forms for a selected calendar year. You can see the vendors for
which you probably need to print 1099s, for example, by choosing the Print/E-
file 1099s = Review 1099 Vendors command. (When you choose this command,
QuickBooks displays the Vendor 1099 Review report, which lists vendors and indi-
cates the vendors that are, per your descriptions, eligible for a 1099.)

The reporting threshold may change in the future due to inflation, but the general
rule is that if you operate a business or own rental property, you need to send a
1099-MISC to pretty much any unincorporated vendor you pay $600 or more dur-
ing the year for services. And before you decide not to follow this rule, you should
know two other facts.

¥ Your business tax return actually needs to disclose whether you followed this
rule. Yikes.

¥ If you don't send 1099s, you'll pay a penalty from $30 to $100 per late 1099 if
you're merely late (with a maximum penalty total set to $500,000). If you
simply blow off this requirement, the penalty equals $250 per 1099 — with no
maximum penalty.

You can use the Print/E-file 1099s = 1099 Wizard command to start an online
wizard that helps you identify the vendors that require 1099s and then prepare to
print or e-file those 1099s.

Finally, you can choose the Print/E-file 1099s menu’s 1099 Summary Report and
1099 Detail Report commands to produce reports you can use to identify which
vendors need 1099s and what detailed information goes in those 1099s. For infor-
mation about how to set 1099 preferences, refer to Book 2, Chapter 3.

Item List command

The Vendors = Item List command displays the Item List window. You can read
more about the Item List window in Book 3, Chapter 3 (the next chapter).
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» Viewing your Item list

» Expanding your Item list
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inventory values

» Modifying prices and price levels

» Dealing with a manufacturing firm’s
inventory

Chapter 3

Tracking Inventory
and Items

f you’ve worked with QuickBooks, you won’t be surprised to hear that the Item

list is a key piece of your QuickBooks accounting system. The Item list identifies

each of the things that you sell. The Item list also identifies other things that
appear in your invoices and — if you use them — purchase orders.

In this chapter, I talk about how you work with the QuickBooks Item list — more
specifically, how you look at and use the information in the Item list to track and
tally what you sell. I explain how to add information to the list and how to edit
information that’s already in the list. What’s more, I talk about three accounting
tasks that are related to your Item list: adjusting physical inventory accounts for
inventory shrinkage or spoilage, adjusting price levels of your inventory items,
and (if you manufacture inventory) using QuickBooks to handle inventories of
manufactured goods.
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Looking at Your Item List

FIGURE 3-1:

The Item Code
column and
drop-down list
in the Create
Invoices window.

Q
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QuickBooks provides a bunch of ways to see the information that you’ve stored
in your Item list. You may already know some of this stuff if you’ve worked with
QuickBooks a bit; some of it may be new to you. In any case, the next sections
review several ways that you can see the items in your Item list.

Using the Item Code column

One important point to consider as you look at the Item Code column and Item
Code drop-down list in the Create Invoices window (see Figure 3-1) is space. Note
that the Item Code column is pretty narrow. Note also that the Item Code drop-
down list in Figure 3-1 provides the item code (the left column), the item type,
and a lengthier item description. Though you do have quite a bit of space for a
description, you can’t go hog-wild.

= Add New = =
= Find & Select ltems = '
consulting Service

consulting service Senvice

Blue Mug Inventory Part blue coffee mug

Gut Buster Chili Dog Inventory Part

Rainbow Mug Inventory Part rainbow coffee mug

Red Box Inventory Part

Red Mug Inventory Part

Red Paper Inventory Part

Stainless Mug Inventory Part v

I’'m using self-explanatory item codes in this reference, as you can see in
Figure 3-1. In real life, your codes may be far more cryptic.

Using the Item List window

If you choose the Lists &> Item List command, QuickBooks displays the Item List
window, as shown in Figure 3-2. The Item List window identifies the item code or
name, the description, the type of item (I talk more about this in the next section
of the chapter), the account that gets credited when you sell some of the items,
and the inventory stocking and pricing information (if you supply that).
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FIGURE 3-2:
The Item List
window.

Home My Company CashFlow Hub Income Tracker BilTracker Calendar = Snapshots Customers Vendors Employees —Bank Feeds

Lookfar in Al fields LAl searcn Search within results
S 77 S T
[+ Consulting Service Senvice ConsulingR. 75.00
+ Blue Mug Blue Coffee Mug. Invent.. Sales Reven. 410 0 12.00
|+ Gut Buster Chili Dog Invent.. Sales Reven. 80 0 6.00
> Rainbow Wug Rainbow Coffee Mug Invent... Sales Reven. 358 0 12.00
[+ Red Box Invent.. Consulting R... 485 0 750
[+ Red Mug Red Coffee WMug Invent.. Sales Reven. 430 0 16.00
|+ Red Paper Invent.. Sales Reven. 1,000 0 1.00
|+ Stainless Mug Invent.. Sales Reven. 440 0 2000
+ Valentines Box Invent.. Sales Reven. 225 0 500
[+ Yellow Mug Yellow Coffee Mug Invent.. Sales Reven. 245 0 10.00
[+ Gift Box. Invent.. Consulting R. 1,400 0 0.00
- Valentine's Day Box Invent... Sales Reven. 0 0 55.00
- Consignment ftem Consigned Non-Inventory Part Item Description Non-i... Consulting R... 0.00
o N tory ttem N, tory partitem i Nor-... Consulting R... 0.00
[+ Fin Chg Finance Charges on Overdue Balance Other . Finance Cha. 10.0%
|+ Reimb Subt Reimbursable Expenses Subtotal Subtot

[+ Reimb Group Total Reimbursable Expenses Group

|+ Discount Disco... Sales Disco. -10.0%
[+ Local Tax Local Sales Tax Sales .. Sales TaxPa 0.0%
[+ Out of State Out-of-state sale, exempt from sales tax Sales .. Sales TaxPa 0.0%
- State Tax State Sales Tax Sales .. Sales TaxPa 0.0%
> WA Sales Tax Sales .. Sales TaxPa 10.0%

lem <~ Activities v | Reports |v | Excel +| Attach | GotoCategory List

The Item list provides a good way to see quickly what items you can put in invoices
and purchase orders. The Item list also provides a quick and convenient way to see
stocking levels and prices.

If you want more information about an item shown in the Item List window, you
can double-click the item. When you double-click the item, QuickBooks displays
the Edit Item window, as shown in Figure 3-3. Essentially, the Edit Item window
displays all the information available about a particular item. You can use this
window to change bits of item information. Later in this chapter, in the section,
“Editing Items,” I describe how to do this.

Using inventory reports

I mention one other thing because it’s so darn useful. As you’d expect, QuickBooks
supplies several interesting, useful inventory reports. If you choose the Report =
Inventory command, for example, QuickBooks displays a submenu of inventory
reports. The submenu provides reports that give inventory valuations, inventory
stock levels, and a worksheet that you can use to physically count the inventory on
store shelves or in the warehouse.
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untant 24.0 - [Edit ltem]

28 3 = °
A ] v B &
Home My Company CashFlow Hub Income Tracker Bil Tracker Calendar Snapshots Customers Vendors Employees Bank Feeds
TYPE ox
Inventory Part . Use for goods you purchase, track as inventory, and resell e
Cancel
New Note
ltern Name/Number Subitem of Manufacturers Part Number
Custom Fields
Blue Mug
Category Spelling
Uncategorized -
g Edit Markup...
UNIT OF MEASURE
um -
PURCHASE INFORMATION SALES INFORMATION

) Description on Sales Transactions
Description on Purchase Transactions P

Blue Coffee Mug
Item is inactive

Cost 6.00 Sales Price 12.00
WMarkup 100.0%
WMargin 50.0%

Income Account  Sales Revenue i

COGS Account Cost of Goods Sold 2 - Tax Code Tax

Preferred Vendor -

INVENTORY INFORMATION
Reorder Point

Asset Account (Min) Max 0On Hand évnesftage onPO. On Sales Order
InventoryAsset 410 6.00 50 0
FIGURE 3-3:
The Edit Item
window.

Book 4, Chapter 2 describes how you produce reports in QuickBooks and how you
customize those reports. If you want to find out more about reports and report

customization, see that chapter.
TIP

Adding Items to the Item List

You can add a bunch of types of items to the Item list. Remember that as noted in
the early paragraphs of this chapter, the Item list stores descriptions of anything
that you stick in an invoice or purchase order.

When you think about this for a minute, you realize that you have different types
of items. If you’re a retailer, for example, the inventory that you sell may appear
in an invoice. If you provide discounts to different sorts of customers, discounts
may appear in an invoice as a line item. If you’re in a state that taxes sales, sales
tax appears as a line item in an invoice.

You describe different items in different ways. You describe an inventory item that

may appear in an invoice differently from the way you describe a sales tax that
you’re required to charge.
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FIGURE 3-4:
The New Item
window.

Given this disparity, I first describe the general process for adding an item to the
Item list. After you know the big-picture stuff, I talk about the items that appear
in the Item list individually. Sound okay? I'll get started.

Adding an item: Basic steps

To add an item to your Item list, follow these steps:

1 . Choose the Lists = Item List command.

QuickBooks displays the Item List window (an example of which appears in
Figure 3-2, earlier in this chapter).

2. To display the Item menu, click the Item button, which appears in the
bottom-left corner of the Item List window.

QuickBooks displays the Item menu.
3. Choose the New command.

This command tells QuickBooks to display the New Item window, as shown in
Figure 3-4.

Pine Lake Porcelain LLC - Intuit Quic

U
a 2 G ® y €
Home My Company Cash Flow Hub Income Tracker Bil Tracker Calendar Snapshols Customers Vendors Employees —Bank Feeds
TYPE IOI(
Senice . Use for senices you charge for or purchase, like ———
spedialized labor, consulling hours, or professional e
fees
Next
Item Name/Number Subitem of
Notes
Category Custom Fields
Uncategorized - Spelling
UNIT OF MEASURE
um >
This senvice is used in assemblies or is performed by a subcontractor or partner
Description Rate 0.00 Item is inactive

Tax Code  Tax he

Account -

Haow can | set rates by customers or employees?

Si Qb Pine Lake Porcelain...
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4. Use the boxes in the New Item window to describe the item that you
want to add.

Your first step is to identify the type of item that you want to add. Based on the
type of item, QuickBooks supplies other boxes that you use to describe the
item. (I go into more detail about this in the following paragraphs, so don't get
freaked out — yet.)

5. Save the item.

After you use the boxes in the New Item window to describe the item that you
want to add, click OK. QuickBooks adds the item that you just described in the
Item list.

The step-by-step approach described in the preceding paragraphs is the conven-
tional way to add an item, but you can also add items on the fly. If you’re using the
Create Invoices window or the Create Purchase Orders window, you can open the
Item drop-down list and choose Add New Entry. When you do this, QuickBooks
displays the New Item window (refer to Figure 3-4). Then you use the New Item
window to add the item in the manner discussed here.

Adding a service item

You use service items to purchase or bill for items that represent service. Take my
example. I'm a CPA in Redmond, Washington. One of the things that I do is pre-
pare tax returns for individuals and businesses. When I bill a client for preparing
their tax return, the line item that appears in the invoice for Tax Return Prepara-
tion is a service item.

In your business, you probably have service items, too. A health-care provider,
such as a dentist or doctor, provides treatment or performs procedures. Dentists
might fill cavities. Doctors might perform physicals or give vaccinations. These
activities represent services.

Even retailers and contractors — businesses that you typically think of as selling
tangible physical goods — often sell services. A retailer may gift-wrap a purchase,
which is a service. A contractor may provide services such as painting and cleanup.

To add a service item, display the New Item window (refer to Figure 3-4, earlier in
this chapter) and choose Service from the Type drop-down list. In the Item Name/
Number box, give the service a brief code or name. If the service is a subitem,
select the Subitem Of checkbox and identify the parent item.

Select the checkbox titled This Service Is Used in Assemblies or Is Performed by
a Subcontractor or Partner if the service is provided by (as the window suggests)
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FIGURE 3-5:
The Inventory
Part version of
the New Item
window.

a subcontractor, owner, or partner. You indicate which services are performed by
subcontractors, owners, and partners because these parties are subject to differ-
ent tax accounting rules.

Next, use the Description box to describe the service. Your description appears in
invoices and purchase orders, so you want to be thoughtful here. Use the Rate box
to describe the price or rate per unit of service. Use the Tax Code drop-down list to
indicate whether the service is taxable. Finally, use the Account drop-down list to
identify which income account should be credited when the item is sold to some
customer, client, or patient.

Adding an inventory part

Inventory parts are those items in invoices and purchase orders that represent
physical goods that you buy, hold, and sell. If you’re a retailer, all that stuff that’s
sitting out on the shelves of your store represents inventory. If you’re a manu-
facturer, the raw materials that you buy and then use to assemble your products
represent inventory.

To set up an inventory part, display the New Item window and choose Inventory
Part from the Type drop-down list. QuickBooks displays the Inventory Part version
of the New Item window, as shown in Figure 3-5.

Pine Lake Porcelain LLC - Intuit Quic nterprise Solutions: Accountant 24.0 - [New ftem]

= File Edit View Lists Favorites Accountant Company Customers Vendgrs Employees Banking Reports Window Help

¢ o W H n

Home My Company Cash Flow Hub Income Tracker Bil Tracker Calendar = Snapshots Customers Vendors Employees BankFeeds
TYPE oK
Inventory Part _ Use for goods you purchase, track as inventory, and resell |
Cancel
Next
Item Name/Number Subitem of Manufacturers Part Number
Notes
Category Custom Fields

Uncat d e
ncategorize Spelling

UNIT OF MEASURE
Edit Markup...
um -

PURCHASE INFORMATION SALES INFORMATION

Description on Sales Transactions
Description on Purchase Transactions P

Item is inactive

Cost 0.00 Sales Price 0.00
COGSA " Tax Cod Markup 100.0%

CCoun Cost of Goods Sold 2 - 3 Code Tax T Margin 100.0%
Preferred vendar ~ Income Account -
INVENTORY INFORMATION

Reorder Point

AssetAccount (Min) Wax On Hand Total Value As of
Inventory Asset = 0.00 0.00 01/01/2024 &
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WARNING

Use the Item Name/Number box to provide a descriptive but brief code or name
for the item. If the item is a subitem of some other parent item, select the Subitem
Of checkbox and then identify the parent item by using the Subitem Of text box.

The Purchase Information and Sales Information sections let you determine the
information that appears in purchase orders and invoices. The Description on
Purchase Transactions box in the Purchase Information section, for example, lets
you provide the text that QuickBooks displays in purchase orders. You can also
guess at the purchase cost by using the Cost text box. Specify the cost of goods
sold (COGS) account that should be debited when this item is sold by choosing
it from the COGS Account drop-down list, and identify the preferred vendor for
purchases of this item by choosing that vendor from the Preferred Vendor drop-
down list.

The Sales Information section provides the information that QuickBooks needs
to correctly include the item in an invoice. The Description on Sales Transactions
box provides a space that you can use to supply the description QuickBooks should
use for this item on your invoice. The Sales Price box enables you to provide your
price for the item. If you’re subject to sales tax, you see (and should use!) the Tax
Code drop-down list to specify whether the item is taxable or nontaxable for sales
tax purposes. Finally, the Income Account drop-down list lets you specify which
income account should be credited when this item is sold.

If you’re confused about seeing three Account drop-down lists in the Inventory
Part version of the New Item window, keep in mind that when you sell an item,
you track the income by crediting an income account and the cost of goods sold by
debiting the COGS account.

Use the Inventory Information section to describe how QuickBooks should handle
inventory tracking for the item. Use the Asset Account drop-down list, for exam-
ple, to specify which account QuickBooks should use to track the dollar invest-
ment in this item. (Typically, you use the Inventory Asset account, but you could
conceivably use some other asset account.) Use the Reorder Point boxes to identify
the inventory stocking level at which you want QuickBooks to alert you to reorder
the item. If you have inventory on hand for this item, enter the quantity that you
have on hand and the value that you have on hand in the On Hand and Total Value
boxes. You also specify the date as of which your quantity and value information
is correct by using the As Of box.

You really shouldn’t be entering inventory balances for an inventory item when
you set it up in the Item list. You should be entering or changing inventory quanti-
ties and values when you purchase the inventory (recorded in the Create Purchase
Orders window or the Write Checks window) and when you sell the inventory
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(typically recorded in the Create Invoices window or the Sales Receipts window).
If you enter a quantity other than zero or a total value other than zero in the New
Item window, you also need to make a journal entry to record the other half of
the transaction. If this “other half” business sounds complicated, just trust me:
You shouldn’t be entering quantity or value information in this window. If you do
understand this “other half” business that I’m referring to, you should know bet-
ter than to enter quantity or value information in the New Item window!

You can click the Spelling button to check the spelling of words and phrases that
you’ve entered in the New Item window. You can also click the Next button to
save the information that you’ve entered for an item and redisplay the New Item
window so that you can add another item.

Adding a noninventory part

To add a noninventory part — which is a tangible good that you sell but for
which you don’t track inventory — display the New Item window and choose
Non-Inventory Part from the Type drop-down list. When QuickBooks displays
the Non-Inventory Part version of the New Item window (see Figure 3-6), give
the noninventory part a name or code by using the Item Name/Number box. If
the new item is a subitem, select the Subitem Of checkbox and then identify the
parent item by using the Subitem Of text box. Use the Description box to provide
the description that should go in invoices that bill for this noninventory part.
Obviously, you enter the price in the Price box. Use the Tax Code drop-down list
to identify whether the item is subject to sales tax. Finally, use the Account drop-
down list to identify the income account that should be credited for sales of this
noninventory part.

Note the checkbox labeled This Item Is Used in Assemblies or Is Purchased for a
Specific Customer:Job. If you select that checkbox, QuickBooks displays a slightly
different version of the Non-Inventory Part window, as shown in Figure 3-7. This
version of the window includes Purchase Information and Sales Information sec-
tions that work the same way as the Purchase Information and Sales Information
sections supplied by the regular Inventory Part version of the New Item window.
(Refer to the section, “Adding an inventory part,” earlier in the chapter.)

Adding an other-charge item

An other-charge item is an item that you use to purchase or bill for things such as
miscellaneous labor or services; materials that you aren’t tracking as inventory;
and special charges, such as for delivery or setup or rush jobs.
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FIGURE 3-6:
The regular
Non-Inventory
Part version of
the New Item
window.

@b Pine Lake Porcelain

NondnventoryPat = | JSe for goods you buy but don'ttrack like office @

supplies, or materials for a specific job that you charge

Cancel
back to the customer.
Next
Item Name/Number Subitem of Manufacturers Part Number
. Notes
Category Custom Fields
Uncategorized -
Spelling
UNIT OF MEASURE e

um -

 This item is used in assemblies or is purchased for a specific customerjob

PURCHASE INFORMATION SALES INFORMATION
ltem is inactive
Description on Purchase Transactions Description on Sales Transactions
Cost 0.00 Sales Price 0.00 Markup 100.0%
ExpenseAccount  CostofGoods Sold2 = TaxCode Tax < Margin 100.0%
Preferred Vendor - Income Account -

FIGURE 3-7:
The kooky
Non-Inventory
Part version of
the New Item
window.
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FIGURE 3-8:

The Other
Charge version
of the New Item
window.

Q

TIP

To set up an other-charge item, display the New Item window and choose Other
Charge from the Type drop-down list. When you do this, QuickBooks displays the
Other Charge version of the New Item window, as shown in Figure 3-8. To finish
setting up your other-charge item, give the charge a name or code or abbreviation
by using the Item Name/Number box. If the other-charge item is a subitem, select
the Subitem Of checkbox and then identify the parent item by using the Subitem
Of text box. Obviously, you use the Description box to provide a description of
the charge. (Remember that this description appears in your invoices.) Use the
Amount or % box to identify how the charge gets calculated or billed. Use the Tax
Code drop-down list to identify the charge as subject to sales tax — or not subject
to sales tax. Use the Account drop-down list to identify the income account that
should be credited when you bill for this other charge.

ain LLC - Intuit Qui s Enterprise Solutions: Accountant 24.0 - [New ltem]

= File Edit View Lists Favorites ompany Customers Vendors Banking Reporis Window Help g DISCOVERY

B @ € 4 T B 0

y CashFlow Hub Income Tracker Bil Tracker Calendar Snapshots Customers Vendors Employees = BankFeeds  Doc:

TPE ()K
Other Charge . Usefor miscellaneous labor, material, or part T
charges, such as delivery charges, setup fees, and cancel
senice charges.
Next
Item Name/Number Subitem of
Notes
Category Custom Fields
Uncategorized - Spelling
This item is used in assemblies or is a reimbursable charge
Description Amountor % - Tax Code

000 Tax hd
Account

Item is inactive

Si @b Pine Lake Porcelain...

If you select the checkbox titled This Item Is Used in Assemblies or Is a
Reimbursable Charge, QuickBooks adds a second set of boxes to the New Item
window. One set of boxes, labeled Purchase Information, provides information
that goes in purchase orders or is used to record purchases and purchase orders.
The other set of boxes, labeled Sales Information, goes in invoices and sales
receipts to record the actual sale or billing for the other charge.
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TIP

FIGURE 3-9:

The Subtotal ver-
sion of the New
Item window.

220 BOOK3

If you want to enter another charge that should be calculated as a percentage, you
must enter the % symbol in the Amount or % box. To include an other-charge
item in invoices that equals 25 percent of the previous item in the invoice, for
example, enter 25% in the Amount or % box.

Adding a subtotal item

If your purchase order, sales receipt, or invoice includes a subtotal line item, you
create a subtotal item in your Item list. To do this, display the New Item window
and choose Subtotal from the drop-down list. Next, give the subtotal item a name
or abbreviation and use the Description box to describe the subtotal. Figure 3-9
shows the Subtotal version of the New Item window.

Pine Lake Porcelain LLC - Intuit Quickd

= File Edit View Lists Favorites Company Customers Ve Reports Window Help

2 B v L ¢

Home My Company CashFlow Hub Income Tracker Bill Tracker Calendar = Snapshots Customers Vendors Employees —Bank Feeds

TYPE o
Use tototal all tems above it on a form, up to the last e

Subtotal -
subtotal. Useful for applying a percentage discount or
surcharge to many items

Cancel

MNext
Item Name/Number
Notes

Spelli
Description AL

Item is inactive

Columnstototal  Learn more
/i nane
~ | Amount

Quantity

Price

Cost

If you're using other-charge items that are calculated as a percentage or
discount items that are calculated as a percentage, you almost certainly need a
subtotal item. Another charge that’s calculated as a percentage typically would
be calculated as a percentage of a subtotal item. Similarly, a discount item that’s
calculated as a percentage is calculated as a percentage of a subtotal item.
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TIP

Adding a group item

A group item makes it easier to invoice customers when, from the customer’s per-
spective, they’re buying a single item, but from your perspective, you’re actually
selling several items. This definition sounds curious at first, but let me give you a
quick example. Suppose that you’re a florist who does booming business on Val-
entine’s Day. Your bestselling items may be red roses and pretty crystal vases. But
you probably don’t sell individual roses and individual vases. You actually sell a
dozen roses with a single vase. Although you want to individually track purchases
of dozens of red roses and individual crystal vases in your purchase orders, in
your invoices to customers, you want to bill for a dozen red roses in a crystal vase.

At the end of the chapter, I describe another item type: inventory assembly, which
works similarly to the group item type. The inventory assembly item type is for
manufacturers.

If that example doesn’t make sense, imagine a more complex floral arrangement
including a dozen red roses, a crystal vase, baby’s breath, flower preservative,
tissue-paper wrapping, ribbon, a box, and so forth. In this case, do you really
want an invoice that shows perhaps 20 items? Or do you want an invoice that
shows a single item: a dozen red roses in a crystal vase? This scenario is why
you create group items. A group item lets you create a single item that you use in
invoices, but this group item actually combines a bunch of individual items that
you’re probably using in your purchase orders.

To create a group item, display the New Item window and choose Group from
the Type drop-down list. When QuickBooks displays the Group version of the
New Item window (see Figure 3-10), use the Group Name/Number box to give
the group item a name or code. Use the Description box to give the group item an
appropriate description. Use the Item, Description, Qty (Quantity), and U/M (Unit
of Measurement) columns at the bottom of the window to identify the individual
items and item quantities that combine to make a group.

Adding a discount item

A discount item subtracts a fixed amount or a percentage from a subtotal. To set up
a discount item, display the New Item window and choose the Discount entry from
the Type drop-down list. When you do, QuickBooks displays the Discount version
of the New Item window, as shown in Figure 3-11.
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FIGURE 3-10:
The Group
version of
the New Item
window.

FIGURE 3-11:
The Discount
version of
the New Item
window.

lain LLC - Intuit Q

dar | Snapshots
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invoice. Ty
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Next
Group Name/Number
Notes

Custom Fields
Description

Spelling
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Print ftems in group

-
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| Useto subtracta percentage or fixed amourt from a

Discount
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Cancel
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Next
Item Name/Number Supitem of
- Notes
Custom Fields
Description Amaunt or %
0.00 Spelling
Account
- Item is inactive
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TIP

To set up your discount item, enter a name or abbreviation for the discount in the
Item Name/Number box. If the discount item is a subitem, select the Subitem Of
checkbox and then identify the parent item by using the Subitem Of text box. Typ-
ically, you describe the discount by using the Description box. Enter the amount
of the discount in the Amount or % box as a dollar amount or as a percentage. (If
you enter the discount as a percentage, be sure to include the percentage symbol.)
Use the Account drop-down list to specify which account gets debited for the dis-
count. Finally, use the Tax Code drop-down list to indicate whether the discount is
applied before sales tax. (In other words, indicate whether the discount is subject
to sales tax.)

If you set up a discount item that calculates the discount as a percentage, you
probably need a subtotal item, too. Then, in your invoices, follow the subtotal
item with the discount item. In this manner, you can easily calculate the discount
percentage by looking at the subtotal amount.

Adding a payment item

If you sometimes accept payments at or before the point you invoice a customer,
you can create a payment item and then add the payment item to the bottom of
the invoice. If you do this, the invoice, the payment amount, and the net amount
due all appear in the same document. That’s pretty cool.

To set up a payment item, display the New Item window and choose Payment
from the drop-down list. QuickBooks displays the Payment version of the New
Item window, shown in Figure 3-12. Use the Item Name/Number box to give the
payment item a code or name such as “payment.” Use the Description box to pro-
vide a nice description of the payment. (No kidding, you may want to include the
phrase Thank you! as part of the payment description, such as Payment .. . Thank
you!) Use the Payment Method drop-down list to identify the method of payment:
American Express, check, cash, Discover, MasterCard, or Visa, as appropriate.
Finally, use the radio buttons — Group with Other Undeposited Funds and Deposit
To — to identify what happens to the money received as part of the payment. If
you indicate that the money is deposited, you also choose the correct bank account
from the Deposit To drop-down list.

Adding a sales tax item

If you sell items that are subject to sales tax, you also include line items in your
invoices that charge for and track these sales taxes. To do this, you create sales tax
items. To create a sales tax item, display the New Item window and choose Sales
Tax Item from the Type drop-down list. When you do this, QuickBooks displays
the Sales Tax Item version of the New Item window, as shown in Figure 3-13.
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FIGURE 3-12:

The Payment

version of

the New Item

224,

window.

Use the Sales Tax Name box to identify or provide an abbreviation for the sales
tax. Use the Description box to give the sales tax a description. Finally, use the Tax
Rate (%) box to identify the sales tax rate and the Tax Agency (Vendor That You
Collect For) drop-down list to identify the tax agency that you’ll pay.
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Cancel
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Spelling
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Setting up a sales tax group

In many jurisdictions, although businesses may charge a single sales tax on sales,
the sales tax is distributed to several tax agencies. A firm may be required to
charge a 9 percent sales tax, for example, but perhaps 1 percent goes to the city
government, another 2 percent goes to the county government, and the remain-
ing 6 percent goes to the state government. In this case, you can set up a sales tax
group, which appears as a single line item invoice. The sales tax group is made up
of individual tax items, however.

To add a sales tax group, display the New Item window and choose Sales Tax Group
from the Type drop-down list. QuickBooks displays the Sales Tax Group version of
the New Item window, as shown in Figure 3-14. Enter a name or an abbreviation for
the sales tax in the Group Name/Number box. Provide an appropriate description
in the Description box. Then use the Tax Item column to identify the individual tax
items that comprise the sales tax group. Note that you should already have set up
the tax items that you want to add to the sales tax group.
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FIGURE 3-13:
The Sales Tax
Item version of
the New Item
window.

FIGURE 3-14:
The Sales Tax
Group version
of the New Item
window.
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FIGURE 3-15:

The Set Up
Custom Fields for
Iltems dialog box.

Adding custom fields to items

If you’ve worked much with the New Item window, or if you’ve paid particularly
close attention to the figures shown in the last few pages of this chapter, you may
have noticed the Custom Fields command button that appears in many, although
not all, of the New Item windows (refer to Figure 3-12).

The Custom Fields button enables you to add your own custom fields to the
Item list. To add a custom field, click the OK button. When you do, QuickBooks
displays a message box and then a small dialog box labeled Custom Fields for
Unnamed Item.

When QuickBooks displays the Custom Fields for Unnamed Item dialog box, click
the Define Fields button. QuickBooks displays the Set Up Custom Fields for Items
dialog box, as shown in Figure 3-15. To add custom fields for the item, use the
Label column to name the fields and then check the Use column for each field you
want to appear. If you want to add a custom field Serial Number for a product you
sell or hold in inventory, for example, enter the label Serial Number in the first
row of the Label column and check the Use column.
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FIGURE 3-16:
The Custom
Fields for Red
Mug dialog box.

Note: If you’re working with the Enterprise Solutions version of QuickBooks,
QuickBooks provides a What Kind of Data? column that you can use to specify the
type of information that can be entered in the new custom field: text, numbers,
and so on. Use the Required on Trans and Required on List columns to tell Quick-
Books that you want to specify the items for which the custom field is required.
When you select either Required column, QuickBooks displays another dialog box
that lets you select the types of items that need the custom field.

When you click OK, QuickBooks redisplays the Custom Fields for Item dialog box;

in the example shown in Figure 3-16, the item is a red mug. Now the dialog box
shows the new custom field — in this example, Serial Number.

Pine Lake Porcelain LLC - Intuit Qui

Banking Reports Window Help
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Help
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Note that custom fields are available for all items. Also note that you see custom
fields for items by displaying the item’s information in the New Item window or
the Edit Item window and then clicking the Custom Fields button.

Editing Items

You can change item information. To do so, display the Item List window and
then double-click the item. When you do this, QuickBooks displays the Edit Item

CHAPTER 3 Tracking Inventory and Items 227

Swi9}| pue

Kiojuanuj Suppoeay



228

window, which resembles the New Item window. The difference is that the Edit
Item window is already filled in with the item information. To change some bit
of item information, edit the contents of the field with the information to be
updated. Click OK to save your changes.

Adjusting physical counts and
inventory values

Inventory shrinkage, spoilage, and (unfortunately) theft all combine to reduce
the inventory that you physically have. To record these inventory reductions, you
periodically count your inventory physically and then update your QuickBooks
records with the results of your physical counts.

I don’t spend any time in this book talking about approaches to providing physi-
cal counts; you probably have better ideas than I do about how to do that. You
presumably know what works best in your business. I can tell you, however, that
to record your physical count information in QuickBooks, you use a special tool.
Specifically, you use the Adjust Quantity/Value on Hand command.

This command is available to you in two places. If you display the Item list, click
the Activities button (which appears at the bottom of the Item List window) and
choose the Adjust Quantity/Value on Hand command. You can also choose the
Inventory = Adjust Quantity/Value on Hand command. (The Inventory menu item
was added to the 2018 version of QuickBooks, so it’s more convenient than in pre-
vious versions.) Choosing either command displays the Adjust Quantity/Value on
Hand window, shown in Figure 3-17.

To use the Adjust Quantity/Value on Hand window, follow these steps:
1. usethe Adjustment Type drop-down list to indicate what you're
adjusting.

You can adjust the quantity or the value, or both the quantity and the value of
the items you're holding in inventory. Just choose the appropriate entry from
the Adjustment Type drop-down list: Quantity, Total Value, or Quantity and
Total Value.

2. Usethe Adjustment Date box to record the date of your physical count.

In other words, you want to adjust your quantities as of the day you took or
completed the physical inventory count.

3. Usethe Adjustment Account drop-down list to identify the expense
account that you want to use to track your inventory shrinkage expense.
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FIGURE 3-17:

The Adjust
Quantity/Value
on Hand window.

TIP

@ Previous B Next | d Attach

Adjustment Type Quantity s

Adjustment Date 04/05/2024 [ Reference Mo. 1
Adjustment Account - Customer:Job -
Class -
Christian Block (christian@nelson.cpa) is signed in
Find & Select items... Set Qty to Zero

Blue Mug Blue Coffee Mug. 410

Red Box 485

Rainbow Mug Rainbow Coffee Mug 58

Red Paper 1,000

mpany Cash Flow Hub Income Tracker Bil Tracker Calendar = Snapshots Customers Vendors Employees = Bank Feeds

Memo

Valug

ITEM INFO AFTER ADJUSTMENT

Quantity on Hand
Avg Cost per ltem

Total Value of Adjustment 0.00

MNumber of ltem Adjustments 0

Save & Close Save & New Clear

4.

5.

(Optional) Provide a reference number (if you use numbers) to uniquely
and meaningfully identify or cross-reference the transaction.

(Optional) Identify the Customer:job and class.

If it's appropriate (in many cases, it won't be), use the Customer:Job drop-down
list to identify the customer and job associated with this inventory shrinkage. In
a similar fashion, if appropriate, use the Class drop-down list to identify the
class that you want to use for tracking this inventory shrinkage.

Supply the correct inventory quantities.

The Item, Description, and Qty on Hand columns of the Adjust Quantity/Value
on Hand window identify the inventory items that you're holding and the
current quantity counts. Use the New Quantity column to provide the correct
physical count quantity of the item. After you've entered the new quantity,
QuickBooks calculates the quantity difference and shows this value in the Qty
Difference column.

You can actually enter a value in the New Quantity column or the Qty
Difference column. QuickBooks calculates the other quantity by using the
current quantity information that you supply. If you enter the new quantity,
QuickBooks calculates the quantity difference by subtracting the new quantity
from the current quantity. If you enter the quantity difference, QuickBooks
calculates the new quantity by adjusting the current quantity for the quantity
difference.
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7. Adjust the value.

If you chose Total Value or Quantity and Total Value from the Adjustment Type
drop-down list in Step 1, QuickBooks displays an expanded version of the
Adjust Quantity/Value on Hand window, as shown in Figure 3-18. This window
lets you enter both the correct physical count quantity and the updated value
for the inventory item. You enter the physical count quantity, obviously, in the
New Quantity column. You enter the new updated value in the New Value
column. You probably use this version of the Adjust Quantity/Value on Hand
window only if you're using a lower-of-cost or market inventory valuation
method. Both financial accounting standards and tax accounting rules allow
you to mark down your inventory to the lower of its original cost or its fair
market value. If you're doing this — and how you do this is beyond the scope
of this book — you enter the new inventory value in the New Value column.

Essentially, using the lower-of-cost or market inventory evaluation method just

?&3 means that you do what it says: You keep your inventory valued at its original
cost or, if its value is less than its original cost, at its new value. Obviously,
TECHNICAL assessing the value of your inventory is a little tricky. But if you have questions,
STUFF

you can ask your CPA for help. One thing to keep in mind, however, is that you
can't go changing your accounting methods willy-nilly without permission from
the Internal Revenue Service. And changing your inventory valuation method
from cost, say, to lower-of-cost or market is a change in accounting method.
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8. Provide amemo description.

If you want to further describe the quantity or value adjustment, use the Memo
box for this purpose. You may want to reference the physical count work-
sheets, the people performing the physical count, or the documentation that
explains the valuation adjustment.

9. savethe adjustment.

After you've used the Adjust Quantity/Value on Hand window to describe the
quantity changes or value changes in your inventory, click either the Save &
Close button or the Save & New button to save the adjustment transaction. As
you probably know at this point in your life, Save & Close saves the transaction
and closes the window. Save & New saves the transaction but leaves the
window open in case you want to make additional changes.

Adjusting prices and price levels

QuickBooks provides a couple of handy commands and tools that you can use to
change the prices that you charge customers for your products and services. In the
following sections, I describe both of these handy aids.

Using the Change Item Prices command

The Change Item Prices command, which appears on the Customers menu, dis-
plays the Change Item Prices window, shown in Figure 3-19. This window lets
you change prices of a bunch of items at one time by an amount or percentage.
To use the Change Item Prices window, first select the items whose prices you
want to change by clicking the check mark column. Next, use the Adjust Price of
Marked Items by (Amount or %) box to specify the dollar amount or the percent-
age amount by which you want to change the price. If you want to change the price
of selected items by $2, for example, enter $2 in the box. If you want to change the
price of selected items by 5 percent, enter 5% in the box. Use the Based On drop-
down list to indicate the base to which you want to add the amount of percentage.
After you identify the items that you want to reprice and the way that you want to
reprice them, click the Adjust button. QuickBooks recalculates the prices and dis-
plays this information in the New Price column. If you want to change the prices
for the items selected, click OK.

If you don'’t like the prices listed in the New Price column, you can keep tinkering
with the value in the Adjust Price of Marked Items by (Amount or %) box, clicking
the Adjust button to refresh the numbers in the New Price column, and clicking
OK only when you’re satisfied.
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FIGURE 3-19:
The Change Item
Prices window.

Pine Lake Porcelain LLC - Intuit QuickBaoks Enterprise Solutions- Accountant 24.0 - [Change ltem Prices]

= File Edit View Lists Favorites Accountant Company Customers Vendors Employees Banking Reports Window Help

A 2 g ® & W € 4 W B 0

Home My Company Cash Flow Hub Income Tracker Bil Tracker Calendar = Snapshots Customers Vendors Employees —Bank Feeds

Item Type
Inventory Part -

J HITEM DESCRIFTIO
Blue Mug Blue Coffee Mug. 12.00

Gut Buster Chili Dog 6.00
Rainbow Mug Rainbow Coffee Mug 12.00
Red Box 750
Red Mug Red Coffee Mug 16.00
Red Paper 1.00
Stainless Mug 20.00
Valentines Box 5.00
Yellow Mug Yellow Coffee Mug 10.00

MarkAll Include inactive

0K Cancel Help

Using price levels

Price levels are kind of weird; they let you individually adjust the prices of items
up or down. If you’ve agreed to discount items by 10 percent for a certain cus-
tomer, for example, you can easily do this by using a price level to knock the price
down by 10 percent whenever you’re invoicing that customer.

To use price levels, you first have to set up the price levels by using the Price Level
List command. After you set up your price levels, you adjust prices by using price
levels when you create an invoice. I describe how both tasks work.

Creating a price level

To create a price level, choose the Lists = Price Level List command. When you do,
QuickBooks displays the Price Level List window (not shown). To create a price
level, click the Price Level button and then choose Price Level &> New. QuickBooks
displays the New Price Level window, as shown in Figure 3-20. Name the price
level change by using the Price Level Name box. Select the items to which you
want to apply the price level by clicking them. (QuickBooks marks selected items
with a check mark.) Then use the Adjust Price of Marked Items to Be boxes to
indicate that this price level increases or decreases the sales price some per-
centage higher or lower than the standard price. Finally, use the Round Up to
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FIGURE 3-20:
The New Price
Level window.

TIP

Nearest drop-down list to specify whether and how QuickBooks should round
off its calculations. Figure 3-20, for example, shows a price level change that
decreases the sales price by 10 percent. After you select the items that the price
level should affect, click the Adjust button to see the new price for each item in
the custom price column.
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Using a price level

To use a price level, you create an invoice in the usual way. Click the Price Each
column for the item that you want to reprice by using the price level. When you
do this, QuickBooks turns the Price Each column into a drop-down list. If you
click the arrow button that opens the drop-down list, QuickBooks displays both
the base rate price and any price levels. If you choose a price level, QuickBooks
adjusts the price for the price level change. In Figure 3-21, selecting the 10 percent
price level change bumps the price from $6.00 to $5.40. In other words, the 10%
Decrease price level change decreases the default price by 10 percent, or 60 cents.

QuickBooks also lets you set a default price level for a customer. When such a
default price level is set, QuickBooks automatically uses the appropriate price level
when you choose that customer. The Price Level box appears on the Additional
Info tabs of the New Customer and Edit Customer windows.
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FIGURE 3-21:
Choosing a price
level with the
Create Invoices
window.
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Enabling advanced pricing

Users of QuickBooks Enterprise 2024 should know one more thing about setting
prices. QuickBooks also provides an advanced pricing function, which you turn
on by choosing the Edit = Preferences command, selecting the Sales & Custom-
ers option, clicking the Company Preferences tab, and then clicking the Enable
Advanced Pricing button.

When you enable advanced pricing, you convert any price levels you’ve previously
defined (see the preceding paragraphs) to price rules that you can tell QuickBooks
to apply to items, item types, particular vendors, customers, customer types, and
job types.

After you turn on advanced pricing, you can choose the Lists = Price Rule List
command to display the Price Rule List window (not shown). To convert a price
level to a working price rule, double-click the new price rule and then use the Edit
Price Rule dialog box (not shown) to describe the rules QuickBooks should follow
to reprice some item automatically.
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Managing Inventory in a
Manufacturing Firm

Tracking inventory in a manufacturing firm is more difficult than in other types
of businesses. When you boil down everything to its essence, the problem stems
from a couple of tricky accounting requirements:

3 In a manufacturing environment, the manufacturer combines raw
materials items into finished-goods items. This means — and this is the
challenging part — that the manufacturing process reduces the inventory count
and value for some items (the raw materials or the components) and at the
same time increases the count and value of the other, finished-goods items.

3 In a manufacturing environment, the rules say that you don’t count just
the value of items in the finished-goods-item inventory values. You also
count the cost of labor and factory overhead used in manufacturing the items.

QuickBooks solves the first problem related to manufacturing inventory, but it
doesn’t solve or address the second problem. Fortunately, as long as you’re a
small manufacturer, you probably don’t need to worry too much about the second
problem. You should ask your CPA about it. But don’t worry — Congress and the
IRS have provided a bunch of loopholes that make the accounting easier for the
small guys.

Handling manufactured inventory
the simple way

If you’re using QuickBooks Pro or some earlier versions of QuickBooks Premier,
you don’t have the ability to account for the manufacture of inventory in Quick-
Books. The best you can do is group items to combine into individual items in a
customer’s invoice. This approach sounds sloppy, but it isn’t quite as bad as you
may think at first blush. You can choose to show only the group item in a customer
invoice. This means — getting back to the example of the florist selling red roses
and vases — that the florist can “manufacture” a crystal vase of a dozen red roses
and then show the manufactured item as a group item in the customer’s invoice.

The one thing that’s problematic about the “just use a group item” approach is
that it doesn’t give you a way to track the finished goods’ inventory values.
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Performing inventory accounting
in QuickBooks

To account for the manufacture of inventory in QuickBooks Premier or
QuickBooks Enterprise Solutions, you add inventory assembly items to the Item
list for those items that you manufacture. You also record the manufacture of
items as you . . . well, manufacture them.

Suppose that Pine Lake Porcelain mostly buys and resells coffee mugs and other
porcelain doodads. But also suppose that once a year, Pine Lake Porcelain assem-
bles a collection of red coffee mugs into a boxed St. Valentine’s Day gift set. In this
case, QuickBooks can record the assembly of a boxed gift set that combines, for
example, four red coffee mugs, a cardboard box, and some tissue-paper wrapping.

Adding inventory assembly items

To describe manufactured items, follow these steps:

1. choose Lists > Item List.
QuickBooks displays the Item List window.

2. Click the Item button in the Item List window and choose New from the
drop-down list.

QuickBooks displays the New Item window.
3. Choose the Inventory Assembly item from the Type drop-down list.

QuickBooks displays the Inventory Assembly version of the New Item window,
as shown in Figure 3-22.

4, Specify the account to use for tracking this item’s cost when you sell it.

QuickBooks suggests the cost of goods sold account. If you've created other
accounts for your COGS, however, choose the other appropriate account.

5. Describe the manufactured item.

Type a description of the item that you want to appear in documents that your
customers see, such as invoices. (QuickBooks suggests the same description
that you used in the Description on Purchase Transactions text box as a default.)

6. Enter the amount that you charge for the item in the Sales Price box.

7. Indicate whether the manufactured item is subject to sales tax by using
the Tax Code drop-down list.

8. Use the Income Account drop-down list to specify the account that you
want QuickBooks to use for tracking the income from the sale of the item.
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FIGURE 3-22:

The Inventory
Assembly version
of the New Item
window.
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0. Identify the components that go into the finished item.

Use the Bill of Materials list to identify the individual component items and the
quantities needed to make the inventory assembly. Each component item goes
on a separate line in the list. Not to be too redundant, but do note that you
identify both the component item and the number of component items needed.

10. Identify the asset account.

Specify the other current asset account that you want QuickBooks to use for
tracking this inventory item'’s value.

11. select a build point.

Use the Build Point boxes to specify the lowest inventory quantity of this item
that can remain before you manufacture more. When the inventory level drops
to this quantity, QuickBooks adds a reminder to the Reminders list, notifying
you that you need to make more of the item.

12. Ignore the On Hand and the Total Value boxes.

See that On Hand box? Leave it set to zero. To enter a number now is to record
an uncategorized transaction, which you don’t want to do. Leave the Total
Value field set to zero, too.

13. Leave the As Of box empty or enter the current date.

What you do here doesn't matter.
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Recording manufacture or assembly of items

To build some assembly, choose the Retail = Inventory Activities = Build Assem-
blies command. QuickBooks displays the Build Assemblies window, as shown
in Figure 3-23. All you do is choose the thing that you want to build from the
Assembly Item drop-down list and then enter the quantity that you (or some hap-
less co-worker) built in the Quantity to Build box in the bottom-right corner. (In
Figure 3-23, I've created an assembly — Valentine’s Day Box — that consists of
some colorful mugs, an attractive gift box, and some scented tissue paper.) Then
you click either the Build & Close or Build & New button. (Click the Build & New
button if you want to record the assembly of some other items.)

Pine Lake Porcelain LLC - Intuit Qui erpris: ons: Accountant 24.0 - [Build Assemblies]
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While I’'m on the subject, let me make a handful of observations about the Build
Assemblies window and the Build Assemblies command:

¥ In the top-right corner of the window, QuickBooks shows the quantity of the
assembly that you have on hand and the number of customers who have
placed orders. That's pretty useful information to have, so remember that
it's there.

¥ Atable in the Build Assemblies window shows you what goes into your
product. Not that you care, but this table is a bill of materials.
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REMEMBER

¥ At the bottom of the bill of materials list, QuickBooks shows you the maxi-
mum number of assemblies that you can make, given your current inventory
holdings.

3 When you build an item, QuickBooks adjusts the inventory item counts. If you
make boxed gift sets — each with four red mugs, one wrapping tissue, and
one box — QuickBooks reduces the item counts of red mugs, wrapping
tissues, and boxes, and increases the item counts of the boxed gift sets when
you record building the assembly.

Some of the components used in an assembly may not be inventory items. You can
use noninventory parts in an assembly.

Managing multiple inventory locations

QuickBooks Enterprise Solutions lets you deal with the record-keeping challenge
of storing inventory in multiple locations. To turn on this capability, called
Advanced Inventory Tracking, choose the Edit @ Preferences command, click
Items and Inventory, click the Company Preferences tab, and then click the
Advanced Inventory Settings button. If you’re using the Enterprise Solutions ver-
sion of QuickBooks, QuickBooks displays dialog boxes that allow you to build a
list of inventory sites and adds fields to appropriate windows and dialog boxes
so that you can track inventory items by site. If you’re not using the Enterprise
Solutions version of QuickBooks, QuickBooks displays information about how you
can upgrade to Enterprise Solutions.
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IN THIS CHAPTER

» Writing and printing checks

» Making deposits and transferring
funds

» Using the register
» Working with the Edit menu
» Reconciling your accounts

» Using the other QuickBooks banking
tools

Chapter 4

Managing Cash and
Bank Accounts

uickBooks provides several tools that make working with your bank

accounts easier, such as a special window for recording the checks you’ve

written. QuickBooks also lets you easily record deposits into accounts.
Additionally, QuickBooks includes tools for easily recording transfers between
accounts, for reconciling bank accounts, and for performing online banking
transactions. This chapter talks about all these features.

If you’ve used QuickBooks’s little-brother product, Quicken, much of the infor-
mation that you see here will be familiar. The QuickBooks banking tools look like
the popular Quicken checkbook program — good news for the 10 million or so

TP Quicken users.
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Writing Checks

Obviously, any business writes checks to pay bills and to pay employees. Quick-

Books includes a command and a window specifically for the purpose of recording
and possibly printing checks.

Recording and printing a check

To record or print checks, choose the Banking = Write Checks command.
QuickBooks displays the Write Checks window, as shown in Figure 4-1.

= File Edit View Lists Favorites
P~ 9!
(1) 1
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B v B B ¢ a

- & H o

Home My Company CashFlow Hub Income Tracker Bl Tracker Calendar

Snapshots Customers Vendors Employees  Bank Feeds
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e» B B &8 Qomeecn FZ Demuaer E @ g =
Find New Save Delele & Memorize Prnt [ |PayOnine  Aftach  Select Clear Recalculate Baich Reorder Intercompan *
- - File PO Spiits Transactions =~ Reminder ~ OTdeT Transaction
Checks
ccount | Big National Bank -

enping eaLnce  264,438.96

No. |2

DATE | 04/21i2024
FAY TOTHE ORDER OF |

-] 3 0.00

Expenses $0.00 | ltems 50.00

FIGURE 4-1:
The Write Checks
window.

Save & Close Save & New Clear

Take the following steps to write a check:

1.

Use the Bank Account drop-down list to choose the account on which to
write a check.

2.

Use the No. (check number) field to identify the check number.

If you don't know the check number yet because you haven't printed the check,

leave the No. field blank. Then select the Print Later checkbox, which appears
on the Main tab of the Write Checks window.
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When you select the Print Later checkbox, QuickBooks displays the phrase
To Print in the No. field.

Use the Date field to record the date when the check was or will be
written.

You can enter the check date in mm/dd/yyyy format. You can also enter dates
as simply mmdd or m/dd, and QuickBooks transforms them to mm/dd/yyyy.
Thus, 8/12, 0812, and 0812/2024 are all valid ways to enter the same date if the
current year is 2024.

Alternatively, you can click the small calendar button that appears to the right
of the Date field. When you click the calendar button, QuickBooks displays a
pop-up calendar. To select a day shown on the calendar, click the day. The
pop-up calendar also includes a pair of buttons that you can click to scroll back
and forth through the months.

Use the Pay to the Order Of field to identify the individual or business
that you're paying with the check.

If the check that you're recording is the first check that you've ever made out to
the payee, you must type the payee’s name in the Pay to the Order Of field. If
you've previously paid the payee, you can click the arrow button at the right end
of the Pay to the Order Of field. When you do this, QuickBooks displays a list of
previous payees. You can choose a payee from this list by clicking the name.

Move the selection cursor to the Dollars (amount) field and type the
check amount.

QuickBooks writes out the check amount on the line below the Pay to the
Order Of field.

(Optional) Provide an address.

If you want, you can use the address block to provide the payee’s address.
Note that QuickBooks writes the payee’s name on the first line of the address
block when you fill in the Pay to the Order Of field. You can add the other lines
to the address block manually. Note, though, that if you've previously entered
an address for a payee (such as when you last recorded a check to the payee),
QuickBooks reuses this address information for subsequent checks.

You can edit the address information shown in the Write Checks window.

You need to record the address only if you're going to print the check and the
address will show through the address window or if you're creating an online
payment — something that | talk about later in this chapter.

(Optional) Provide a memo description.

You can use the Memo field to provide or record additional information. If
you're going to print the check, for example, you can use the Memo field to
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TIP

TIP

identify your account number or the invoice number that the check pays. If
you're simply recording checks and won't be printing them, you can use the
Memo field to record more proprietary or confidential information.

(Optional) Select the Pay Online checkbox.

So, here’s the deal: If you've told your bank that you want to do the online
banking thing and have followed its instructions for setup, you can select the
Pay Online checkbox, which appears after you've set up online banking. This
setting tells QuickBooks to transmit this check information to your bank, along
with instructions to the bank to make the payment.

More information on setting up online banking is available later in this chapter.

To transmit the payment instructions to the bank later, choose Banking =
Bank Feeds => Bank Feeds Center, click Send Items, and enter your personal
identification number (PIN) when QuickBooks asks for it. Note that QuickBooks
doesn't display the Bank Feeds command until you set up an account for
online banking.

Distribute the check amount to the appropriate expense or asset
accounts.

If the check pays for a particular expense or purchases a particular asset, click
the Expenses tab; then use the lines or rows of the Expenses tab to identify the
account and the amount that the check pays. To record a $50 check that pays a
supplies expense, for example, use the Account column of the Expenses tab to
select the office-supplies expense account; then use the Amount column to
identify the amount of the office supplies. Optionally, use the Memo column to
provide a memo description of that line of expense detail. Equally optionally,
use the Customer:Job column and the Class column to further describe and
categorize the line of account detail information. If you categorize the expense
as one incurred for a particular customer or job, you can use the Billable?
column to indicate whether this item should be billed to the customer later
(see Figure 4-2).

If a check pays for several types of expenses, the Expenses tab should show
several lines.

If you write a check to purchase an asset, the Expenses tab doesn't show an
expense account; instead, its tab shows an asset account. If you buy a $5,000
piece of machinery, you may distribute, or categorize, that $5,000 check to an
asset account. In this case, the Account column of the Expenses tab shows the
asset account name and the Amount column shows the amount of the asset
purchased.
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FIGURE 4-2:

The Write Checks
window, filled
out to record an
expense.

TIP

Pine Lake Porcelain LLC - Intuit QuickBooks Enterprise Solutions: Accountant 24 0 - [Write
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10. pescribe the items that the check purchases.

Figure 4-3 shows the Items tab of the Write Checks window. You use the ltems
tab when you write a check to purchase items shown and described in your
Item list. If you write a $1,000 check to buy 400 $2.50 items for inventory, you
use the Items tab. To use the Items tab, identify the item being purchased by
entering the item code or name in the Item column. Optionally, edit the item
description shown in the Description column. Then use the Qty, Cost, and
Amount columns to describe the number of items and the total cost of the
items purchased. As with the Expenses tab, QuickBooks gives you the option of
further classifying an item by using the Customer:Job, Billable?, and Class
columns (if you have class tracking enabled).

Book 3, Chapter 3 describes how items and the Item list work in QuickBooks. If
you're unsure how to work with items, refer to that chapter.

11.70 print a check, click the Print button.

The Print option is on the top menu above the bank account you've selected

to pay from. Alternatively, if you want to print checks in a batch, after you've
recorded the last check that you want to print, click the down arrow below

the Print button. When QuickBooks displays the Print menu, choose its Batch
command. QuickBooks displays the Select Checks to Print dialog box, as shown
in Figure 4-4. Select the checks that you want to print by clicking them. Use the
First Check Number box to identify the number of the first check form to use
for printing. Then click OK.
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FIGURE 4-3:

The Write
Checks window,
displaying the
Items tab.

FIGURE 4-4:
The Select
Checks to Print
dialog box.
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FIGURE 4-5:
The Print Checks
dialog box.

TIP

When QuickBooks displays the Print Checks dialog box, as shown in Figure 4-5,
use the Check Style section to identify the type of check forms on which you're
printing. If you're using standard or wallet-style checks, you also need to
indicate the number of checks. Then click the Print button.

You can also print check forms in a batch by choosing File &> Print Forms &>
Checks. When you choose this command, QuickBooks displays the Select
Checks to Print dialog box. Identify which checks you want to print, click OK,
and use the Print Checks dialog box to finish printing your checks.
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12.

After you describe the check and the reasons for writing the check, click
either the Save & Close or the Save & New button in the Write Checks
window.

The Save & Close button saves the check and also closes the Write Checks
window. Click the Save & New button to save the check and then redisplay the
Write Checks window so that you can record another check. If you don't want
to save the check, click the Clear button.

The Write Checks window provides several buttons on the Main tab, including
Previous, Next, Print, and Find. | describe the Print button in an earlier step,
but let me note here that the Previous and Next buttons page back and forth
to the checks that you've already written. The Find button displays the Find
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FIGURE 4-6:
The Fonts tab of
the Print Checks
dialog box.

Checks dialog box, which you can use to describe a check similar to the one
you're looking for. After you describe the check you're looking for, click the Find
button in the Find Checks dialog box.

Customizing the check form

While I’m on the subject of printing check forms, I’ll quickly make a couple of
observations. If you click the Fonts tab of the Print Checks dialog box, QuickBooks
displays a couple of buttons you can click to specify what fonts QuickBooks should
use for printing check forms (see Figure 4-6).

If you click the Font button, for example, QuickBooks displays the Select Font
dialog box, shown in Figure 4-7. You select the font you want in the Font list box,
any special type style (such as bold or italic) in the Font Style list box, and the
point size in the Size list box. You can experiment with font settings and see the
combined effect in the Sample box.

If you click the Partial Page tab, QuickBooks displays the dialog box shown in
Figure 4-8. Use this tab’s buttons to tell QuickBooks how you feed a partial page
of check forms through your printer.
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FIGURE 4-7:
The Select Font
dialog box.

FIGURE 4-8:
The Partial
Page tab of the
Print Checks
dialog box.
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One final tidbit about customizing check forms: If you click the Logo button of the
Print Checks dialog box (refer to Figure 4-8), QuickBooks displays a little dialog
box that lets you tell QuickBooks to print a logo on your checks. To print a logo,
you need an image file for the logo (perhaps something you’ve created in Micro-
soft Paint 3D or another image-editing program). This little dialog box lets you
tell QuickBooks where the logo image file is located.

Making Bank Deposits

FIGURE 4-9:

The Payments

250

to Deposit
dialog box.

QuickBooks also supplies a command and window for recording bank deposits. To
record bank deposits, follow these steps:

1. choose the Banking => Make Deposits command.

QuickBooks displays the Payments to Deposit dialog box, shown in Figure 4-9.
The dialog box shows any payments previously recorded by means of the
Receive Payments and Enter Sales Receipts commands, which appear on the
Customers menu. (Note that QuickBooks goes right to the Make Deposits
window, shown in Figure 4-10, and skips the Payments to Deposit dialog box if
there are no pending deposits to make.)

Pine Lake Porcelain LLC - Intuit Quick

File Edit

SELEGT VIEW
View payment method type | All types What are payment metnod views?

Sort payments by Payment Method

@ Previous
SELECT PAYMENTS TO DEPOSIT

Di it T
Deposit To Ry

Click Payme 05/01/2024 PMT Cash Black Star Coffee 800.00]

To getcash
where you w

Cash back

0 of 1 payments selected for deposit Payments Subtotal 0.00

Select All

a
} Cancel Help ear

Hi g Pine Lake Porcelain
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FIGURE 4-10:
The Make
Deposits window.

in LLC - Intuit Quic

= File Edit View Lists Favorites Accountant Company Customers Vendors Employees Banking Report: dow Help g DIOOVERY
A B »
ST w . 8 T
Home My Company CashFlow Hub Income Tracker Bil Tracker Calendar = Snapshots Customers Vendors Employees BankFeeds = Docs
@ Previous ® Next [ Save ) Print v‘ B2 payments. History [B Journal | i) Attach
DepositTo  Big National Bank ~ | Date |05/012024 B Memo  Deposit
Click Payments to select customer payments that you have received. List any other amounts to deposit below.
300.00
Deposit Subtotal 800.00
To getcash back from this deposit, enter the amount below. Indicate the account
where you want this money to go, such as your Petty Cash account
Cash back goes to Cash back memo Cash back amount
Deposit Total 800.00
DUYYN  save & New Revert

O Ei  Gb PinelakePorcelin

Select the payments you want to deposit.

You can select all the payments listed by clicking the Select All button or select
individual payments by clicking them. QuickBooks marks selected payments
with a check mark.

Click OK.
QuickBooks displays the Make Deposits window, shown in Figure 4-10.

Use the Deposit To drop-down list to identify the bank account into which
you're depositing the funds.

Use the Date box to identify the deposit date.

You can enter the date in mm/dd/yyyy fashion, or you can click the small
calendar button to the right of the Date field. On the calendar that appears,
click the day that you want the Date field to show.

(Optional) Provide a memo description.

Initially, QuickBooks uses the Memo field to describe the transaction as a
deposit. This is, obviously, a pretty good description of a deposit transaction. If
you want to change the memo description to something else even more
useful, such as daily cash sales, replace the contents of the Memo box.
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Perhaps the best use for the box was suggested by the accountant who
reviewed this manuscript: You can use this field to further describe any
unusual transactions, such as refunds of expenses, rebates, or asset-sale
TIP proceeds.

As you may know either from working with QuickBooks or from the discussion

of making sales in Book 3, Chapter 1, you have the option of telling QuickBooks
(whenever you receive a payment) that the payment should be deposited
directly into the bank account or lumped with other payments in an undeposited-
funds bucket.

Not all customer payments appear in the Make Deposits dialog box. As discussed
in Book 3, Chapter 1, you can also indicate that a customer payment should be
deposited in a bank account directly from two windows: Receive Payments and
TIP Enter Sales Receipts. These direct-into-the-account payments don't appear in

the Make Payments dialog box. You record these bank account deposits at the
same time that you record the customer payment or the sales receipt.

7. (Optional) Record any additional deposit amounts.

If you want to include as part of the deposit some other payment that's not
listed initially in the Make Deposits dialog box, you can use the next empty row
of the list to describe this payment. To describe the payment, use the Received
From column to identify the customer, vendor, or other individual or business
making the payment. Use the From Account column to identify the account
that should be credited for this payment. In the case of a customer payment
that's a sale, for example, your sales revenue account should be the one
recorded in the From Account column. Use the other columns of the Make
Deposits dialog box — Memo, Chk No., Pmt Meth., Class (if applicable), and
Amount — to provide the other details of the payment.

8. (Optional) Identify any cash-back amount.

If you're making a $1,000 deposit but want to hold $100 of the deposit back as
cash, you record a cash-back amount. To record a cash-back amount, use the
Cash Back Goes To drop-down list to identify the account that should be
adjusted for the cash back. Use the Cash Back Memo field to describe the
reason for the cash-back transaction. Finally, enter the cash-back amount in
the cleverly titled Cash Back Amount box. If you want to hold $100 of cash back
for an owner draw, for example, you may enter owner draws (suppose that
this is an account) in the Cash Back Goes To box. Then use the Cash Back
Memo field to further describe the reason for the draw. Or not. Finally, enter
the cash-back amount, $100, in the Cash Back Amount box.

9. savethe deposit transaction.

As is the case with other QuickBooks transaction-entry dialog boxes, click
either the Save & Close or the Save & New button to save your deposit
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transaction. Note that after you've saved the deposit transaction, QuickBooks
records the deposit in the appropriate bank account. This deposit transaction
total — which appears in the Deposit Total field at the bottom of the dialog
box — is the amount that appears in your bank statement. It's also the amount
that appears in the bank account register. (I talk about bank account registers a
little later in the chapter.)

The Make Deposits window also provides Previous and Next buttons that enable
you to page back and forth through your deposit transactions. The Print button
lets you print a deposit list. The Payments button lets you redisplay the Payments
to Deposit dialog box. The History button lets you display a transaction history
for the selected payment. The Journal button takes you to the Transaction
Journal ledger. Finally, the Attach button opens a dialog box that you can use to
attach a document (such as a PDF image of a check) to the deposit.

Transferring Money between
Bank Accounts

The Banking menu supplies a useful command for transferring money between
bank accounts. To transfer money between accounts, you can choose Banking =
Transfer Funds. When you do so, QuickBooks displays the Transfer Funds between
Accounts window, shown in Figure 4-11.

To use this window, follow these steps:

1.

Use the Date field to identify the transfer date.

You can enter the date in mm/dd/yyyy format, or you can click the small
calendar button that appears to the right of the Date field. When QuickBooks
displays the calendar, click the day that corresponds to the date you want to
enter in the Date field.

Use the Transfer Funds From drop-down list to select the bank account
from which you’re moving funds.

You can enter the bank account name in the box, or you can click the arrow at
the right end of the box and choose a bank account from the list that
QuickBooks supplies.

Use the Transfer Funds To drop-down list to identify the bank account
that receives the transferred funds.

The Transfer Funds To list works like the Transfer Funds From list.
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pany Customers Vendors Employees Banking Reports Window Help

o

come Tracker Bill Tracker Calendar = Snapshots Customers Vendors Employees —Bank Feeds
Joumnal | @ Attach

Home: ny Cash Fk
@ previous B Next [ Save

Transfer Funds DATE cLass

05/12/2024 ] -

TRANSFER FUNDS FROM  Big National Bank ~ | ACCOUNT BALANCE 266,400.13
TRANSFER FUNDS TO | pyget Sound Credi Union » |  ACCOUNT BALANCE 10,000.00

TRANSFER AMOUNT 10,000.00

WEMO | Funds Transfer

Save & Close Save & New Clear

FIGURE 4-11:

The Transfer
Funds between
Accounts window.

4. uUse the Transfer Amount box to identify the amount of the transfer.

If you transfer $10,000 from one bank account to another, for example, the
transfer amount is $10,000. (This is what Figure 4-11 shows.)

5. (Optional) Provide a memo description for the transfer transaction.

If you want (and this is no big deal), you can use the Memo box to provide
some brief memo description of the funds transfer.

6. Save the transfer transaction.

To save your transfer transaction, click either the Save & Close or the Save &
New button. Alternatively, if you don't want to save the transfer transaction,
click the Clear button.

Working with the Register

You can record checks, deposits, and account transfers by using the commands
described in the preceding paragraphs of this chapter, but another method is
available: You can use the Register window. The Register window looks like the
regular paper register that you use to keep track of transactions for a bank account.
QuickBooks allows you to enter transactions directly into an account register.
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Recording register transactions

To enter a bank account transaction directly into an account register, follow these
steps:

1. 7o display an account register, choose the Banking -> Use Register
command.

Sometimes, when you choose Banking = Use Register, QuickBooks displays
the Use Register dialog box (see Figure 4-12). If you have only one bank
account set up, QuickBooks displays the actual register.

The Use Register dialog box asks you to select the bank account that you want
to display in a register. Open the Select Account drop-down list, choose the
bank account, and then click OK. QuickBooks displays the Register window,
shown in Figure 4-13.

If QuickBooks shows the register of an account other than the one you want to
see, choose Banking = Use Register again. The Use Register dialog box (refer

to Figure 4-12) should appear.
TIP

The Use Register dialog box lets you select any balance sheet account. You can
select a nonbank account, too.

Pine Lake Porcelain LLC - Intuit QuickBooks Enterprise Solutions: Accountant 24.0 - [Big National Bank]

= File Edit View Lists Favorites Accountant Company Customers Vendors Employees Banking Repors Window Help < PISCOVERY al- =

o m 3 ° L »
AR B W B E € AT B8 e
Heme My Company Cash Flow Hub Income Tracker Bill Tracker Calendar = Snapshots Customers Wendors Employees — Bank Feeds Docs.

@ Goto.. | () Print.. | [ Edit Transaction [5) QuickReport [2] Setup Bank Feeds

DATE IBER PAYEE ACCOUNT P ENT v DEPOSIT BALANCE
03/31/2024 Interestincome v 6.50 28832588 4|
04/21/2024 2 Office Warehouse Office Supplies 50.00 288,276.88
042112024 |3 Country Goffee Supplies Inventory Asset 500.00 287 776,88
05/01/2024 4,080.69 291,857.67
05/01/2024 291,857.67
05/12/2024 SelectAccount | Big National Bank - 3,597.00 295,454 57
05/12/2024 330.00 295,784.57
051212024 @ Cancel 588,84 296,473.41
05/12/2024 7,645.33 304,118.74
osrz2i2024 |13 Office Warenouse Accounts Payable 450.00 303,668.74
05/12/2024  ToPrint  Office Warehouse Accounts Payable 450.00 30321874
051212024 |4 Office Warehouse -split- 780.00 302,438.74
06/01/2024 14 Puget Sound Energy Accounts Payable 275.00 302,163.74
60112024 |15 Office Supplies Accounts Payable 560.00 30161374
60112024 16 Landlord Accounts Payable 2,500.00 209,113.74
07/01/2024 |5 Rent Expense 1,000.00 208,113.74
071142024 20 Christian Block -split- 3,846.15 294,267.59
071152024 |6 Office Warehouse Supplies 1,500.00 202,767.59 .
01/2024 [ - - ¥

Spits ENDING BALANCE 292,767.59
¥ 1-Line

FIGURE 4-12: Sotby  Date and Order Entered  ~ Restore

The Use Register
dialog box.

= O Bi b PinclokePorcelain.. P Book3 Chapter4 ...
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04/21/2024

04/21/2024

05/12/2024

05/12/2024

05/12/12024

05/12/2024

06/01/2024

06/01/2024

06/01/2024

2 Office Warehouse 50.00 257,963.95 4|
CHK  Office Supplies
3 Country Coffee Supplies 500.00 257,462.96

CHK Inventory Asset
3,597.00 261,060.968

DEP _split- Deposit
330.00 261,390.96
DEP Undeposited Funds Deposit
688.84 262,079.80
DEP -split- Deposit
764533 26972513
DEP _split- Deposit
ToPrint | Puget Sound Energy 275.00 26945013
BILLPMT Accounts Payable
ToPrint | Office Supplies 550.00 268,900.13

BILLPMT Accounts Payable
ToPrint | Landlord 2,500.00 266,400.13
BILLPMT Accounts Payable

FIGURE 4-13: 122024 @ .

The Register

ow, showing =

transactions that 1Line

affect the bank SOMbY  Date and Order Entered  + Restore
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account.

ENDING BALANCE 266,40013

2.

BOOK 3 Book

Use the Date column of the register to record the date of the deposit,
payment, or transfer.

You can enter a date by using mm/dd/yyyy date format. Or you can click the
small calendar button to the right of the Date field to display the month that
shows the date and then click the day button that corresponds to the date you
want to enter.

(Optional) Assign a transaction number.

Use the Number column to uniquely identify the transaction. In the case of
check transactions, for example, use the Number field to record the check
number. For transfers and deposits, you may not need to record a number.

Use the Payee field to record the payee for a check or some other bit of
information in the case of a transfer transaction.

Note that you can choose an existing customer, vendor, or a name from one of
the QuickBooks lists by clicking the down-arrow button at the right end of the
Payee field. When you do this, QuickBooks displays a list of names. Click one to
choose it.

Provide the transaction amount.

Use the Payment column if you're describing a check transaction or a transfer
that moves money from the account. Use the Deposit column if you're

keeping Chores



TIP

describing a deposit into the account or transfer into the account. Enter the
amount of the transaction in the appropriate column — Payment or Deposit —
by using dollars and cents.

Note that a check mark will appear between the payment and deposit column
when a transaction has been reconciled in the bank reconciliation.

Identify the account.

For check transactions, you use the Account field to identify the expense that a
check pays or the asset that a check purchases. For deposit transactions, you
use the Account field to identify the sales revenue account that the deposit
represents. For Transfer transactions, use the Account field to identify the
other bank account involved in the transaction. You can enter the Account
name in the Account box, or you can open the Account drop-down list and
select the account that you want.

(Optional) Provide a memo description.

If you want, use the Memo field to provide a brief description of the payment,
deposit, or transfer transaction.

(Optional) Split the transaction.

If a transaction needs to be assigned to more than one account, click the Splits
button (refer to Figure 4-13). QuickBooks displays the Splits area of the register
window, as shown in Figure 4-14. The Splits area lets you split a transaction
among several accounts. A check that pays both office supplies and rent
expenses, for example, can be split between these two expense accounts.
Similarly, a deposit transaction that represents both product revenue and
service revenue can be split between these two accounts. When you finish with
the Splits area, click its Close button.

You can erase the Splits detail by clicking the Clear button. You can also tell
QuickBooks to recalculate the payment or deposit amount by using the split
transaction data simply by clicking the Recalc button.

The Splits area also lets you do something that isn't possible inside the regular
register: Record customer and job information, class information, and billing
information. To do this, use the Customer:Job column, the Billable column, and
the Class column.

To record a transaction in the register, click the Record button.

QuickBooks recalculates the account balance and adjusts the ending balance
for the new transaction. After you record the transaction, you can see a
running tally on the right side with the bank account balance in it after each
transaction.
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FIGURE 4-14:

The Register
window, showing
the Splits area.

$ Goto.. | () Print.. | [ Edit Transaction &) QuickReport Setup Bank Feeds
- - » -
05/12/2024 7,645.33 26072513 4|
DEP -Split- Deposit
05122024 13 Office Warehouse 450.00 26927513
BILLPMT Accounts Payable
051202024 ToPrint | Office Warehouse 450.00 268,825.13
BILLPMT Accounts Payable
06/01/2024 14 Puget Sound Energy 275.00 268,550.13
BILLPMT Accounts Payable
oe/01/202¢ 15 Office Supplies 550.00 268,000.13
BILLPMT Accounts Payable
06/01/2024 16 Landlord 2,500.00 265,500.13
BILLPMT Accounts Payable
05M12r2.. B |4 Office Warehouse ~ | 780.00
CHK  -split-
Office Supplies 400.00 Close
Computerand Intern = 380.00 - - Clear
Recalc .
I
Soity ENDING BALANCE 265,500.13
1-Line
SombY  Date and Order Entered + Restore

Using Register window commands
and buttons

The Register window provides several buttons and boxes that enable you to work
with the Register window more easily and control the way it looks.

The Go To button

Clicking the Go To button, shown in Figure 4-15 (top-left corner), displays the
Go To dialog box. This dialog box lets you search for a transaction in the Register
window, such as a transaction in which the Payee/Name uses some name. You
can click the Back and Next buttons to move to the previous or next transactions
that also match the search criteria. To remove the Go To dialog box from the
QuickBooks program window, of course, click Cancel.

The Print button

The Print button, when clicked, displays the Print Register dialog box (see
Figure 4-16). This dialog box lets you print a copy of the register for the account.
The Print Register dialog box provides Date Range From and Date Range Through
boxes, where you specify the range of dates you want on the printed register. The
Print Register dialog box also provides a Print Splits Detail checkbox, which you
can select to tell QuickBooks that you want to see the split transaction detail.
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FIGURE 4-15:
The Go To
dialog box.

FIGURE 4-16:
The Print Register
dialog box.

Snapshots  Customers

05/12/2024 330.00 26139095 4|
DEP Undeposited Funds Deposit
05/12/2024 638.84 262,079.80
DEP  -split
05/12/2024 - 764533 260,725.13
| Account: Big National Bank Back
WhichField Payee/Mame -
0sM2/2024 13 Office Warend Next 450,00 269,.275.13
BILLPMT Accounts Pay{ Search For M
0511212024 |ToPrint | Office Warend FOr more search options, use EditiFind command Cance! 450.00 268,825.13
BILLPMT Accounts Payh
05/12/2024 4 Office Warehouse 780.00! 268,04513
CHK  -split
oe/01/2024 14 Puget Sound Energy 276.00 267,770.13
BILLPMT Accounts Payable
06/01/2024 |15 Office Supplies 550.00 267,220.13
BILLPMT Accounts Payable
06/01/2024 |16 Landlord 2,500.00 264,720.13
BILLPMT Accounts Payable
0511220 @ v .
- |
(Spils ENDING BALANCE 264,720.13
1Line
SonbY  Date and Order Entered  + Restore

ain LLC - Intuit
it View Lists Favorites
A <]
Home W ompany Cash Flow Hub Incs Tracker Bill Tracker Calendar = Snapshots Customers
& Goto.. | &) Print..
05112/2024 330.00 261,300.98 4|
DEP Undeposited Funds Deposit
05/12/2024 688.84 262,079.80
DEP  -split-
0512/2024 DATE RANGE @ 764533 269,725.13
DEP  -split From (01012024 ® Cancel
0sH2/2024 13 Office Warehouse] Tnrougn (05302024 | . 450.00 260,275.13
BILLPMT Accounts Payable|
05112/2024  ToPrint  Office Warehousel - print splits detail 450,00 268,825.13
BILLPMT Accounts Payable|
05/12/2024 4 Office Warehouse 780.00 268,045.13
CHK  -split-
oe/o1/2024 14 Puget Sound Energy 275.00 267,770.13
BILLPMT Accounts Payable
08012024 | 15 Office Supplies 560.00 267,220.13
BILLPMT Accounts Payable
06/01/2024 | 16 Landlord 2,500.00 264,720.13
BILLPMT Accounts Payable
0512120 B d ‘.
Spits ENDING BALANCE 264,720.13
1-Line
Sortby  Date and Order Entered  + m Restore
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FIGURE 4-17:
A sample
QuickReport.

The Edit Transaction button

The Edit Transaction button, when clicked, tells QuickBooks to display whatever
window you used to originally record the selected transaction. Remember that the
Register window shows all the transactions for the bank account. These transac-
tions include, for example, checking account transactions that you recorded when
using the Write Checks window. If you click the Edit Transaction button when
the selected transaction is one that you originally recorded in the Write Checks
window, QuickBooks displays that transaction again in the Write Checks window.
Edit the transaction in the Write Checks window and click either Save & Close or
Save & New to save your changes.

The QuickReport button

Click the QuickReport button to display a report that summarizes register infor-
mation for the payee or name in the selected transaction. If the selected trans-
action is a check written to Puget Sound Energy, clicking QuickReport builds a
quick-and-dirty report that shows the transactions you’ve paid to Puget Sound
Energy (see Figure 4-17).

Pine Lake lain LLC - Intuit QuickBooks Enterprise Solutions: Accountant 24.0 - [Register Quic

= File Edit View Lists Favorites Accountant Company Customers Vendgrs Employees Banking Reports Window Help

€ 4 U H

Home My Company Cash Flow Hub Income Tracker Bil Tracker Calendar = Snapshots Customers Vendors Empioyees —Bank Feeds
Customize Report |~ Commenton Report | Share Template | Memorize Print |v| Email | v Excel v | HideHeader | | Refresh
Dates Al ~  From H To B SortBy Default -

Report Basis: (® Accrual Cash Show Filters

Pine Lake Porcelain LLC

Register QuickReport
Accrual Basis All Transactions
Type Date Num Memo Account Cir Split Amount
Office Warehouse
» Check 0412112024 2 Big National Bank Office Supplies -50.00 4

Bill Pmt -Check 0sM2/2024 13 Big National Bank Accounts Pa.. -450.00

Bill Pmt -Check 051212024 Big National Bank Accounts Pa. -450.00

Check 0512/2024 4 Big National Bank -SPLIT- -780.00

Total Office Warehouse -1,730.00

TOTAL -1,730.00
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FIGURE 4-18:
A one-line version
of the register.

The Download Bank Statement button

Click the Download Bank Statement button to tell QuickBooks that you want to use
the Internet to connect to your bank’s computer and download recent transac-
tions. Note that you need to prearrange this service with your bank and that this
button is called Setup Bank Feeds until you set up an online account. (For more
information about QuickBooks’s online banking features, see the section, “Bank
Feeds command,” later in this chapter.)

The 1-Line checkbox

QuickBooks lets you display a one- or two-line version of the register (see
Figure 4-18). By default, QuickBooks assumes that you want the two-line version
of the register, but you can display a more compact, one-line version of the reg-
ister by selecting the 1-Line checkbox.

Pine L: rcelain LLC - Intuit Qui Enterprise Soluti ountant 24.0 - [Big Mational Bank]

= File Edit View Lists Favorites Accountant Company Customers Vendgrs Employees Banking Report

A .
Heme My Company Cash Flow Hub Income Tracker Bill Tracker Calendar = Snapshots Customers Wendors Employees — Bank Feeds Docs.

& Goto.. | () Print.. | 2 Edit Transaction [2) QuickReport [2) Setup Bank Feeds

DATE IBER ACCOUNT PAYMENT v DEPOSIT BALANCE
0111512024 Undeposited Funds 5,625.00 268,138.95 4|
02/15/2024  ToPrint Landlord Accounts Payable 10,000.00 258,138.96
0211512024  ToPrint | Office Warehouse Accounts Payable 1,000.00 257,138.96
0211512024 Undeposited Funds 424875 261,387.71
0310112024 ~split- 517.50 261,905.21
30212024 9 Landlord Accounts Payable 2,500.00 259,405.21
031512024 ~split- 10,120.00 269,525.21
0311512024  ToPrint  PugetSound Energy Accounts Payable 380.00 269,145.21
arz12024 2 Office Warenouse Office Supplies 50.00 260,005.21
arz12024 3 Country Coffee Supplies Inventory Asset 500.00 268,505.21
051212024 -split- 3,597.00 272,192.21
511212024 Undeposited Funds 330.00 27252291
511212024 ~split- 688.84 273.211.05
0511212024 ~split- 7,645.33 280,856.38
os11212024 13 Office Warehouse Accounts Payable 450,00 280,405.38
0511212024  ToPrint  Office Warehouse Accounts Payable 450,00 279,956.38
osr12i2024 4 Office Warenouse -zpit- 780,00 279,176.38
6r01/2024 14 Puget Sound Energy Accounts Payable 275.00 278,001.38
6r01/2024 15 Office Supplies Accounts Payable 550.00 27835138
/012024 |18 Landlord Accounts Payable 2500.00 275,85138 .

] - - 000 ¥

Spits ENDING BALANCE 275,851.38
@ 1Line
Sotby  Date and Order Entered  ~ Besiore

The Sort By list

The Sort By drop-down list lets you choose how QuickBooks arranges register
information. QuickBooks lets you arrange register information by date, by amount,
by order entry date, and by several other sorting methods as well. To change the
way that QuickBooks orders or organizes the information in the register, open the
Sort By drop-down list and choose the ordering sequence that you want.
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Using the Edit Menu Commands

262

In the preceding paragraphs of this chapter, I describe how to record check trans-
actions, deposit transactions, and transfers between accounts, as well as how
to use the register. You often don’t need to know any more than I’ve already
described to use the windows discussed and record the transactions described.
Know, however, that when you’re working with a register, the Edit menu provides
several other useful commands for entering new transactions, editing existing

transactions, and reusing transaction information.

»

TIP

»

»

»

»

»

»

»

Edit Check/Deposit: This command is equivalent to the Edit Transaction
button (which appears in the Register window). If you choose the Edit Check/
Deposit command, QuickBooks displays the Write Checks window so that you
can edit the transaction with that tool.

The command name changes depending on the selected transaction. You see
the Edit Check command if the selected transaction is a check. You see the
Edit Deposit command if the selected transaction is a deposit.

New Check: This command displays the Write Checks window so that you can
record a new check transaction and record it in the register.

Delete Check: The Delete Check command deletes the selected transaction
from the register. (The name of this command changes depending on the
transaction selected in the register.)

Memorize Check: This command, which appears when appropriate, memo-
rizes the selected transaction, adds the check information to the memorized
transaction list, and thereby allows you to reuse the check information at
some point in the future. (If you have a transaction that you record frequently,
such as every month, memorizing the transaction and then reusing it often
saves you data entry time.)

Void Check: This command, which also appears when appropriate, lets you
void the selected check transaction.

Copy/Paste: The Copy command copies the selected check. If you choose the
Paste command, QuickBooks pastes the just-copied check into the next empty
row of the register.

Go to Transfer: This command goes to the other side of a transfer transac-
tion. The Go to Transfer command, obviously, makes sense and works only if
the selected transaction is a transfer.

Transaction History: This command displays a window that lists all the
transactions related to the current selected transaction. Typically, you use this
command when the selected transaction is a customer payment. In this case,
the Transaction History window lists all the transactions related to the
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FIGURE 4-19:
The Simple tab of
the Find window.

»

»
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customer payment transaction. You can use the Transaction History window
to go quickly to one of the related transactions. Simply click the transaction
listed. You can also edit transactions shown in the Transaction History window
by clicking the transaction and then clicking the Edit Payment button.

Change Account Color: This command displays the Change Account Color
dialog box, which lets you choose another color for the striping shown in the
Register window. To select another color, click the color square that shows the
color that you want and then click OK.

Use Register: This command displays the Use Register dialog box, which lets
you select the account that you want to display in a register.

Use Calculator: This command, predictably, displays the Windows Calculator. If
you have questions about how to work with the Windows Calculator, refer to the
Windows documentation, the Windows Help file, or a book such as the latest
edition of Windows For Dummies, by Andy Rathbone (John Wiley & Sons, Inc.).

Find: The Find command displays either the Simple tab of the Find window,
shown in Figure 4-19, or the Advanced tab of the Find window, shown later in
this section. Both tabs allow you to search your register and find transactions.

-elain LLC - Intuit Quick erprise Solutions: Accountant 24.0 - [Find]

Edit View Lists Favorites Accountant Company Customers Vendors Employees Banking Reports Window Help g DISCOVERY

¢ o

My Company Cash Flow Hub Income Tracker Bill Tracker Calendar | Snapshots Customers Vendors Employees = BankFeeds

Close

Help

%49 AM
023

Hi @b Pine Lake Porcelain...
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To use the Simple tab, use the Transaction Type, Customer:Job, Date, Invoice
#, and Amount controls to describe the transaction you want. Enter as much
information as you can, but note that if you enter incorrect information,
QuickBooks (obviously) won't be able to find the transaction you're looking
for. After you describe the transaction in as much detail as you can, click the
Find button. QuickBooks displays a list of transactions that match your search
criteria (see Figure 4-20). To go to a particular transaction, click the transaction
in the list and then click the Go To button.

The Advanced tab, shown in Figure 4-21, lets you describe a much more
precise and complex set of search criteria. Essentially, you can describe in
painful detail a filter that QuickBooks should apply to each field that's
recorded for a transaction. If you want to filter based on the account, for
example, select the account entry in the Filter list. Then open the Account
drop-down list and choose one of the account groupings that QuickBooks
displays. In Figure 4-21, the All Accounts entry is selected, so all accounts
appear, but you can choose the Select Accounts entry instead to display a
dialog box that you can use to individually select the accounts you want to
look for. The Include Split Detail? radio buttons let you indicate whether you
want to use split detail information.

Pine Lake Porcelain LLC - Intuit Quic nterprise Solutions: Accountant 24.0 - [Find]

= File Edit View Lists Favorites Accountant Company Customers Vendgrs Employees Banking Reports Window Help

5] . ]

Home My Company Cash Flow Hub Income Tracker Bil Tracker Calendar = Snapshots Customers Vendors Empioyees —Bank Feeds
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Transaction Type
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Close
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8] T L Help
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e TvPe e e 3 GoTo
A
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' Report
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021512024 NV 2 Grand Coffee Supplies 424875
021512024 NV 25 Five Star Foods 528.00
02i05/2024 INV 24 Hamilton Grinders 2,992.00
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the Find window.
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FIGURE 4-21:
The Advanced
tab of the Find

window.

TIP
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After you describe the filter or filters you want to use, click the Find button. As
with the Simple tab of the Find window, QuickBooks displays a list of all the
transactions that match your filter. To go to one of the transactions listed, click
it and then click the Go To button.

The Report button, which appears on both the Simple tab and the Advanced tab,
creates a report of all the transactions that the Find command has found. You
can print this report — QuickBooks displays it in a regular report window — by
choosing the File = Print Report command or by clicking the Print button that
appears at the top of the Report window. The Simple and Advanced tabs of the
Find window also include a Reset button. | should say that if you want to start
your search over by using a new set of search criteria or filtering criteria, simply
click the Reset button.

Search: This command opens a search window that you can use to search for
specific information within your company file.

Preferences: This command enables you to change the way that QuickBooks
works so that it best matches your firm’s accounting requirements. Book 2,
Chapter 3 discusses the Preferences command in detail.
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Reconciling the Bank Account

FIGURE 4-22:
The Begin

Reconciliation

266

dialog box.

You can reconcile a bank account with surprising speed in QuickBooks. To rec-
oncile a bank account, choose the Banking => Reconcile command. QuickBooks
displays the Begin Reconciliation dialog box, shown in Figure 4-22.

Yorcelain LLC - Intuit Qui
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s 5
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O Enging Balance | 288326 84 Open Balance
Crispy C [

Landlord Enter any service charge or interest earned
MugsRLY

Senice Charge  Date Account Class Order 1099 Forms
Office 8
'S 7500 0402024 @ Bank Senvice Charges - - Order Checks
Office W,
InterestEamed  Date Account Class
Pugets
550 04302024 @ Interestincome B B
Super S

WaDept} Locate Discrepancies Undo Last Reconciliation [ Continue Cancel Help

Item Receipt 03/15/2024 Accounts Payable -3,310.00
Item Receipt 03/02/2024 Accounts Payable -2,500.00
Manage Transactions v Run Reports v | Schedule Online Payment

q Internal Revenue Se... g QuickBooks Deskt:

To begin reconciling your account, follow these steps:

1. choose the account that you want to reconcile from the Account drop-
down list.

2. Use the Statement Date box to identify the ending date of the bank
statement that you're using in your reconciliation.

As is always the case with date fields in QuickBooks, you enter the date in
mm/dd/yyyy date format or click the calendar button and use it to select the
correct date.

3. Enterthe ending balance shown on your bank account statement in the
Ending Balance box.
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FIGURE 4-23:
The Reconcile
window.

4. Use the Service Charge and Interest Earned boxes to identify the amount
of any service charge or of any interest, the date of any such transaction,
and the account that you use to track those charges.

If your bank statement shows a service charge, enter the service charge amount
in the first Service Charge box. Enter the date of the service charge transaction
in the Service Charge Date box. Finally, choose an appropriate expense account
for tracking service charges from the Service Charge Account drop-down list.
(Bank charges, for example, is a good account to track service charges.)

In a similar fashion, use the Interest Earned boxes to describe any interest
earned on a business account.

5. Review the statement information.

After you enter information about the bank account, the statement date, the
ending balance, and any service charge or interest earned information, take a
moment to review the information and confirm that it's correct. You'll have a
whale of a time reconciling an account if the amount that you're trying to
reconcile to is incorrect.

6. After you make sure that everything is hunky-dory, click the Continue
button.

QuickBooks displays the Reconcile window, as shown in Figure 4-23.

celain LLC - Intuit Quic
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7. To identify checks and payment transactions that have cleared your
bank account, click the transactions that have cleared.

The Reconcile window displays two lists of transactions: a list of checks and
payments, which appears on the left, and a list of deposits and other credits,
which appears on the right. When you click a transaction, QuickBooks marks the
transaction with a check mark, indicating that a transaction has cleared. You can
mark all the transactions in a list as cleared by clicking the Mark All button. To
mark all the transactions in a list as uncleared, click the Unmark All button.

Use the Deposits and Other Credits list to identify those deposit transactions
that have cleared the bank account. You identify a cleared deposit transaction
in the same way that you identify a cleared check or payment transaction. You
can click a transaction, which causes QuickBooks to mark the transaction as
cleared. You can also use the Mark All and Unmark All buttons to mark or
unmark all the deposits and other credit transactions at one time.

If you realize that as part of the reconciliation, you've incorrectly entered the

@ service charge, interest earned, ending balance, or any other information, click
the Modify button. QuickBooks redisplays the Begin Reconciliation dialog box
TIP (refer to Figure 4-22). Make the necessary changes and click Continue to return

to the Reconcile window.
8. Verify that the cleared balance equals the ending balance.

If you provided correct information in the Begin Reconciliation dialog box
(refer to Figure 4-22) and you correctly identified all the transactions that have
cleared your account, the ending balance should equal the cleared balance, as
shown in Figure 4-24.

9. Whenthe ending balance equals the cleared balance, click the Reconcile
Now button.

QuickBooks permanently records your cleared transactions as cleared and
redisplays the Register window. If you can't reconcile an account, you can click
the Leave button. QuickBooks saves your half-completed reconciliation so that
you can come back later to finish it.

Can I interject a couple of tangential comments here? Good. If you want, you can

@ print a little report that summarizes your reconciliation after you click the Recon-

cile Now button. (QuickBooks gives you this option in a dialog box that it displays.)

TIP You can also click the Previous Reports button to display a dialog box that lets you

print other old reconciliation reports. You can click the Discrepancy Report but-

ton to produce a report that lists transactions that have been edited since you last

reconciled the account. Finally, you can click the column headings used in the
Reconciliation window to sort and re-sort the bank account information.
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FIGURE 4-24:

The Reconcile
window when the
reconciliation is
complete.
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WHEN YOUR ACCOUNT WON'T BALANCE

If your account won't reconcile, the problem stems from one of several conditions.
None of the conditions is hard to describe, but all of them can be pretty hard to fix.
Here's a quick overview of what may be causing you trouble and what may be prevent-
ing you from reconciling your account:

® Are you working with the right account? That sounds pretty dumb, doesn't it?
But if you have several bank accounts, you may be trying to reconcile the wrong
account or using the wrong statement to reconcile your account.

® Are you missing any transactions? If the bank has recorded transactions that you
haven't, this fact causes your ending balance to not equal your cleared balance.
Look on your statement for any transactions that you're missing or forgot to record;
then record these transactions and mark them as cleared.

® Have you recorded transactions correctly? This may sound silly, too, but if you
recorded the transaction, and you're a few pennies or a few dollars off — perhaps
you've transposed a couple of numbers — you won't be able to reconcile your
account. | commonly find that I've entered a transaction or two wrong per month.

(continued)
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(continued)

(Maybe this is because my fingers are too arthritic to record amounts correctly.)
But it's probably very common when you're entering dozens and dozens of transac-
tions to occasionally record a transaction wrong. The occasional errors need to be
fixed before you can reconcile an account.

Note that it's quite likely — especially when you're getting started — that you won't be
able to reconcile an account because of multiple errors. If you do something like record
a transaction erroneously and then forget to record a couple of transactions, you'll need
to fix each error to reconcile your account.

One final tip: Reconciling an account is much easier when you're using online banking.
| talk about how online banking works a little later in this chapter.

Reviewing the Other Banking Commands

Earlier in this chapter, I describe the most common and useful banking com-
mands. You may not need to use the other commands provided on the Bank-
ing menu. Nevertheless, my compulsive personality requires that I describe these
other commands.

Order Checks & Envelopes command

The Order Checks & Envelopes command displays a submenu of commands you
use to order QuickBooks checks and envelopes or to get information about order-
ing QuickBooks checks and envelopes.

Enter Credit Card Charges command

If you set up a credit card account — this is a credit card account that you or your
business would use to charge transactions — you can choose the Banking = Enter
Credit Card Charges command to display a window that you can use to enter credit
card charges.

When you choose the Enter Credit Card Charges command, the Enter Credit Card
Charges window appears (see Figure 4-25). You can figure out how this window
works without my help, I’'m sure. You identify the credit card account for which
you want to record transactions and describe the credit card purchase by using the
field at the top of the screen. Then you use the Expenses and Items tabs — these
tabs work the same way as the similar tabs in the Write Checks window — to
detail the reasons and the accounts affected by your charge.
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FIGURE 4-25:
The Enter Credit
Card Charges
window.
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If you click the Download Card Charges button (which appears at the top of the
Enter Credit Card Charges window), assuming that you’ve set up credit card
accounts that allow for online services, QuickBooks downloads recent credit card
transactions directly into the credit card register. Perhaps obviously, for this com-
mand to work, several prerequisites must be met:

3 You need a credit card account set up.
¥ You need to have set up the credit card account for online services.

¥ You need an Internet connection so that QuickBooks can grab the credit card
transactions from the credit card company.

Bank Feeds command

The Bank Feeds command displays a submenu of commands that you use to con-
duct online banking and to see which financial institutions (banks, savings and
loans, and credit unions) let you do online banking. If you want to do online
banking — which can save businesses a ton of time — call your existing bank to
ask whether it provides the service. If it does, ask for a sign-up packet and for
specific instructions on how to get going with online banking. If you don’t like
the idea of calling your bank directly, choose the Set Up Bank Feed for Account
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©

REMEMBER

command from the Bank Feeds submenu. This command walks you through the
process of applying for and setting up online financial services.

If you want to learn more about online banking, choose the Participating Financial
Institutions command to see which banks play well with QuickBooks. And choose
the Learn about Online Bill Payment command for online bill payment options
when your bank doesn’t play well with QuickBooks but you don’t want to change
banks.

The Bank Feeds submenu also provides the Import Web Connect File command,
which lets you open a transaction file from your bank (if that’s the way your bank
does online banking), and the Change Bank Feeds Mode command, which lets you
tweak the way the online banking window looks.

Can I close this discussion of online banking with an editorial comment? Online
banking is a real time-saver for business owners. If you’re not using online bank-
ing, you should have a pretty darn good reason for not doing so.

Loan Manager command

The Loan Manager command displays a window that lists loan accounts you’ve
set up. This listing of loan accounts by itself isn’t all that special, but the Loan
Manager window does something else that is special: If you click the Add a
Loan button, QuickBooks collects loan information from you so that it can break
loan payments into principal and interest.

Other Names list

The Other Names list displays a window that lists all the other names you’ve used
to record transactions. People and businesses that appear in your Other Names
list aren’t customers, vendors, or employees. In other words, the Other Names list
includes names that don’t neatly fit into one of the standard categories.
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» Setting up a payroll service

» Setting up payroll runs
» Getting your employees paid
» Revising checks

» Handling payroll liabilities

Chapter 5
Paying Employees

uickBooks provides a do-it-yourself option for paying employees:

Enhanced Payroll, which means that QuickBooks helps you with the

payroll tax forms. A second payroll option would be QuickBooks Assisted
Payroll. With this option, you handle paying your employees within QuickBooks;
then Intuit handles making the tax payments and filing the necessary payroll
tax forms.

Yet another option to consider in case you’re not an accountant and are in need of
payroll: Think about splurging a bit and going with one of the full-service pay-
roll providers, such as ADP, Paychex, and Gusto. Having one of them process your

TIP payroll greatly simplifies the accounting work and — in my experience — saves
you money over time.

If you go with a payroll provider, you can stop reading this chapter right now.

Seriously. All you need to do is telephone the payroll service company and
say, “Help!”

Setting Up Payroll

To set up do-it-yourself payroll, you step through a web-based interview. To start
this interview, choose Employees = Payroll &> Turn on Payroll in QuickBooks.
QuickBooks displays the page shown in Figure 5-1.
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FIGURE 5-1:
The first payroll
setup webpage.
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You have three payroll options: Enhanced Payroll, Payroll Core, and Payroll
Premium. If you choose the Enhanced option, QuickBooks will help you remit
the payroll tax deposits and then prepare (or mostly prepare) the payroll tax
returns for you. The Payroll Core and Payroll Premium options are full-service;
QuickBooks prepares the paychecks, direct deposits, and payroll tax forms, and
remits payroll tax deposits on your behalf.

You can choose any option by clicking the appropriate Get Started button. If you
know you do not want to mess around with payroll tax filings, paying a bit more
for the Core or Premium options probably makes sense.

Intuit changes the pricing for its payroll services from time to time; at the time
I’m writing (summer 2023), Enhanced service costs approximately $600 per year,
and the full-service options are about $550 to $900 per year (without a sign-up
promotion). The cost of each plan increases as the number of employees and the
number of checks you issue increases.

Even though you have three QuickBooks payroll options, in this chapter I assume
that you want to use the Enhanced option, which requires a more hands-on
approach than the others. You do some of the work. You need to understand fed-
eral and state payroll tax rules, but the benefit is lower cost, which adds up if you
are paying for the service year after year.
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WARNING

To choose the Enhanced option, click the Get Started button. QuickBooks gives you
the option to pay for a full year, which saves you $100, or pay in monthly install-
ments. Then QuickBooks collects your credit card information (so that it can bill
you for the service).

Signing up for a payroll service

To sign up for the payroll service after you’ve selected a particular option, you
fill in a series of webpage forms. Along the way, you enter your business name
and address and give your firm’s employer identification number (EIN). To move
through the webpage forms, click the Continue and Back buttons. QuickBooks
steps you through the sign-up process very efficiently. Simply follow the onscreen
instructions to describe how your company processes payroll.

But let me issue a warning: When you do set up your company information for
payroll, QuickBooks asks for a bunch of information. I won’t repeat the instruc-
tions that the webpages provide, but you do need to fully describe how you pay
your employees, to whom you remit deductions, and other stuff like that. Care-
fully read the instructions that QuickBooks provides, which takes some time. If
you get into trouble, you may want to get an outside accountant’s help to set up
the Enhanced service or consider the Assisted option.

Setting up employees

After you set up your company information for payroll, you’re ready to set up
employees for payroll. As part of the Enhanced setup process, QuickBooks displays
a webpage where you can add your employees. You can also add employees by
displaying the Employee Center. (Choose Employees > Employee Center and click
the New Employee button.) Whe